
Psych Advantage
Version 12.2: Release Notes
(Initial Release Date - 3/24/2020)

Document Revised (12/2/2020)

Click the link below to go to the Education page of the Compulink Client Website. This is information 
central for the Advantage Software eLearning Portal.  The ‘What’s New in CU’ tab offers links to 
courses for the CURRENT Advantage Software version on distribution.  For lists of features and 
enhancements for PREVIOUS version builds, go to the ‘Previous Versions’ tab.  Here you will find a 
list of links with version numbers and release dates.
What’s New in CU for Psych

 X  Items marked with a red 'X' are things that Compulink deems important for you to know PRIOR to
updating your software to the version listed above.

The date in red to the left of the Enhancement, indicates the date the item was added to or updated 
on this document.

Items marked (Request) were requested by clients, and satisfied with this update.

Service Pack Enhancements: Click here for a list of Service Pack Enhancements released with 
incremental updates (0.5, 0.6) between version steps (e.g. V11 to V12). 

HOT TOPICS
 X (10/22/2019) Appointment > HOT TOPIC

• See the following topic in the Appointment section:
          • .Display Changes > Menu Commands

 X (1/30/2020) Customization > HOT TOPIC

• See the following topic in the Customization section:
          • Advantage Software > GUI Customization
          • Screen Builder > ALL > Migrate Tabs to 12.2 Theme

 X (1/28/2020) Education > HOT TOPICS

• See the following topics in the Education section:
          • Menu Changes > .Main Screen

 X (3/24/2020) Exam > HOT TOPICS

• See the following topics in the Exam section:
          • .Display Changes > Icons Condensed Under Ellipsis
          • .Display Changes > Menu Commands
          • Command (Orders) > New Command & SMART Functionality Added
          • Command (Utility) > Video Session
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HOT TOPICS
          • Data Entry > NEW Diagnosis Driven Orders Window
          • OpenOffice Documents > Next Appointment Database Field Changes

 X (1/30/2020) General > HOT TOPICS

• See the following topics in the General section:
          • Advantage Software > Theme Change
          • Menu Changes > .Main Screen (Right Click)
          • Menu Changes > Across All Screens
          • Menu Changes > Hotkeys

 (4/13/2020) I.T. Specialist Information > HOT TOPIC

• The following NEW section was added to the END of this document: I.T. Specialist 
   Information

 X (10/22/2019) Ledger > HOT TOPICS

• See the following topics in the Ledger section:
          • .Display Changes > Menu Commands
          • Patient Payments > Payments Via the Patient Portal

 X (1/28/2020) Patient Area > HOT TOPICS

• See the following topics in the Patient Area section:
          • .Display Changes > Icons Condensed Under Ellipsis
          • .Display Changes > Menu Commands
          • Command (Back & Next) > New Functionality
          • Command (Print) > NEW Document Creation Window
          • Command (Referral) > User Friendly Edit Screen
          • Command (Search) > NEW Search Window
          • Data Entry > AdvantageERx Eligibility Check
          • SMART Workflow > .Re-branding Functionality

 X (11/13/2019) Utility > HOT TOPIC

• See the following topic in the Utility section:
          • System Administrator > Login > IDs > Field(s) ADDED: Enable Grid Hover Menus

Education
 (3/16/2020) Menu Changes > .Main Screen

• A NEW 'Education' command was added. 
• When clicked, it will open to the eLearning Resources landing page on the client web 
   portal, with easy access to the following Training resources: 
          • Client Education Seminars – hosted at various locations 
          • Connected User Conferences – hosted near Compulink corporate 
          • Live Training Webinars - online 
          • Request Training -(online or at your location(s)

Appointment
 X (2/6/2020) .Display Changes > Menu Commands

• ALL command icons were updated to a new format.
• Utility – This was renamed from 'Tools' to be consistent throughout the software.
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Appointment
• Resource – This was moved under the 'Utility' command.
• Daily Note – This was moved to the right click menu option on the header.

 X (3/30/2020) .Display Changes > Open Windows

• With the option to add Resources to the existing window, View All Providers, etc., the 
   option to open multiple Appointment windows has been removed. (Request)

 X (8/20/2019) .Header Change(s) > Provider/Resource Filtered By Location

• The Provider or Resource field will now filter the available Resources by the Location field.
• This filter is based upon the Provider/Location that is assigned to the templates under 
   Tools > Table Setup > Template Schedule.

 X (4/6/2020) .Header Change(s) > Right Click Menu ADDED

• The header is the area that displays fields for the Date, Location, Provider and 
   Department.
• Right click in an empty spot in the header to open a menu with the following options:
          • Show Daily Note – Opens the 'Edit Daily Note' window.
                    • Enter a message for your scheduling staff or Provider for that specific 
                       schedule and click SAVE.
                    • A yellow Notes field will display on the schedule below the header.
          • View Waiting List – Opens the Appointment Waiting List.
          • Close All Other Schedules – Closes all schedules on the screen, other than the 
             active one (the one currently highlighted).
          • Remove – Closes/Removes from the screen just the active schedule (the one 
             currently highlighted).

 X (1/14/2020) Command (Book/Edit) > Field and Header Enhancement(s)

• Header – Global Period Added
          • If a patient is within their post-surgical follow-up time, once the Appointment 
             'Reason' is selected, 'Global Period' will display in the header. (Request)
          • Click the label to open the Information window to see what Global Periods exist, or
             have recently expired.

• Patient Information section
          • Plan field – This is now a mandatory field. If left blank, when saving the record, 
             the following message will appear: Patient Plan Required!

 (10/21/2020) Command (Book/Edit) > Locking of Bill Table

• Account Responsible section
          • While editing an Appointment, Account Responsible data is locked, which prevents
             Ledger entries from being made.

 X (11/11/2019) Command (Book/Edit) > NEW Episode Functionality

• Appt section
          • A NEW 'Episode' field was added. (Request)
                    • This field defaults to empty if the patient does NOT have an active Episode.
                              • If the patient has ONE active Episode, it will default.
                              • If the patient has more than one active Episode, it will default with 
                                 the last one added.
                    • Click the drop-down to open the 'Select Active Episode' window if you would
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Appointment
                       like to attach the Appointment to an active Episode other than the one that 
                       defaults.
                              • Information displayed: Start (date), Name, Injured (date) and 
                                 Category.

• Episode of Care panel – This is a NEW panel that was added to the tab.
          • This is a filtered grid to only show the patient's ACTIVE Episodes.
          • Information displayed includes:
                    • Effective (date)
                    • (Episode) Name
                    • (Episode) Category
                    • I = Insurance. 'Y' indicates that it has been connected to an Insurance 
                       Payor.
                    • R = Referral. 'Y' indicates that it has been connected to a Referral Source.
                    • C = Contact. 'Y' indicates that is has been connected to a Patient Contact 
                       record.
                    • * = Note. '*' indicates that there is something in the 'Notes' field on the 
                       Episode.
                    • To view the 'Notes', hover the mouse over the '*' for a PopUp, or double 
                       click on the record to bring up the Edit window.
          • Instead of clicking the drop-down at the 'Episode' field, you may single left click on
             an Episode in the grid, and it will populate the 'Episode' field.

• Filtering Grids
          • Once the active Episode is selected, the following grids will only display the records
             that are connected to that active Episode:
                    • Appointment History, Insurance and Referral Sources. (Request)
          • If no records were connected, then ALL records for that section will display in the 
             grid.

 (6/18/2019) Command (Print) > Month at a Glance > Totals Added

• The Crystal Report now prints Location totals in the top right corner, as well as daily totals
   in the header of each day. (Request)

 (8/20/2019) Command (Print) > Selected Resource > Chronologically (both) > 
Merge More Notes

• The options of 'Chronologically' and 'Chronologically w/Open slots' will now merge 
   multiple lines of the Appointment 'Note' field, based upon the data entered. (Request)

 (12/30/2019) Command (Utility) > Column > Customize > NEW Field(s)

• Select the 'Appointment' database on the left; the 'Arrived' time field from the SMART 
   Workflow functionality is now available to display. (Request)

 (4/6/2020) Command (Utility) > Release Held Time Slots > NEW Command 
ADDED

(*)(4/6/2020) Command (Utility) > Release Held Time Slots > NEW Command ADDED

• The NEW command 'Release Held Time Slots' was added.
• In the event a system crash occurs while time slots are being edited in your appointment 
   schedule, these records may be locked.
• Use this command to release them, so that they are available for scheduling. 
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Appointment
• After the operation has run, click OK on the following message: All held timeslots older 
   than five minutes were released.

 (9/16/2019) Command (Utility) > Table Setup > Template > Field/Label 
Change(s)

• Discontinued – NEW field added. (Request)
          • If a template is no longer needed, edit the record and enter a 'Discontinued' date.
          • The template will no longer display for selection when adding new items in the 
             Template Schedule, but WILL continue to display in the calendar for any days that 
             have already been assigned to it.

Communication
 (2/5/2020) Command (Help) > Review Pending Bugs/Requests > NEW Option

• Under the 'Help' command, there is a NEW option 'Review Pending Bugs/Requests'.
• A window will open showing any Bugs and/or Requests that Compulink has connected to 
   the users account.
• Back/Next - Click 'Back' or 'Next' to move through the items.
• Information displayed includes: 
          • Description – Description of the Bug/Request
          • Total from Other Clients – Displays the number of other Compulink clients attached
             to the same request.
          • Weight – Current priority
          • Resolved – Date it was Resolved
• Weight - Click 'Weight' to open the 'Update Weight' window and enter either 1 (low), 2 
   (medium) or 3 (high) to update the suggested priority for YOUR office.
          • Once 'OK' is clicked, an 'Updating' message will display as the information is sent 
             to Compulink.
          • You will NOT see a change in 'Weight' displayed, as the data has not been 
             processed.
• Delete – Used to Delete a REQUEST that you no longer need.
          • Click 'Back/Next' until you find the Request.
          • Click 'Delete'.
          • Click 'Yes' or 'Cancel' on the message: Select YES to confirm Deletion.

 X (1/20/2020) InBox > Command(s) ADDED

• Split
          • This NEW command allows the user to Split a document into multiple pages.
          • The office may receive a document with multiple patients on it, and needs to 
             distribute it among different accounts.
          • Highlight the communication and click 'Split'.
                    • A window opens prompting you to 'Enter Start Page'; enter the number to 
                       start the split and click OK.
                    • Next, 'Enter End Page'; enter the number to end the split and click OK.
                    • Continue entering Start/End page numbers until you have split the 
                       document into the number of sections needed.
                    • Once you enter the last page of the document as the End number, it will no 
                       longer prompt for a Start number. 
          • The InBox window will now display multiple lines with the split document, as well 
             as the original full document.

• Xfer
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Communication
          • Not available in the InBox from the MAIN MENU, you must enter the patient 
             record.
          • This NEW command allows the user to transfer the document to one of the 
             following areas:
                    • Demographic Documents
                              • Highlight communication and select 'Xfer > Demographic 
                                 Documents'.
                                        • The 'Select Patient' window opens for your to type in the Last,
                                           First name of the patient you want to transfer the document 
                                           to. Type the name and hit Enter.
                                        • Patients that match will appear in the window; information 
                                           displayed includes: Patient Name, Birth, Age, Plan, Last Visit, 
                                           Provider, Location, Acct#, Responsible Name and Balance. 
                                           (Request); double click to select the appropriate one.
                                        • A Confirm window opens: Press OK to Confirm Assignment to:
                                           patient name; click OK or Cancel; if only one patient 
                                           matches, the Confirm window will automatically open.
                                        • A 'Select Provider' window opens to choose a person to assign
                                           the document to; highlight and enter, or double click to 
                                           select.
                                        • If the document contains multiple pages a Confirm window 
                                           opens: Select YES to remove the Cover Page Before 
                                           Transferring?; Click Yes or No.
                                        • An 'Edit Document' window will open with the following:
                                                  • Date – The Date the document was received; this may 
                                                     be changed if you prefer a Date ON the document, or 
                                                     the current Date.
                                                  • Time – The Time the document was received.
                                                  • Type – Click the drop-down to select the Type of 
                                                     document.
                                                  • Name – Defaults to 'Incoming Fax', but may be 
                                                     changed.
                                                  • Requires Review – Defaults to checked, but may be 
                                                     unchecked.
                                                            • If checked, the document will appear on the 
                                                               NEW worklist 'Demographic Documents 
                                                               Requiring Review'.
                                                            • Information displayed includes the Patient 
                                                               Account Number, Name and Document Name.
                                                  • Reviewed – Date the document was Reviewed. 
                                                            • If it was Reviewed prior to transfer, then click 
                                                               the drop-down and select the date it was 
                                                               Reviewed; if not, leave blank.
                                                            • By entering a Date, the document will not 
                                                               appear on the worklist to be Reviewed.
                                        • Click 'Save'.
                              • The file will be saved under the patient's 'Scanned Documents' grid.
                              • To view the document, double click on it, or highlight the ellipsis and 
                                 select 'View'.
                    • Exam Communication
                              • Highlight communication and select 'Xfer > Exam Communication'.
                                        • The 'Select Patient' window opens for your to type in the Last,
                                           First name of the patient you want to transfer the document 
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Communication
                                           to. Type the name and hit Enter.
                                        • Patients that match will appear in the window; information 
                                           displayed includes: Patient Name, Birth, Age, Plan, Last Visit, 
                                           Provider, Location, Acct#, Responsible Name and Balance. 
                                           (Request)
                                        • Double click to select the appropriate one.
                                        • A Confirm window opens: Press OK to Confirm Assignment to:
                                           patient name; click OK or Cancel.
                                        • If only one patient matches, the Confirm window will 
                                           automatically open.
                                        • If the document contains multiple pages a Confirm window 
                                           opens: Select YES to remove the Cover Page Before 
                                           Transferring?; Click Yes or No.
                                        • If the patient has more than one active Episode, the 'Select 
                                           Active Episode' window will open for selection. 
                                        • The PopUpCommunication tab will open with the following:
                                                  • Date – Current Date 
                                                  • Contact Type – Referral
                                                  • Subject – Subject of the Communication in the InBox
                                                  • Method – Fax
                                                  • Image – Transferred file
                                                  • To be Reviewed - Defaults to checked, but may be 
                                                     unchecked.
                                                            • If checked, the document will appear on the 
                                                               NEW Worklist 'Demographic Documents 
                                                               Requiring Review'.
                                                            • Information displayed includes the Patient 
                                                               Account Number, Name and Document Name.
                                                  • By – The name of the Provider that was selected.
                                                            • CAUTION: If 'To be Reviewed' is checked, and a 
                                                               Provider is NOT selected, the item will NOT 
                                                               display on a Worklist.
                                        • Complete/Change any needed fields and click 'Save'.
                                                  • 'Contact Type' and 'Subject' default, but may be 
                                                     changed.
                                        • Go to the patient and click Exam. Click 'Add' and select the 
                                           appropriate Communication layout used in your office.
                                        • The file will be saved under the 'Communications/Patient 
                                           Annotations' grid; save the Communication layout.

 X (1/24/2020) InBox > Fax Assignment

• Fax assignment will now be based on the following:
          • Login Right Access (already established in previous versions)
          • Match between the Login ID's table 'Location Group Restriction' field and the Fax 
             Setup table 'Service Location Group' field.
          • Match between the Login ID's table 'Department Group' field and the Fax Setup 
             table 'Service Department Group' field.

 (12/20/2019) Instant Message > Field(s) ADDED

• On the 'New Message' tab, the check box 'Connect to:' was added. (Request)
• The name of the patient that is currently displayed when accessing the Instant Message 
   window will display next to the box. Example: Connect to: John Smith?
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Communication
• If checked, when the message is SENT, it will be connected to the current patient.
• When the message is RECEIVED, the top of the IM window will display the following:
          • Patient first and last name
          • [ACCT:#] - Account number (can be shared on a family account)
          • [EHR:#] - Unique EHR number (unique to patient)
• Example: This may be useful if sending a message to a Provider to let them know that 
   the patient is waiting, and possibly upset for some reason.

Customization
 (11/15/2019) Advantage Software > GUI Customization

• GUI stands for 'Graphical User Interface', and is pronounced 'gooey'.
• It is the user interface that includes graphical elements, such as windows, icons and 
   buttons.
• You now have access to control what fonts and colors your Advantage software displays 
   in. (Request)
• On the Patient screen, click the 'Printer & Output Tools' icon in the bottom right corner 
   and select 'GUI Customize'.

• Create the Custom GUI
          • Click the 'Add' command to open the 'Custom GUI Editing' window.
          • All fonts must be selected from the drop-drown, as typing in the field is not 
             accessible.
                    • Name – Assign a name to specify who the custom setting will be used for, 
                       or what computers it will be used on. Example: Providers or ExamRooms.
                    • Main Background Color – Background that everything sits on. 
                              • Seen mostly at the top of the screen in the header area.
                              • Example: In exam, at the top where the Patient, Plan, Loc, and 
                                 Acct# are.
                    • Main Font – Font Type on the Toolbar Icons, as well as on the Main Data 
                       (NOT sub-table records). Allowed range is 6-20.
                    • Main Font Size – Font Size on the Toolbar Icons, as well as on the Main Data
                       (NOT sub-table records).
                    • Main Font – Font Type on the Toolbar Icons, as well as on the Main Data 
                       (NOT sub-table records).
                    • Toolbar Background Color – Background color of the Toolbar with the Icons 
                       at the top and bottom of the screens.
                    • Toolbar Point Size – The size of the Toolbar and Icons. Allowed range is 16-
                       48.
                    • Toolbar Icon Color – Color of the Icons on the Toolbar at the top and bottom
                       of the screens.
                    • Show Tool Bar Captions – 'Y' to show the captions under the Icons on the 
                       Toolbar at the top of the screen, 'N' to hide them.
                    • Panel Color – Color of the Panel where the data is displayed.
                              • Example: On the Patient Demographic where the Patient Information
                                 displays, and on the Exam where the Main Data displays (NOT sub-
                                 tables).
                    • Panel Border Color – Color around the Panels. This includes the Main Data 
                       and the Sub-tables that are sitting on top of Panels.
                    • Tab Parent Color – Color of the Parent tab.
                              • Example: In the Exam, at the top of the Compulink-Owned tabs, 
                                 there is a label that describes what tab you are looking at. The label 
                                 will display in the Parent Color area.
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Customization
                    • Tab Parent Height – Height of the label across the top of the Compulink-
                       Owned tabs. Allowed range is 20-50.
                    • Tab Parent Font Name – Font Type on the label across the top of the 
                       Compulink-Owned tabs.
                    • Tab Child Color – Color of the labels in the sub-table grids.
                    • Tab Child Height – Height of the labels in the sub-table grids. Allowed range
                       is 16-40.
                    • Tab Child Font Name – Font Type in the labels in the sub-table grids.
                    • Grid Color – Background color in the sub-table grids.
                    • Grid Title Font Name – Font Type in the Title/label bar of the sub-table 
                       grids.
                    • Grid Alternate Color – When sub-table grids have multiple records, they are
                       highlighted In alternating colors. The 'Grid Color' is the primary color, and 
                       the 'Grid Alternate Color' is the secondary color.
                    • Grid Font Name – Font Type for the data contained in the sub-table grids.
                    • Grid Header Color – Color of the Header where the column names display in
                       the sub-table grids.
                    • Grid Row Height – Height of the alternating rows of data in the sub-table 
                       grids. Allowed range is 12-20.
          • Save the record.

• Update the Custom GUI
          • Once the Custom GUI has been created, highlight it, click the 'Update' command 
             and select 'Highlighted'.
          • Click 'Yes' on the confirmation: Select Yes to Confirm Selection of GUI: XXX (XXX 
             will display the name of the Custom GUI).
          • This will assign the highlighted GUI to the current LOGIN ID.
          • You must CLOSE completely out of the Advantage software and log back in for the 
             changes to take effect; LOGGING out and back in will NOT work.

• Other Custom GUI Table Options
          • Search – Search the table for a specific Custom GUI.
          • Edit – Edit the highlighted Custom GUI; you may also double click on the record.
          • Delete – Delete the highlighted Custom GUI. 
                    • You must click 'Yes' on the confirmation: Are you SURE you want to Delete 
                       highlighted item AND ALL Detail entries associated with it?
                    • If the Custom GUI is connected to a Login ID, the following Warning will 
                       appear: Unable to Delete Custom GUI as in use by another User!
          • Update – Assign a GUI.
                    • Highlighted – Assigns the highlighted Custom GUI to the current Login ID.
                              • Click 'Yes' on the confirmation: Select Yes to Confirm Selection of 
                                 GUI: XXX (XXX will display the name of the Custom GUI).
                    • Default – Assigns the Compulink Default GUI to the current Login ID.
                              • Click 'Yes' on the confirmation: Select Yes to Confirm Default GUI!
                    • All – Assigns the highlighted Custom GUI to ALL Users.
                              • This option is only available to Users with Login Right 'System 
                                 Administrator' set to Full.
                              • Click 'Yes' on the confirmation: Select Yes to Confirm Selection of 
                                 GUI: XXX for ALL Users! (XXX will display the name of the Custom 
                                 GUI).

• Logging into Advantage Software.
          • When the Login screen opens, it will display the Custom GUI of the LAST person 

1100 Business Center Circle | Thousand Oaks, CA  91320 | 805.716.8677 | eLearning@compulinkadvantage.com
www.compulinkadvantage.com

   9



Customization
             that logged out of that workstation.
          • Once the new person Logs in, it will then display the Custom GUI that is assigned 
             to their Login ID.

 X (10/28/2020) Screen Builder > ALL > Migrate Tabs to 12.2 Theme

• A NEW Screen Builder tool was created to assist in migrating customized User-Owned 
   tabs to the NEW theme that was introduced with Version 12.2.
• The tool can perform part of the migration, but there will still be some manual changes 
   that need to be done for the full effect.
• If your customized tabs are very similar to the Compulink-Owned tabs, you may consider 
   duplicating the V12.2 Compulink-Owned tab, and adding your customization, rather than 
   migrating your existing tab.
          • This will assure that you have all of the latest enhancements to the tab that you 
             may have been missing due to using a custom tab.
• It is NOT mandatory that custom tabs be migrated, simply an option.

From Main Menu, go to Utility > Customize Screens/Table Structures/Rules > Screen 
Builder. Choose the area you want to access screens for, such as Patient or Exam.

• Migrating the Tab:
          • NOTE: Once you migrate a tab to V12.2, it can NOT be undone!
          • If you would like to make a backup of the tab prior to running the tool, click 'Tab >
             Load' and select the tab that you would like to migrate to the new theme.
          • Once loaded, Click 'Tab > Duplicate'; click 'OK' on the Duplicate Tab message.
                    • This will create a duplicate of the tab with the same name and '- Copy(1)' 
                       after.
          • When ready to migrate, click 'Tab > Migrate 12.1 screens to 12.2'.
          • The 'Load Tab' window opens for you to select the tab to migrate; highlight and 
             click 'OK', or double click to select.
                    • Only tabs that have NOT yet been migrated will display in this window to 
                       select.
          • Click 'OK' on the message: Conversion Complete.
          • Click 'OK' on the message: Tab Migrated.

• Viewing the Tab:
          • Click 'Tab > Load'; in the 'Load Tab' window on the far right, the 'Version' will now 
             display 'V12.2'.
          • Highlight the tab and click 'OK', or double click to select.
          • Click the yellow Tab bar at the top to expand and view the information; notice that 
             the 'Compulink GUI Style' box is now checked.

• Compulink GUI Style check box
          • Once this box has been checked, the following will occur:
                    • The tab will display 'V12.2' under the 'Version' column when loading a tab.
                    • The tab will no longer display as an option when selecting 'Migrate 12.1 
                       screens to 12.2'.
                    • It will prevent the following types of customization to the tab:
                              • Changes to Fonts (Ex: size, color, etc.)

• Making Manual Changes:
          • As previously stated, the tool can perform part of the migration, but there will still 
             be some manual changes that need to be done.
          • The default font for labels and fields is now: Segoe UI, size 9. If things overlap, 
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Customization
             you may have to change to size 8.

 (8/6/2020) Smart Function Editor > ALL > ADDED: GetQueryInteger

• SF: GetQueryInteger(ReqSQLGridName,ReqFieldName: String): Integer;
• WHAT IT DOES: Pulls the integer/number out of a SQLGrid object.
• WHERE IT ATTACHES: Assigned to the HoverMenu icon in Screen Builder.
• DEFINITIONS:
          • ReqSQLGridName = Name of the SQLGrid to pull data from
          • ReqFieldName = Name of the Field in the SQLGrid to pull data from
          • Integer = The ReqFieldName number must be in whole number (integer) format.
• EXAMPLE: FaxCancel
             begin
             SF.FaxCancel(SF.GetQueryInteger('DOCHIST','DOCUMENTHISTORYUNIQUE'));
             end;

 X (1/27/2020) Smart Function Editor > ALL > Column Order Changed

• The 'Name' and 'Purpose' columns were switched so the 'Name' of the Smart Function will
   now display BEFORE the 'Purpose'.

 (4/2/2019) Smart Function Editor > ALL > Patient Tracking INNER JOIN

• Patient Tracking 'INNER JOIN' option now available.

 (8/14/2020) Smart Function Editor > Exam > EDITED: GridDisplay

• SF: function GridDisplay( Name: String; ReqLeft: Integer = 0; ReqTop: Integer = 0; 
HealthHistoryEpisodeFilter: Boolean = false ): Boolean; 
• WHAT IT DOES: Opens a window of multiple related exam elements for Add or Edit.
• WHERE IT ATTACHES: Assigned to the PopUp Grid icon in Screen Builder.
• DEFINITIONS:
          • Name = Name to display at the top of the GridEdit window
          • ReqLeft = The number of pixels from the left screen edge where the user wants 
             the grid to appear.
          • Integer = The ReqLeft number must be in whole number (integer) format.
          • ReqTop = The number of pixels from the top screen edge where the user wants the
             grid to appear.
          • Integer = The ReqRight number must be in whole number (integer) format.
          • HealthHistoryEpisodeFilter = Health History grids will filter by the Episode 
             connected to the Exam.
• EXAMPLE: GridEditDisability
             begin
             SF.GridDisplay('Disability',0,0,True);
             end;

 (8/20/2019) Smart Function Editor > Exam > Smart Function(s) ADDED

• A NEW 'PrintDocument' Smart Function was created.
• When attached to an object (like a print button) in the Exam, it will allow the user to 
   specify the exact document(s) to print.
• A '*' for a wildcard may also be used if several documents start/end with the same 
   letters.
          • Example: 'ExamRx*' can be used for ExamRxAllFinal and ExamRxAllFinalSign.
• For an example on how to use this NEW Smart Function, see the following topic in the 
   Compulink Advantage Online Help Manual:
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   http://help.compulinkadvantage.com/en/cbs/smart_functions_available.htm

Data Mining
 (11/19/2020) .Parameter > ALL > ADDED: DEPARTMENTGROUPUNIQUEPARAM

• The NEW Parameter DEPARTMENTGROUPUNIQUEPARAM was added.
• Description – Corresponds to the 'Department Group' field in the Login IDs table. If 
   added to a Data Mining Query, it will look for a match in the data to the 'Department 
   Group' assigned to the person that is currently logged into the software and running the 
   Query.
• Worklist in the Advantage software for example: Task Management All

 (11/19/2020) .Parameter > ALL > ADDED: LOGINGROUPUNIQUEPARAM

• The NEW Parameter LOGINGROUPUNIQUEPARAM was added.
• Description – Corresponds to the 'Staff Group' field in the Login IDs table. If added to 
   a Data Mining Query, it will look for a match in the data to the 'Staff Group' assigned to 
   the person that is currently logged into the software and running the Query.
• Worklist in the Advantage software for example: Task Management All

Exam
 (11/6/2020) .Display Changes > Exam Header Enhancement(s)

• Header
          • The header itself was enhanced to make better use of the space, and several items
             were change from yellow highlight to BOLD font. (Request)

• Age
          • The patient's Age will now display in the header. (Request)
          • If the patient is less than 3 years old, the age will display in months.
          • If the Birth date is not entered on the Demographics, 'Missing' will display.

• Allergy
          • The date the last time the Allergies were reviewed will now display in the header.

• Companion Accounts
          • The chevrons < > were removed from around the word Companion.

• Date
          • Changed to a taller and bolder font.

• Global Period
          • If a patient is within their post-surgical follow-up time, 'Global Period' will now 
             display in the Exam header.
          • Click the label to open the Information window to see what Global Periods exist, or
             have recently expired.

• Hx
          • This label was changed from 'Health Hx'.

• Layout Name
          • Changed to a taller and bolder font.
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• Med
          • This label was changed from 'Meds'.

• Phone Number
          • The patient's Cell phone number will now display in the header.
          • If no Cell phone is listed, then the Home number will display.

 X (11/13/2019) .Display Changes > Icons Condensed Under Ellipsis

• ALL CHS-Owned tabs
          • All icons were moved under a 3 vertical dot ellipsis icon to provide a cleaner look.
                    • Hover the mouse over the ellipsis to open a window with the available icons 
                       for that area, then single left click to select.
                    • Forward icons and Filter icons for grids were also moved under the ellipsis 
                       icon.
          • To disable this option, see the topic Utility Enhancements: System Administrator > 
             Login > IDs > Field(s) Added/Edited/Removed: Enable Grid Hover Menus.

 X (10/29/2019) .Display Changes > Menu Commands

• The two rows of commands were combined into one row, and modifications were made.
• The following commands were REMOVED from the main menu: 
          • Alert, Docs, Insured, Letters, Notes, Referral, and Todo 
• Jump – NEW command added to access remaining commands to save on space.
• Alert – Moved to NEW 'Jump' command and renamed to 'Alerts'.
• Appt – Moved to NEW 'Jump' command and renamed to 'Appointments'.
• Insured – Moved to NEW 'Jump' command.
• Ledger – Moved to NEW 'Jump' command.
• MACRA – Renamed from 'M'.
• Referral – Moved to NEW 'Jump' command.
• Search icon – Moved under the 'Utility' command.
• View
          • All Available Orders – Removed from the menu, as it is now available via the NEW 
             'Orders' command in the NEW 'SMART Patient Orders' window.
          • All Educational Resources – Removed from the menu, as it is now available via the 
             NEW 'Orders' command in the NEW 'SMART Patient Orders' window.
          • Diagnosis Related Orders – Removed from the menu, as it is now available via the 
             NEW 'Orders' command in the NEW 'SMART Patient Orders' window.

 (11/13/2020) Command (E-Rx)(AdvantageERx) > NEW 'Authorization' Command
ADDED

• The NEW command 'Authorization' was added for future development. (Available 
   12.3.0.27)

 (3/31/2020) Command (E-Rx)(AdvantageERx) > NEW 'Monitor' Command ADDED

• The NEW command 'Monitor' was added for future development. (Available 12.3.0.27)

 (11/12/2020) Command (E-Rx)(AdvantageERx) > NEW Option ADDED Under 
Utility Command

• The new option 'PMP User Name Password' was added under the 'Utility' command for 
   future development. (Available 12.3.0.27)
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 X (12/4/2019) Command (Fees) > Episode Controlled Pricing

• The SKU Pricing Engine will now look at the PRIMARY or DME Payor that is connected to 
   the Exam Episode for pricing out Inventory.

 X (11/13/2019) Command (Fees) > Posting Charges and Ledger Rights

• The 'Post' button in the 'EHR Automated Fee Posting' window will be grayed out if the user
   has the 'Patient Ledger' Login Right set to either 'None' or 'View Only'.

 (10/21/2020) Command (Fees) > Posting Charges while Ledger in Use

• When clicking Post in the 'EHR Automated Fee Posting' window, if line items are currently 
   being added or edited on the Ledger, the following messages will display: 
          • ‘Patient Record Area currently in USE: <Login Name> /<Workstation Name> 
Access
             Privileges reduced to VIEW ONLY!’ (Example: John Smith / Workstation 1)
          • Clicking ‘OK’ brings up this subsequent message: ‘Unable to Post Charges as 
Ledger is
             in use by someone else on network!’

 (11/3/2020) Command (Fees) > SKU Formula Plan Pricing

• You may now enter an Inventory item into the Exam using the SKU#, and when clicking 
   the 'Fees' command, the software will look at the SKU Formula Plan Pricing table to 
   charge out the material. (Request)
• This is based upon proper setup of the following items:
          • Utility > Look-up Tables > Inventory > SKU Formula Plan Pricing
          • Utility > Look-up Tables > Inventory > SKU Groups
          • Inventory > Miscellaneous (items have been assigned a SKU Group)

 (10/21/2020) Command (Jump) > All > Disabled while Editing

• While editing an Exam, the user is prevented from Jumping to other areas of the 
   software.
• If you click Jump, and select any option, the following message will appear: ‘Unable to 
   Jump to new Area before saving Edits!’

 (11/6/2020) Command (Locate) > NEW Command ADDED

• The NEW command 'Locate' was added to the menu.
• The following options that were under a Search icon in previous versions, can now be 
   found under this NEW command:
          • Exam
          • SQL Options
          • Options with Review
          • Modify EHR Search Options
          • Text within Record
• See the Compulink Advantage Online Help Manual for details on these options.

 X (7/16/2019) Command (MACRA) > Command Renamed

• The command 'MACRA' was renamed from 'M' to better represent the overall legislation.

 X (11/11/2020) Command (Orders) > New Command & SMART Functionality Added

• The NEW command 'Orders' was added to the menu; when clicked, it will open the NEW 
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   'SMART Patient Orders' window.
• This new functionality eliminates several gestures to automated selection of Assessments,
   Plans, Order Sets and Orders.
• It provides access to tables, and provides an easier format for creating Order Sets.
• The SMART functionality will remember and update as Users pull in new data.
• The window displays the following items:
          • Top window – Diagnoses that are attached to the patient record.
                    • Information Displayed 
                              • Done – Once you have made your selections in the bottom window 
                                 and clicked the 'Save with Orders' button, this will display a 'Y', 
                                 indicating that this Diagnosis has been addressed, and you can 
                                 move on to the next one on the list.
                              • Order – Order in which the Diagnoses should appear on the claim
                                        • If the Order was not identified on the previous screen, it will 
                                           automatically default to the Order in which the Diagnoses 
                                           were entered.
                                        • Double left click on the Diagnosis to open the 'Identify Claim 
                                           Order' window and change the claim order; Enter 1-9 and 
                                           click 'OK'.
                                        • The Up/Down arrows on the left may also be used to change 
                                           the order. See the instructions for button identification.
                              • Code – Diagnosis ICD-10 Code
                              • Description – Diagnosis Description
                    • Buttons
                              • Double right arrows – Forward All Diagnoses from previous visit.
                              • Up/Down – Change the 'Order' of the highlighted Diagnosis. 
                                        • Highlight a Diagnosis and click either the Up or Down arrow to
                                           move it in the list; the 'Order' will automatically update.
                                        • You may also double left click on the Diagnosis to identify the 
                                           claim order.
                              • Plus Sign – Add a NEW Diagnosis to the patient record. 
                                        • Click to open the 'Diagnosis Add' screen.
                                        • When the Diagnosis is saved, it will display both in the 
                                           'SMART Patient Orders' screen AND in the patient exam 
                                           record.
                                        • The 'Order' field will default based upon the current Diagnosis 
                                           count in the window.
                              • Pencil – Edit the highlighted Diagnosis. 
                                        • Highlight a Diagnosis and click the Pencil to open the 
                                           'Diagnosis Edit' screen.
                                        • When the Diagnosis is saved, it will display the updated 
                                           information both in the 'SMART Patient Orders' screen AND in 
                                           the patient exam record.
                              • Trash can - Delete the highlighted Diagnosis.
                                        • Highlight a Diagnosis and click the Trash can. Select 'Yes' on 
                                           the following confirmation message: Press YES to confirm 
                                           Deletion of Diagnosis: XXX (where XXX is replaced with the 
                                           ICD-10 Code of the highlighted Diagnosis).
                                        • After confirmation, the Diagnosis will be removed from both 
                                           the 'SMART Patient Orders' screen AND the patient exam 
                                           record.
          • Assessment memo field – Field from the Diagnosis/Assessment/Plan screen, 
             displaying the Assessments that have already been attached to the highlighted 
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             Diagnosis in the top window.
                    • Double left click in the window to open the 'Diagnosis Edit' screen.
                    • When the Diagnosis is saved, it will display the updated information both in 
                       the 'SMART Patient Orders' screen AND in the patient exam record.
          • Plan memo field - Field from the Diagnosis/Assessment/Plan screen, displaying the
             Plans that have already been attached to the highlighted Diagnosis in the top 
             window.
                    • Double left click in the window to open the 'Diagnosis Edit' screen.
                    • When the Diagnosis is saved, it will display the updated information both in 
                       the 'SMART Patient Orders' screen AND in the patient exam record.
          • Assessments check list – List of Assessments connected to the Diagnosis (on the 
             patient record, and in the 'Assessment/Plan By Diagnosis' table).
                    • Assessments Displayed
                              • Any Assessments that are connected to the patient record, will 
                                 display grayed out in the window; this allows you to see what has 
                                 already been selected.
                              • All other Assessments connected to the Diagnosis in the table, but 
                                 NOT connected to the patient record, will display in black.
                              • Left click on an Assessment (the 'Short Desc' field from the table) to 
                                 highlight it; a hover box will pop up to display the 'Long Desc'.
                              • Check the box next to any Assessments that you would like to 
                                 connect to the patient record.
                    • Assessments label
                              • Left click on the underlined label to open the 'Select Assessments' 
                                 window with the FULL list of options for ALL Diagnoses.
                    • List field
                              • Left click in the list field, and then right click to display a list of items
                                 to choose from.
                              • Assessment/Plan Table – Opens the 'Assessment/Plan Items' table.
                                 (Request)
                              • Default Toggle – Set the highlighted Assessment as a default for the 
                                 Diagnosis that is highlighted in the top window.
                                        • Left click the Assessment, right click and select 'Default 
                                           Toggle'.
                                        • Click 'Yes' on the message: Select YES to Toggle Default for: 
                                           XX (XX represents the highlighted Assessment)
                                        • Click 'OK' on the message: Default Toggled for: XX
                                        • The Assessment will now display as a default connected to the
                                           Diagnosis in the 'Assessment/Plan By Diagnosis' table.
                                        • Follow the same steps to reverse change.
                              • Diagnosis Mapping – Opens the 'Assessment/Plan By Diagnosis' 
                                 table.
                              • Hide Item – Hide the highlighted Assessment.
                                        • Left click the Assessment, right click and select 'Hide Item'.
                                        • Click 'Yes' on the message: Select YES to Hide: XX (XX 
                                           represents the highlighted Assessment)
                                        • The Assessment will be removed from the list on the screen.
                                        • In the 'Assessment/Plan By Diagnosis' table, the Assessment 
                                           will now be marked as hidden.
                                        • Follow the same steps to reverse change.
          • Plans check list – List of Plans connected to the Diagnosis (on the patient record, 
             and in the 'Assessment/Plan By Diagnosis' table).
                    • Plans Displayed
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                              • Any Plans that are connected to the patient record, will display 
                                 grayed out in the window; this allows you to see what has already 
                                 been selected.
                              • All other Plans connected to the Diagnosis in the table, but NOT 
                                 connected to the patient record, will display in black.
                              • Left click on a Plan (the 'Short Desc' field from the table) to highlight
                                 it; a hover box will pop up to display the 'Long Desc'.
                              • Check the box next to any Plans that you would like to connect to 
                                 the patient record.
                    • Plans label
                              • Left click on the underlined label to open the 'Select Plans' window 
                                 with the FULL list of options for ALL Diagnoses.
                    • List field 
                              • Left click in the list field, and then right click to display a list of items
                                 to choose from.
                              • Assessment/Plan Table – Opens the 'Assessment/Plan Items' table.
                                 (Request)
                              • Default Toggle – Set the highlighted Plan as a default for the 
                                 Diagnosis that is highlighted in the top window.
                                        • Left click the Plan, right click and select 'Default Toggle'.
                                        • Click 'Yes' on the message: Select YES to Toggle Default for: 
                                           XX (XX represents the highlighted Plan)
                                        • Click 'OK' on the message: Default Toggled for: XX
                                        • The Plan will now display as a default connected to the 
                                           Diagnosis in the 'Assessment/Plan By Diagnosis' table.
                                        • Follow the same steps to reverse change.
                              • Diagnosis Mapping – Opens the 'Assessment/Plan By Diagnosis' 
                                 table.
                              • Hide Item – Hide the highlighted Plan.
                                        • Left click the Plan, right click and select 'Hide Item'.
                                        • Click 'Yes' on the message: Select YES to Hide: XX (XX 
                                           represents 
                                           the highlighted Plan)
                                        • The Plan will be removed from the list on the screen.
                                        • In the 'Assessment/Plan By Diagnosis' table, the Plan will now
                                           be marked as hidden.
                                        • Follow the same steps to reverse change.
          • Order Sets check list – List of Order Sets connected to the Diagnosis in the 
             'Diagnosis driven Ordersets' table.
                    • Order Sets Displayed
                              • Items set as Default in the table will be marked with a check and 
                                 grayed out; ones not set as Default will not have a check. 
                              • Check the box next to an Order Set to add the individual Orders to 
                                 the 'Order Details'.
                                        • When checked, it will be grayed out and NOT able to be 
                                           unchecked.
                                        • Individual Orders may be checked and unchecked as needed.
                    • Order Sets label
                              • Left click on the underlined label to open the 'Select Order Sets' 
                                 window with the FULL list of options for ALL Diagnoses.
                    • List field
                              • Left click in the list field, and then right click to display a list of items
                                 to choose from.

1100 Business Center Circle | Thousand Oaks, CA  91320 | 805.716.8677 | eLearning@compulinkadvantage.com
www.compulinkadvantage.com

   17



Exam
                              • OrderSet Table – Opens the 'Order Set' table.
                              • Default Toggle – Set the highlighted Order Set as a default for the 
                                 Diagnosis that is highlighted in the top window.
                                        • Left click the Order Set, right click and select 'Default Toggle'.
                                        • Click 'Yes' on the message: Select YES to Toggle Default for: 
                                           XX (XX represents the highlighted Order Set)
                                        • Click 'OK' on the message: Default Toggled for: XX
                                        • The Order Set will now display as a default connected to the 
                                           Diagnosis in the 'Assessment/Plan By Diagnosis' table.
                                        • Follow the same steps to reverse change.
                              • Diagnosis Mapping – Opens the 'Assessment/Plan By Diagnosis' 
                                 table.
                              • Hide Item – Hide the highlighted Order Set.
                                        • Left click the Order Set, right click and select 'Hide Item'.
                                        • Click 'Yes' on the message: Select YES to Hide: XX (XX 
                                           represents the highlighted Order Set)
                                        • The Order Set will be removed from the list on the screen.
                                        • In the 'Assessment/Plan By Diagnosis' table, the Order Set 
                                           will now be marked as hidden.
                                        • Follow the same steps to reverse change.
          • Order Details check list – List of Individual Orders that make up the Order Sets 
             that are connected to the Diagnosis in the 'Diagnosis driven Ordersets' table.
                    • Order Details Displayed
                              • Items set as Default in the table will be marked with a check and 
                                 grayed out; ones not set as Default will not have a check. 
                              • Check or uncheck as needed.
                              • As new 'Order Sets' are checked on the bottom left, the individual 
                                 Orders will appear on the list under 'Order Details'; check or 
                                 uncheck as needed.
                    • Order Details label
                              • To add Supplemental Orders, left click on the underlined label to 
                                 open the 'Select Order Type' window. 
                              • This allows you to add the following items 'on-the-fly': Appointment, 
                                 Education, Goal, Immunization, Medication, Order, Referral, Surgery,
                                 Test, Todo Action, Treatment or Products.
                              • Diagnosis does NOT appear as an option in this list as it did in 
                                 previous versions, as it now appears in its own window above the 
                                 Order Details.
                    • List field
                              • Left click in the list field, and then right click to display a list of items
                                 to choose from.
                              • Order Tables – Opens the 'Select Detail Type' window; double click 
                                 on one of the following to open the corresponding table to make 
                                 changes:
                                        • Appointment – Next Appointment
                                        • Education – Resources Item
                                        • Goal – Goal Name
                                        • Immunization – Immunization Name
                                        • Medication – Medication Name
                                        • Order – Orders Definition
                                        • Referral – Referral Sources
                                        • Surgery – Surgery Name
                                        • Test – Test Name
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                                        • Todo Action – Todo/Followup Items
                                        • Treatment – Treatment Name
                                        • Products – Retail Products
                              • Default Toggle – Set the highlighted Order as a default for the 
                                 Diagnosis Set that is highlighted in the window to the bottom left.
                                        • Left click the Order, right click and select 'Default Toggle'.
                                        • Click 'Yes' on the message: Select YES to Toggle Default for: 
                                           XX (XX represents the highlighted Order)
                                        • Click 'OK' on the message: Default Toggled for: XX
                                        • The Order will now display as a default connected to the 
                                           Order Set in the 'Order Set' table.
                                        • Follow the same steps to reverse change.
                              • Hide Item – Hide the highlighted Order.
                                        • Left click the Order, right click and select 'Hide Item'.
                                        • Click 'Yes' on the message: Select YES to Hide: XX (XX 
                                           represents the highlighted Order Set)
                                        • The Order will be removed from the list on the screen.
                                        • In the 'Order Set' table, the Order will now be marked as 
                                           hidden.
                                        • Follow the same steps to reverse change.

• Buttons at the bottom
          • Cancel – Cancel the Orders and close the window. Clicking the 'X' in the top right 
             corner will also act as a 'Cancel'.
          • Save with Orders – Save the window with selected Assessments, Plans and Orders.
             This will also mark the 'Done' column at the top with a 'Y'.
          • Save without Orders – Save the window with selected Assessments and Plans 
             ONLY, do NOT save the Orders.

 (11/8/2019) Command (Orders) > Order Sets > ADDED: ADHD

• ADHD – Order attached: Monarch Trigeminal Nerve Stimulation (eTNS) System

 X (12/30/2019) Command (Orders) > Order Sets > Detail Enhancements

• Compulink-Owned records - You now have the following options for 'Detail': (Request)
          • Add – Add Detail to CHS-Owned records.
          • Edit – Change the Display Order of the Detail items.
          • Hide – Hide Detail items.
          • Default – Change the Default status of an item.

• When clicking 'Detail >Add', the 'Select Detail Type' window now displays the full 
   description of the items to choose from, you no longer need to enter the one letter code.
          • Double click to select a Type, and then follow the prompts for adding that 
             particular Order to the Set.

• You now have the option of adding the following 'Types' of Detail:
          • Appointment – This will display the Appointment Reasons to choose from.
                    • Appointments attached to Order Sets will appear in the Orders PopUp 
                       window to select to add to the 'Next Appointments' grid.
                    • If set to 'Default' on the Order Set, they will automatically be checked in the
                       PopUp window, and if not unchecked, will be saved into the 'Next 
                       Appointments' grid.
          • Diagnosis
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          • Todo Action – This will display the list of Todo/Followup items to choose from.
                    • Todos attached to Order Sets will appear in the Orders PopUp window to 
                       select to add to the 'Phone Calls / Action Items' grid.
                    • If set to 'Default' on the Order Set, they will automatically be checked in the
                       PopUp window, and if not unchecked, will be saved into the 'Phone Calls / 
                       Action Items' grid with an 'Add Date' and 'Due Date' of the current date.
                    • The 'Add ID', 'ID' and 'Dept' will all default to blank, as the software does 
                       not know the staff member for assignment.

 X (11/16/2020) Command (Orders) > Order Sets > Diagnosis Mapping > Order Set 
Detail

• Order Set Detail
          • The Order Set Detail at the bottom of the screen will now display a 'Hide' field and 
             an 'Owner' field.
                    • The 'Owner' field will default to 'C' for Compulink-Owned records and 'U' for 
                       records added by the User.
                    • To 'Hide' the item, highlight it, click on 'Detail > Hide'; repeat the process to
                       unhide.
          • You are now able to add Order Sets to Compulink-Owned records. (Request)

 X (8/1/2019) Command (Print) > .Options Added/Edited/Removed

• The following Print options were REMOVED, as they are now handled via the NEW 
   Document Creation window when selecting Print > Letter:
          • Send Letter to Patient Portal
          • Send Letter to Referral/Contact

• Print > Selected was changed FROM Print > Range.
          • The NEW Document Creation Window will now open.
          • For full details, go to the Patient Area Enhancements section and find the topic: 
             Command (Print) > NEW Document Creation Window.

 (11/17/2020) Command (Print) > Audit Report > NEW Item(s) Added

• If a document is sent from the Exam to the recipient's Direct E-Mail, the following NEW 
   Audit Event will display on the report: Direct Send Document.

 (10/28/2020) Command (Print) > Complete and Positive > NEW Document 
Creation Window

• When selecting Print > Complete or Positive, a NEW Document Creation window will flash 
   on the screen, and the document will automatically merge.
• Once the user closes the merged document, the software will automatically add a copy of 
   it to the Exam record (EHR Images).

 (3/26/2019) Command (Print) > Letter > Document(s) ADDED

• The following are for ALL Compulink Advantage products:
• OpioidTreatUseAgreement, OpioidTreatUseAgreementSign, OpioidTreatUseAgreement2 
   and OpioidTreatUseAgreement2Sign
          • These are 2 Opioid Treatment Agreements, and their sign versions, for the new 
             2019 PI ePrescribing bonus measure.

 (11/26/2019) Command (Print) > Letter > Document(s) ADDED
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• ConsentEPrescribe and ConsentEPrescribeSign
          • These are the 'Consent For E-Prescribing' documents that the patient must sign.
          • They are a consent to request and use the patient's prescription medication history
             from other Healthcare providers and/or third party pharmacy benefit payors for 
             treatment purposes.
          • The 'ConsentEPrescribe' has a blank signature line, so the document may be 
             printed and handed to the patient.
          • The 'ConsentEPrescribeSign' allows for an electronic signature, and will then merge
             back into the Documents area in the patient exam.

• ConsentTeleHealthServices
          • This is the 'Consent For Telehealth Services' document that the patient must sign if
             they wish to receive health care services via Telehealth/video conference.

• ExamAssessClinicalTMSSign
          • This is the Transcranial Magnetic Stimulation (TMS) Screening Questionnaire.

• ExamProgressNoteTMS 
          • This is a TMS report that prints Transcranial Magnetic Stimulation therapy (90869, 
             90867 and 90868).
          • It includes supporting protocol fields and TMS history.

• PatientAuthorizationMedInfo
          • This is the 'Authorization to Share Medical Information' document.
          • It is a release that covers information concerning medical or psychiatric conditions,
             and may include a history of drug and/or alcohol use, psychiatric illness and/or 
             sexually transmitted diseases.

• PatientCrisisSafetyPlan
          • Created for the patient to sign.
          • Merges the following data if entered into the Advantage software:
                    • Warning Signs that a crisis may be starting.
                    • Internal coping strategies.
                    • People and social settings that provide a distraction.
                    • People I can ask for help.
                    • Professionals and Agencies I can contact during a crisis.
                    • Make the environment safe.

• PatientMedicalSafetyPlan
          • Created for the patient to sign.
          • Merges the following data if entered into the Advantage software:
                    • Consent to 'Provide verbal/written consent to contact 911 in the event a 
                       client becomes unresponsive or exhibits medical concern during a session.'
                    • Two emergency contacts to be called after calling 911.
                    • PCP contact information.
                    • Other Doctors.
                    • Medical Case Manager.
                    • Provide 24-hour nursing line with client's insurance agency OR local hospital
                       in case the family has any medical questions.

 (11/26/2019) Command (Print) > Letter > Document(s) EDITED

• ExamCompleteCurrent
          • The filter was changed from 'all exams' to 'this exam' in the following areas:

1100 Business Center Circle | Thousand Oaks, CA  91320 | 805.716.8677 | eLearning@compulinkadvantage.com
www.compulinkadvantage.com

   21



Exam
                    • Allergies
                    • Current Psychiatric Medications
                    • Current Non-Psychiatric Medications
                    • Discontinued Psychiatric Medications
                    • Medications

• ExamCompleteCurrentProgress
          • Marked with Retired/Discontinued notes, as it will no longer be used by Compulink.

• ExamIndividualGroupSessionNote and ExamIndividualGroupSessionNoteSign
          • Therapies/Treatments Received section – The Treatment 'Location' was added.

• ExamIndividualServicePlan
          • The filter for Goal was changed from 'all exams' to 'this exam'.
          • The filter to print only Orders with a Category of 'objectives' was removed, so ALL 
             Orders will print.

• ExamMHIntakeNarrative and ExamPsychFollowupNarrative
          • Current Psychiatric Medications – The 'Started' date was added.
          • Current Non-Psychiatric Medications – The 'Started' date was added.
          • Discontinued Psychiatric Medications – The 'Discontinued' date was added.

• ExamPsychMedHistory
          • The header was renamed from 'Psychiatric Medication History' to 'Medication 
             History'.

 (7/15/2020) Command (Print) > Letter > Document(s) EDITED

• ExamMHIntakeNarrative
          • Family Dynamics – This is a NEW section added.
          • The following fields from the 'Psych Simple SOAP' layout were added:
                    • Subjective (CC/HPI)
                    • Objective
                    • Assessment
          • Addictions in Remission – The header was renamed from 'Resolved Addictions'.
          • The filter for all of the sub-tables was changed from 'all exams' to 'this exam'.

 (8/11/2020) Command (Print) > Letter > Document(s) EDITED

• ExamLabAllOrders, ExamLabAllOrdersSign, ExamLabOnlyOrders and 
   ExamLabOnlyOrersSign
          • Document footer – The patient 'EHR' number was added, as a unique identifier.

 (8/11/2020) Command (Print) > Letter > Document(s) EDITED

• ExamLabRadiologyOrders and ExamLabRadiologyOrdersSign
          • Document footer – The patient 'EHR' number was added, as a unique identifier.

 X (11/17/2020) Command (Print) > Letter or Selected > NEW Document Creation 
Window

• When selecting Print > Letter or Selected, a NEW Document Creation window will open.
• Documents with the 'Sign' option that are Printed/Sent from the Exam, will also display in
   the 'EHR Images'.(Request)
• For full details, go to the Patient Area Enhancements section and find the topic: Command
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   (Print) > New Document Creation Window.

 (11/19/2020) Command (Print) > Letter to Multiple Referral/Contact > 
Automatically Sent Via PracticeWatch

• When selecting Print > Letter to Multiple Referral/Contact, after selecting the recipient's, 
   the following message will appear: Letters have been Queued up for PracticeWatch to 
   Send!
• The user does not need to take any other action; as long as PracticeWatch is running, the 
   letters will be sent either by Direct E-Mail or Fax (if an E-Mail is not found).

 (11/16/2020) Command (Print) > Letter to Multiple Referral/Contact > Cannot 
Send Signed Documents

• When selecting Print > Letter to Multiple Referral/Contact, if a 'Sign' version of a letter is 
   selected, a confirmation window opens with the following: Select YES to Skip Signatures 
   within Document!
• If you select 'No', the following message will appear: Multi-Select Print option utilizes 
   PracticeWatch to deliver the Document to each selected individual so if you want 
   signatures then you will need to print individually!

 (4/29/2019) Command (Utility) > NEW Option for ScreenBuilder

• The NEW option to access the Screen Builder was added to the Utility command.
• This will save time from going to the main menu and clicking on Utility > Customize 
   Screen/Table Structure/Rules.

 (3/24/2020) Command (Utility) > Video Session

• The Advantage Telehealth solution, provides convenient, accessible care for patients 
   through video conferencing.
• For full details on this Utility, see the following topic in the Advantage Help file: 
   Telehealth: Remote Video Session

 (11/25/2019) Command (Utility) > Healthcare Maintenance > Resources > Item 
> ADDED

• AL-ANON
• Al-ateen
• Alcoholics Anonymous
• Association of Jewish Family and Childrens Agencies
• Cocaine Anonymous
• Co-Dependents Anonymous
• FAN-Families Against Narcotics
• Food Addicts
• Gamblers Anonymous
• Hoarding
• Marijuana Anonymous
• Mental Health
• NAR-ANON
• Narcotics Anonymous
• National Council on Problem Gambling
• NIDA
• Overeaters Anonymous
• SAMHSA
• Save a Star
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• Secular Sobriety
• Sex Addicts Anonymous
• SMART Recovery
• TAP - The Addicts Parents United
• Women for Sobriety

 X (11/8/2019) Data Entry > NEW Diagnosis Driven Orders Window

• After adding a Diagnosis (either manually or via an Encounter Favorite), upon saving the 
   record, the NEW 'SMART Patient Orders' window will open.
• The header displays the Diagnosis that was selected.
• For details on how the rest of the window functions, see the following topic: Command 
   (Orders) > New Command & SMART Functionality Added.

 (1/22/2020) Encounter Favorites > Option to Select Multiple Plans

• When using Encounter Favorites, the user now has the option of selecting multiple Plans. 
   (Request)
• This is accomplished via the NEW 'SMART Patient Orders' window that now opens after 
   saving the Diagnosis.
• For details on the NEW window, see the following topic: Command (Orders) > New 
   Command & SMART Functionality Added.

 (11/11/2020) Encounter Favorites > SMART Patient Orders

• The NEW 'SMART Patient Orders' window will only open when using Encounter Favorites if 
   the user's Login ID is set for 'Prompt for OrderSet after Diagnosis Add'='Y'.
• This will allow the user to skip the prompts, and click the 'Orders' command to open the 
   window when they choose.
• This NEW window lets the user Add/Edit the following: Assessments, Plans and Orders.

 (11/6/2020) Encounter Favorites > Single Diagnosis Auto-Selected

• If the Encounter Favorite only has one Diagnosis assigned, when the 'Select Diagnosis' 
   window opens, it will now automatically be checked, and the user just needs to click 'OK'.

 (11/25/2019) Layouts > Layout(s) ADDED

• PopUpTMS
          • This layout was created to support Transcranial Magnetic Stimulation therapy.
          • It contains the following tab: PopUpTMS.
          • See the following topic for details on the 'PopUpTMS' tab: Tabs > Tab(s) ADDED.

• Psych Simple SOAP
          • The layout was designed for Psychiatrists who need a basic note to document in 
             SOAP format, and do NOT need to meet Meaningful Use due to being a cash office.
          • It contains the following tabs: Dictation and HiResMedication MH.
          • The following OpenOffice documents are attached:
                    • Print > Complete has the ExamComplete document.
                    • Print > Positive has the ExamPositive document.

• TMS
          • This layout was designed to support Transcranial Magnetic Stimulation therapy.
          • It contains the following tabs: TMS and EHR Documents.
          • See the following topic for details on the 'TMS' tab: Tabs > Tab(s) ADDED.
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 (10/17/2019) Look-up Tables > Right Click Access to Single Column Tables

• When you click the drop-drown at certain fields, the table is a single column list of items.
• If the user has Table Editing Rights, they will now have the option to access and edit the 
   table directly from many of these fields (not all of them at this point).
• Left click in the field first to make sure that the cursor is in the correct field, then right 
   click; the table will either automatically open, or give you the option to select 'View 
   Lookup List Entries' to open the table.

 (11/5/2020) Look-up Tables > Diagnosis > Name > Item(s) EDITED

• Several of the descriptions have been updated per DSM-5 Standards. (Request)

 X (11/8/2019) Look-up Tables > Next Appointment > Provider Added

• The NEW field 'Provider' was added to the table.
• When the Next Appointment is selected, the Provider will populate the 'Resource' field.

 X (10/22/2019) OpenOffice Documents > Next Appointment Database Field 
Changes

• In the exam, there is an option for adding the Next Appointment recommendations.
• The fields for 'Reason' and 'ID' were changed to look-up fields in the previous version.
• If you created any custom OpenOffice documents, you should have updated the logic that
   pulls from these fields.
          • ExamAppt.Reason > ExamAppt.ApptReasonUnique
          • ExamAppt.ID > ExamAppt.LogUnique
• Both of these fields ARE NOW RETIRED in version 12.2.

 (11/25/2019) Tabs > Tab(s) ADDED

• Dictation 
          • This tab was designed for Psychiatrists who need a basic note to document in 
             SOAP format, and do NOT need to meet Meaningful Use due to being a cash office.
          • It includes memo fields for entering the following: Subjective (CC/HPI), Objective, 
             Assessment and Plan.
          • All memo field labels have a Smart Function attached; when clicked, the field will 
             be cleared of data.
          • It also includes grids for the following: Labs and Diagnosis/Plan.
          • Highlight the Ellipsis in the top left corner for the following options:
                    • Encounter Favorites
                    • Default Normals
                    • Forward Select Date
                    • Forward Last Value
                    • Forward Last Positive

• PopUpTMS
          • This tab was created to support Transcranial Magnetic Stimulation therapy.
          • It includes areas to enter/view the following: Therapy/Treatment, Provocations, 
             Precautions, Protocol, Treatment, Subjective, Objective, Assessment and Plan.

• TMS
          • This tab was created to support Transcranial Magnetic Stimulation therapy.
          • Use the ellipsis to Add a Therapy/Treatment record; this will open the PopUpTMS 
             tab.
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          • The following icons will bring up a PopUp with additional information:
                    • Psychiatric ROS
                    • Assessment Tools
                    • Print Treatment Plan
          • The following icons will print the appropriate OpenOffice document:
                    • Progress Note
                    • Session Note
                    • TMS Screening Questionnaire
          • It includes areas for entering/viewing the following:Diagnosis And Plan, 
             Objectives/Goal Steps, Psychological Assessments and Staff Who Entered Data.

 X (11/16/2020) Tabs > Tab(s) EDITED

• The following are for ALL Advantage products.
• Changes made to PopUp tabs will be reflected on ALL tabs that access that PopUp.

• All USER-OWNED tabs
          • Tab text - Tab text will be underlined on all User-Owned tabs.

• ALL User-OWNED and CHS-Owned tabs
          • Tab text – Tab text will now be Bold AND underlined when that tab is currently 
             active. It will help in identifying which tab you are currently on in the layout.

• ALL tabs with Health History grids
          • GridEdits – If an item is accidentally select (either Yes or No), this will check the 
             'Update' box. 
                    • Uncheck the 'Yes' or 'No' field (this will NOT uncheck the 'Update' field).
                    • Even though the 'Update' field is checked, it will NOT add a record to the 
                       grid, as BOTH the 'Yes' and 'No' fields are blank/False. (Request)

• ALL tabs with the 'Next Appointments' grid
          • Resource or Provider field – Will now access the Login ID table, and only display 
             those that are marked as 'Provider'=Y or 'Non-Provider Appointment Use' = Y. 
             (Request)
                    • The names listed will also be filtered by the Staff Group that the current 
                       User is assigned to (if the office is using Staff Groups).
          • Target field – If the User selects the 'Target' date first, and then the 'Reason', the 
             'Target' calculated from the 'Reason' (based on the table entry) will NOT replace 
             the the selected 'Target'. (Request)

• ALL tabs with an Image field
          • When right clicking in an Image field and selecting 'Import', the file type will now 
             default to PDF and not JPG. (Request)

• PopUpDiag
          • Right click in the 'Assessment' and 'Plan' fields and select 'View Lookup List Entries'
             to now access the tables and make changes directly from the exam. Login Rights 
             to tables still apply.

• PopUpLab
          • Test field – A Smart Function was added to the field to filter the Tests that are 
             displayed, based upon the 'Department' that is selected. (Request)
                    • You MUST select the 'Department' field FIRST, in order for the filter to work.
                    • Example: 'Department'=Chemistry. Click the drop-drown at 'Test', and only 
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                       Tests assigned to the Department of 'Chemistry' will display.
                    • If the 'Department' is NOT selected first, then ALL Tests will display.

• PopUpMedication
          • Special Instructions field - Right click in the field and select 'View Lookup List 
             Entries' to now access the table and make changes directly from the exam. Login 
             Rights to tables still apply.
          • Field lock-down – If a medication is pulled from the favorites list or the U.S. Master
             Drug List, the following fields will be locked, and not available for editing:
                    • Strength/Dose
                    • Units
                    • Route
                    • Form
                    • RXCUI (RxNorm Concept Unique Identifier)
                    • NDC
                    • DEA Schedule #
                    • Generic
                    • RX Type

• PopUpSurgery
          • Op Notes field - Right click in the field and select 'View Lookup List Entries' to 
             access the table and make changes directly from the exam. Login Rights to tables 
             still apply.
          • Procedure field – You are now able to search for a Procedure by Post Code as well 
             as Name. Type in the Post Code and click the drop-drown to filter the table.

• PopUpTest
          • Test field – You are now able to search for a Test by Post Code as well as Name. 
             Type in the Post Code and click the drop-drown to filter the table.

• PopUpTreatment
          • Right click in the 'Notes' field and select 'View Lookup List Entries' to now access 
             the table and make changes directly from the exam. Login Rights to tables still 
             apply.

 (11/5/2020) Tabs > Tab(s) EDITED

• Changes made to PopUp tabs will be reflected on ALL tabs that access that PopUp.

• Addictions
          • Use/Addictions label – The label on the header was changed from 
             'Abuse/Addictions' to be more inline with the DSM 5 standard wording.

• PopUpAssessList
          • Suicide Risk button – This is a NEW button that was added.
                    • When clicked, the 'Suicide Risk Assessment' tab will be added to the end of 
                       the patient's current Exam layout.

• PopUpGoals
          • Progress field – This is a NEW field that was added to enter Goal Progress.

• PopUpGroup
          • The following changes were made to the PopUp tab, so they will be reflected on 
            ALL tabs that access the Group Therapy Session Notes.

1100 Business Center Circle | Thousand Oaks, CA  91320 | 805.716.8677 | eLearning@compulinkadvantage.com
www.compulinkadvantage.com

   27



Exam
          • Individual Notes field – You can now double left click in the field to bring up the 
            'Select EHR Note(s)' window with the following options:
                    • GOALS ADD: Goals Address This Visit
                    • GOALS ADD: Measurable Outcomes
          • Active Goals grid – This is NEW to the tab, and will display the patient's Active 
            Goals.
                    • Double clicking on a Goal will add it to the 'Individual Notes' field.
          • Example of how best to use these new options: 
                    • Double click in the 'Individual Notes' field and select 'GOALS ADD: Goals 
                       Address This Visit'. This will add the following statement to the field: Goals 
                       that were addressed this visit are:
                    • Go to the 'Active Goals' grid and double click on the Goals that were 
                       addressed during the visit; they will be added to the end of the statement 
                       above.
                    • Result in the 'Internal Notes' field = Goals that were addressed this visit 
                       are: decrease anxiety, develop coping skills, 

• PopUpISSGoals
          • The following change was made to the PopUp tab, so it will be reflected on ALL 
             tabs that access the Individual Service Plan Goals.
          • Goal Details – Long Des field – This is a NEW field that was added to display the 
             long description of the Goal that is selected. (Request)

• PopUpMedication
          • Substitutions Allowed field – This field will now default to checked, and stay 
             checked once a medication has been selected. (Request)
                    • The user may uncheck the field if needed, but this will save time, since 
                       most practices DO allow Substitutions.

• PopUpSurgery
          • Historical field – This is a NEW field that was added to signify that this Surgery 
             took place in the past.
                    • The field will automatically default to checked upon adding the record.
          • Complications/Notes label – This was renamed from 'Notes'.

Function
 (11/16/2020) ALL Functions >   Loc. Group Option

• The 'Loc. Group' option for ALL Functions will now default and look to the 'Location Group 
   Restriction' field in the Login IDs table.

 (10/30/2020) Appointment Communication >   Wildcards

• The function was optimized, converting the legacy methodology to SQL.
• With this optimization, the 'Loc', 'Dept' and 'ID' fields MUST be run with either the '*' for 
   ALL, or a selected item from the table; wildcards (partial entry with a *), will no longer 
   be allowed.

 (5/7/2019) Insurance Activities > Batch Eligibility >   Date of Death

• If the Insured's 'Date of Death' is included in the information that is downloaded, it will 
   now print on the report in a bold red font.

 (10/1/2020) Insurance Activities > Billing >   Max Days to File Claim
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• In previous versions, the software would only pull claims that were 365 days from the 
   Date of Service.
• Beginning in Version 12.2.0.29, the software will scan the 'Max Days to File Claim' field in 
   the 'Payor > Names' table to find the highest number across ALL payors, and use this 
   number as the eligible billing days from the Date of Service.
• Example: Payor One says 365, Payor 2 says 700 and Payor 3 says 999.
          • When the billing function is run, all claims that are within 999 days of the Date of 
             Service will be eligible for scrubbing/billing.

 X (2/24/2020) Insurance Activities > Legacy Billing (Retiring) >   Function Retired

• The Legacy Billing Function has been retired in this version.
• This was only available for clients needing a little more time to transition to the new 
   Insurance Billing methodology that was introduced in version 12.1.
• The new Claim Scrubbing was being done, regardless if your office was using the Legacy 
   or the new functionality, however, by using the Legacy, the claims were going through the
   scrubbing process a 2nd time, adding extra time to your billing process that was no 
   longer needed.
• To run the billing in version 12.2, go to Function > Insurance Activities > Billing.

 (11/5/2020) Insurance Activities > Scrub Claims >   Option for Previous Days of 
Activity

• After selecting YES to confirm starting the Scrub Claims process, a NEW window will 
   open, giving you the option to 'Enter # of Previous Activity Days to Scrub'.
          • Default of '0' days will 'Scrub Only Changes since Last Scrub'.
          • Enter a number other than '0' to define the number of days you would like the 
             Claim Scrubbing to go back.

 (10/30/2020) Patient Follow-up/Todo >   Wildcards

• The function was optimized, converting the legacy methodology to SQL.
• With this optimization, the 'Loc' and 'ID' fields MUST be run with either the '*' for ALL, or 
   a selected item from the table; wildcards (partial entry with a *), will no longer be 
   allowed.

 (10/30/2020) Patient Recall >   Wildcards

• The function was optimized, converting the legacy methodology to SQL.
• With this optimization, the 'Loc', 'Dept' and 'ID' fields MUST be run with either the '*' for 
   ALL, or a selected item from the table; wildcards (partial entry with a *), will no longer 
   be allowed.

General
 X (1/30/2020) Advantage Software > Theme Change

• There is a NEW theme change across the entire application.
• Look for visual changes on the menus, as well as the screens.
• All changes are explained in the corresponding sections of these Version Release Notes.

 (2/6/2020) Grid Changes > Patient Demographic and Exam

• Left clicking on the top bar of the grid will now bring up the PopUpAdd to add a record.
• This functions the same as highlighting the ellipsis and clicking on 'Add'.
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 X (1/21/2020) Menu Changes > .Main Screen (Right Click)

• In previous versions, there was an option to right click on the status bar on the bottom of
   the screen, and it would open a menu for selection. The items listed below have been 
   relocated:
          • Turn Tablet Mode On/Off – This can be found in 2 locations:
                    • Workstation Setup > Misc. Tab: 'Tablet Mode'
                    • Printer and Output Tools icon at the bottom right of the screen
          • Turn Phone Mode On/Off – Removed, as it is no longer needed.
          • Set Scaling – Workstation Setup > Misc. Tab: 'Screen Display Scale %'
          • Display Screen Resolution – Removed, as this is accessed through Windows.
          • Turn On/Off “AdvantagePA” - Exam > View > PA Advantage Engine

 X (1/28/2020) Menu Changes > Across All Screens

• ALL command icons in the software were updated to a new format.
• The following changes can be seen across all screens where the icons/commands are 
   found.
• Commands across the TOP of the screen:
          • Exit – Command was removed. Use the 'X' in the top right OR the ESC key on the 
             keyboard to exit the current screen. 
          • Help – Moved to the far right of the menu bar/screen.
          • InBox – Moved to the bottom bar on the right side; to access, click the NEW InBox
             icon.
          • I.M. – Moved to the bottom bar on the right side; to access, click the NEW 
             Messaging icon.
          • View > This command was removed.
                    • Access History and View > Appt History were moved under the 'Utility' 
                       command.
                    • See 'Patient Area Enhancements' for further details.

• Commands/Items across the BOTTOM of the screen:
          • Search icon – This is a NEW 'Staff Search' feature.
                    • Click the icon and a window opens to enter the First and Last name of the 
                       staff member that you are searching for; type the name and hit Enter, or 
                       click 'OK'.
                    • A window opens showing each Station that the staff member has logged 
                       into.
         • SMART Workflow Walking Person Icon
                    • Access available from the following areas: Patient Demographics, Exam and
                       Ledger.
                    • Only visible on workstations that have a 'Patient Tracking Stop' assigned in 
                       the Workstation Configuration.
                              • If you are new to setting up SMART Workflow, you must go into the 
                                 Table Setup to establish Workflow Stations, prior to assigning them 
                                 in the Workstation Configuration.
                                        • Click the Tracking icon on the Patient Demographic screen.
                                        • Select Tools > Table Setup > Workflow Stations.
                              • Once the Stations have been created, an Administrator may assign 
                                 them to the computers in the office.
                                        • From the main screen of the software, click Utility > System 
                                           Administrator > Workstation Static Licenses.
                                        • They may also do it individually from each workstation by 
                                           clicking on the 'Printer & Output Tools' icon in the bottom 
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                                           right corner and selecting 'Workstation Configuration'.
                    • Click to view ALL patients waiting throughout the office (SMART Workflow 
                       only).
                    • A window opens with the following information in the header: Patients 
                       Waiting Across Office [Dbl-Click on Open Room to Select & Move].
                    • Information displayed includes:
                              • Appt – Appointment Time
                              • Reason – Appointment Reason
                              • Provider – Provider Last, First Name
                              • Notes – Appointment Comments field
                              • Arrived – Time patient was Arrived into the office (Arrive command)
                              • Wait – How long the patient has been waiting at the current Station
                              • Name – Patient Last, First Name
                              • Where – Station Category that the patient is currently at
                              • For – Station Name the patient is currently at
                              • Next – Next Station Category for the patient in the SMART Workflow
                              • Open Room – Name of an Open Station that the patient can be 
                                 moved to
                    • Double click on the Station under 'Open Room' to move the patient to that 
                       Station.
                              • This can be done from ANY Station that is a Tracking Stop.
                              • Move the patient from your Station to the next Station.
                              • Pull the patient from the current Station to your Station. 
                                 (Request11460)
                              • Move the patient from the current Station to the next Station 
                                 (neither one is your Station).
          • License # – This will no longer display; you can find it under the Printer and 
             Output Tools > Workstation Info.
          • Location Code – This will no longer display; you can find it under the Printer and 
             Output Tools > Workstation Info.
           • Printer and Output Tools
                    • GUI Customize – Allows access to the Graphical User Interface 
                       Customization tool. For full details, see the Customization Enhancements 
                       topic: Advantage Software: GUI Customization.
                    • Grid Hover Menu – Allows the User to turn off the ellipsis menu option and 
                       view the icons as with previous versions.
                              • Click 'OK' on the confirmation: Select OK to Confirm Turning OFF 
                                 Grid Hover Menu option!
                              • Exit the patient screen and go back in to see the change to the 
                                 menus.
                              • Follow the same steps to reverse the option.
                              • This change DOES effect the 'Enable Grid Hover Menus' setting in the
                                 Login IDs table.
                    • Hint Pause – The number of seconds the mouse can hover over an item 
                       before the hint window pops up.
                    • Turn Tablet Mode On/Off – Toggle between Tablet and Normal mode.
                    • Font Selection – This was REMOVED, as it is no longer needed with the NEW
                       GUI Customization.
                    • Workstation Info – Opens a window with the following information:
                              • Name of User currently logged in
                              • Device Name
                                        • This pulls from the 'Workstation Setup.
                                        • The 'Patient Tracking Stop' will display; and if empty, the 
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                                           'Legacy Workstation Name' will display.
                              • License #
                              • Location Code
                    • Workstation Configuration – Opens the 'Workstation Setup' window; 
                       previously accessed by clicking on the ID on the task bar.

 X (9/24/2019) Menu Changes > Hotkeys

• Hotkeys let you select commands by typing the underlined letter in the command.
• For example, to access Reports from the Main Menu, type the letter R on your keyboard.
• If you don't see the underlined letters in your command menu, press the <ALT> key on 
   your keyboard and then type the letter. <ALT> redirects the focus of your window to the 
   Command Menu.
• Menus and Hotkeys may change as you move about the program. (Request)
• Example: Typing I accesses 'Inventory' on the Main Menu and 'Insurance' on the Patient 
   Demographic screen.

 (10/14/2019) Staff > Groups > Field/Label Change(s)

• Display Order – NEW field added.
          • If you want to control how Groups display, enter a number between 1 and 999998.
             Default is 999999, to display items in the order in which you built them into the 
             table.

• Hide – NEW field added.
          • Set to 'Y' if you do not want to display the item in drop-down lists. Default is 'N'.

Inventory
 (8/23/2019) ALL > Dashes and Alpha Characters

• Inventory can now be built using dashes and alpha characters. (Request)
• When scanning barcodes in the Exam and at the Ledger to remove items from Inventory, 
   it will now recognize dashes and alpha characters.

 X (1/29/2020) ALL > Command (Search) > NEW Screen/Functionality

• Click 'Search' and a NEW 'Inventory Search, Navigation, and Viewing' window opens.
• This window consolidates ALL search options into one screen.
• Header fields:
          • Mfg – Manufacturer. Default is blank.
          • Name – Name/Style. Default is blank.
          • SKU – Unique SKU or Stock#. Default is blank.
          • Category – Cat. Default is blank.
          • Location – Defaults to the Location assigned to the currently displayed Inventory 
             item. 
• Search Examples (after selecting options, click 'Search' or hit Enter):
          • Select a 'Mfg', leave 'Name', 'SKU' and 'Category' blank; leave the default 
             'Location'.
                    • All items for the selected 'Mfg' and 'Location' will display.
                    • Further Search breakdowns can be done by selecting a 'Name', 'Category' 
                       and/or a 'Location'.
          • Select a 'Name', leave 'Mfg', 'SKU' and 'Category' blank; leave the default 
             'Location'.
                    • All items for the selected 'Name' and 'Location' will display.
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                    • Further Search breakdowns can be done by selecting a 'Location'.
          • Select a 'Mfg' and 'Name', leave 'SKU' and 'Category' blank; leave the default 
             'Location'.
                    • All items for the selected 'Mfg', 'Name' and Location will display.
          • Leave 'Mfg', 'Name' and 'SKU' blank and select a 'Category'; leave the default 
             'Location'.
                    • All items for the selected 'Category' and Location will display.
          • Leave 'Mfg', 'Name' and 'Category' blank, leave the default 'Location' and enter a 
             'SKU'.
                    • If a match is found for the 'SKU', you will be taken directly to the Inventory 
                       screen for that item.
          • All Searches can be changed by selecting a different 'Location', or by selecting 'All 
             Locations'.
                    • Location Group Restriction
                              • If the office has filled out the 'Location Group Restriction' field in the 
                                 Login IDs table, the drop-drown will only display Locations that are 
                                 part of the Group attached to the current Login ID.
                              • The option for 'All Locations' will display items for all Locations that 
                                 are part of the Location Group.
• Information Displayed:
          • Location – Office Location name connected to the item
          • Manufacturer – Manufacturer of the item
          • Name – Name/Style of the item
          • Category - Classification
          • SKU – Unique SKU or Stock# assigned to the item
          • # - Qty on Hand
• Search Results
          • If only one Inventory item exists for the Search result, you will automatically be 
             taken to that item, and the 'View' window will close.
          • If multiple items exist for the result, they will display in the 'View' window for you 
             to select from; double click to select.

 X (2/3/2020) Command (View) > NEW Screen/Functionality

• Click 'View' and a NEW 'Inventory Search, Navigation, and Viewing' window opens.
• The window still displays the items with the same 'Manufacturer' and product 'Name' as 
   the currently displayed Inventory item.
• Header fields:
          • Mfg – Manufacturer. Defaults to the Manufacturer that is assigned to the currently 
             displayed Inventory item.
          • Name – Name/Style. Defaults to the Name/Style that is assigned to the currently 
             displayed Inventory item.
          • Category – Cat. Default is blank.
          • SKU – Unique SKU or Stock#. Defaults to blank. The User may type a SKU# and 
             then click the 'Search' button at the top left to search for a specific Inventory item 
             with the same Mfg/Name combination.
          • Category – Cat. Default is blank.
          • Location – Location of the Inventory items. Default is the Location that is assigned 
             to the currently displayed Inventory item. 
                    • Click the drop-drown to select a specific Location to only see items with a 
                       matching Mfg/Name for that Location.
                    • The 'All Locations' option will display all items across all Locations.
                    • Location Group Restriction
                              • If the office has filled out the 'Location Group Restriction' field in the 
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                                 Login IDs table, the drop-drown will only display Locations that are 
                                 part of the Group attached to the current Login ID.
                              • The option for 'All Locations' will display items for all Locations that 
                                 are part of the Location Group.
• Information Displayed:
          • Location – Office Location name connected to the item
          • Manufacturer – Manufacturer of the item
          • Name – Name/Style of the item
          • Category – Classification
          • SKU – Unique SKU or Stock# assigned to the item
          • # - Qty on Hand
• Search Examples:
          • Leave the default 'Mfg', 'Name' and 'Category' and select a different 'Location' or 
             'All Locations'.
          • Leave the default 'Mfg', 'Name' and 'Category' and enter a 'SKU'.
          • Leave the default 'Mfg' and 'Category', select a different 'Name'.
          • Leave the default 'Mfg', 'Name' and 'Location' and select a different 'Category'.
• Search Results:
          • If only one Inventory item exists for the Search result, you will automatically be 
             taken to that item, and the 'View' window will close.
          • If multiple items exist for the result, they will display in the 'View' window for you 
             to select from; double click to select.

Ledger
 (12/5/2019) .Display Changes > Ledger Header Enhancement(s)

• Co-Manage
          • If the Referral Source is flagged 'Co-Manage' = 'Y', then 'Co-Manage' will display 
             in the patient header, followed by the Referral Source.

• Collection
          • This will now display in a bold font.
          • The <> signs will no longer display.

• Ins. Bal
          • This will now display in a bold font when the balance is greater than zero; it will no
             longer be highlighted in yellow.

• Resp. Bal
          • This will now display in a bold font when the balance is greater than zero; it will no
             longer be highlighted in yellow.

• Statement Hold Dates
          • These will now display in a bold font.

 X (8/26/2019) .Display Changes > Menu Commands

• The two rows of commands were combined into one row, and modifications were made.
• The following commands were REMOVED from the main menu: 
          • Alert, Appt, Docs, Letters, Notes, Referral and Todo 
• Jump – NEW icon added to access remaining commands to save on space.
• Alert – Moved to NEW 'Jump' command and renamed to 'Alerts'.
• Appt – Moved to NEW 'Jump' command and renamed to 'Appointments'.
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• EHR – Moved to NEW 'Jump' command and renamed to 'Exam'.
• Insured – Moved to NEW 'Jump' command.
• Referral – Moved to NEW 'Jump' command.

 X (9/24/2019) Command (EHR Post) > NEW Option To Select Encounter To Post

• If more than one encounter (exam record) has been added for the week, when you click 
   the 'EHR Post' command, a window will open listing the encounters for you to choose 
   which one you would like to post for.
          • This will only work if after saving the encounter, the 'Fees' command was clicked to
             prepare the charges to be posted.
• Double click on the encounter that you would like to post.
• The 'EHR Automated Fee Posting' window will open to allow you to make any needed 
   changes.
• Click 'Post' to post the charges to the Ledger.

 X (10/22/2019) Command (Search) > New Window Defaults to Acct#

• The New Search window defaults to the Account Responsible section, 'Acct#' field for 
   searching. You may select a different field to search by if needed.
• For details on the new Search window, see the Hot Topic: Command (Search) > NEW 
   Search Window.

 X (10/16/2019) Command (Service) > Diag Drop-drown Update

• If the 'Diag' field is empty when the drop-drown arrow is clicked, it will now only display 
   the top used Diagnoses from the office; speeding up the process. (Request)
• If searching for a specific Diagnosis, you may still type in either part of the Code or 
   Description PRIOR to clicking on the drop-drown to filter the FULL list of Diagnoses by 
   items that match what was typed.

 X (10/18/2019) Command (Service) > Facility Field Updates

• POS Field Control - When selecting the 'Facility', it will now update the 'POS' field based 
   upon the 'Place of Service' attached to that Facility.

• Table Access – If the User has Access Rights to edit tables, they may now right click in 
   the field for direct access to the table for editing.

 (11/19/2020) Command (Service) > Location Field Update

• When editing the charge 'Loc' field, it will now only display the Locations that are 
   connected to the 'Location Group Restriction' attached to the person that is currently 
   logged into the software.

 (10/28/2019) Command (View) > Audit Activity for Record > New Item(s)

• Audit Activity will now be available for the following items:
          • Diagnostics: Ledger cleanup that populates paid dates on charges
          • Function > Account Statements: Finance Charge Posted to Ledger
          • Ledger > Edit > Change made to Diagnosis Codes (Request)
          • Ledger > Options > Recalc
          • Ledger > Options > Return
          • Ledger > Options > Void Entry
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 X (2/11/2020) .Multiple Areas > Column Order Changed

• For tables containing these standard columns, they will now be in the following order:
          • Owner
          • Hide
          • Display
          • Order

 (1/9/2020) .Multiple Areas > NEW Table Command(s) Added

• Location Groups
          • The NEW 'Location Groups' command was added to several tables.
          • When clicked, it will open the Location Groups table.

• Utility
          • The NEW 'Utility' command was added to several tables.
          • When highlighted, it displays the following options:
                    • Hide All – Mark ALL entries as 'Hide=Y'. Select 'Yes' or 'Cancel' on the 
                       message: Select YES to Confirm the Hiding of ALL Records! (Request)
                    • UnHide All – Mark ALL entries as 'Hide='N'. Select 'Yes' or 'Cancel' on the 
                       message: Select YES to Confirm the Un-Hiding of ALL Records! (Request)

 (3/31/2020) EHR > Episode Type > Field(s) EDITED

• The 'Value' field was increased from 30 to 50 characters. (Request)

 (9/12/2019) EHR > Episode Type > Field/Label Change(s)

• Lookup Group Name – NEW field added.
          • Allows attachment of a Subgroup to the Value/Episode Type.
          • When adding records, you can create individual Values to select from, as well as 
             Groups that will be made up of individual Values.
          • Example: GROUP Name: 'Spine', individual Values consist of 'Cervical', 'Thoracic' 
             and 'Lumbar'.
          • Adding the 'Episode Type'
                    • Click the 'Add' command.
                    • Display Order – Order in which you would like the Type to display in the list.
                    • Owner – 'C' for Compulink-Owned or 'U' for User-Owned.
                    • Hide – 'N' to display or 'Y' to Hide. You may want to Hide the individual 
                       Values that will make up a Group of Values.
                               • Example: Spine (not hidden), Cervical, Thoracic and Lumbar 
                                  (hidden). 
                    • Value – Episode Type/Value. You will create a record for both the GROUP 
                       Value AND the INDIVIDUAL Values that will be in the SUBGROUP (Hiding 
                       the individual Values). 
                    • Lookup Group Name – Once you create the SUBGROUPS, you will attach 
                       them to the Group via this field.
                    • Modified – Date the record was last modified.
                    • Save the record.
          • Creating the Subgroup
                    • Click the 'Subgroups' command to open the 'Lookup Groups' table.
                    • Click the 'Add' command.
                    • Name – Enter a 'Name' for the Subgroup. This may be the same name as 
                       the GROUP name in the previous table, or it may be different. Example: 
                       Spine.
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                    • Owner – Defaults to 'U' for User-Owned.
                    • Hide – Defaults to 'N' to display in the list.
                    • Save the record.
          • Attaching the INDIVIDUAL Values to the Subgroup.
                    • Highlight the Subgroup, click on 'Detail > Add'.
                    • Select the first of the INDIVIDUAL Values from the list (Example: Cervical).
                    • Continue this process for all needed Values.
                    • Example: Attach 'Cervical', 'Thoracic' and 'Lumbar'
                    • Exit the Lookup Groups table, back to the Episode Type Table.
          • Attach the Lookup Group or SUBGROUP to the Episode Type.
                    • Edit the Episode Type.
                    • Click the drop-down at the 'Lookup Group Name' field and select the 
                       SUPGROUP that was created. 
                               • Example: Edit 'Spine' and attach 'Spine'.
                    • Save the record.
          • Adding the Episode Type using Subgroups
                    • Subgroups are only visible when adding an Episode via the 'Episode of Care'
                       grids on the Demographic and Appointment edit screens.
                    • Click the drop-down at the 'Description' field to display a list of all of the 
                       Episode Types/Values that are NOT hidden.
                    • If a Subgroup is attached to a Group Value, you will see a triangle next to 
                       it; click the triangle to expand and view the individual Values that make up 
                       the subgroup.

• Value – Field EDITED.
          • The field was increased to 50 characters. (Request)

 X (10/17/2019) EHR > Medication > Name > NDC Validation

• Upon update to version 12.2, the software will look at all User-Owned Medication records 
   and validate the NDC Code.
• If the Code is NOT a valid NDC Code, the Medication record will be marked as 'Hide=Y'.
• When the Provider wants to prescribe the Medication, they will need to pull the correct 
   one with the correct NDC Code from the U.S. Master Drug List
• This will prevent any errors with ePrescribing due to incorrect NDC code.

 (11/26/2019) EHR > Notes > Item(s) ADDED

• There were 34 items ADDED to the table to support the NEW Transcranial Magnetic 
   Stimulation therapy tab.

• The following items were ADDED to the table for Sort = GOALOBJ:
          • (Short = Mild):(Long = Client progress is mild.)
          • (Short = Moderate):(Long = Client progress is moderate.)
          • (Short = Significant):(Long = Client progress is significant.)
          • (Short = Regression):(Long = Client progress is showing regression.)
          • (Short = Attained):(Long = Client progress has been attained.)
          • (Short = Deferred):(Long = Client progress has been deferred.)
          • (Short = Discontinued):(Long = Client progress has been discontinued.)
          • (Short = No Progress):(Long = Client has not shown any progress.)

 (6/19/2019) EHR > Orders > Definition > NEW Task Groups and Payor Groups

• The option to attach NEW 'Task Groups' and/or 'Payor Groups' via the Detail command 
   was added.
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• See the following for details: EHR > Surgery > Name Table > NEW Task Groups and Payor
   Groups.

 (9/24/2019) EHR > Orders > Description > Item(s) ADDED

• Monarch Trigeminal Nerve Stimulation (eTNS) System

 (12/12/2019) EHR > Surgery > Name > NEW Task Groups and Payor Groups

• The option to attach NEW 'Task Groups' and/or 'Payor Groups' via the Detail command 
   was added. (Request)
• Task Groups – A group of tasks that must be completed when the Surgery/Procedure is 
   added to the patient exam.
          • When the Surgery/Procedure is added to the exam record, the INDIVIDUAL Tasks 
             associated with the GROUP Task, will automatically be added to the patient record 
             with a Status of 'Opened'.
          • If the INDIVIDUAL Task was not assigned a Staff Group or a Department Group in 
             the Task Definition table, the 'Responsible' name on the Task will default to the 
             person that was responsible for creating the Task (Example: the person that was 
             logged in when the Surgery was added to the record).
          • Order Sets assigned in the Exam will be reviewed, and if there is a Surgery 
             connected, the 'Task Group' for that Surgery will be added to the patient record.
          • Individual Tasks from the Group will display in both the Exam and the Patient 
             Demographics.

• Payor Groups – A group of Payors that require certain Tasks to be completed when the 
   Surgery/Procedure is added to the patient exam.
          • When the Surgery/Procedure is added to the exam record, the patient's Insurance 
             records will be reviewed. If their Payor matches a Payor listed in the Payor Group 
             attached to the Surgery, the INDIVIDUAL Tasks associated with the GROUP Task 
             will automatically be added to the patient record.
          • If an Episode of Care is connected to the exam, and there is a primary Payor 
             connected to the Episode of Care, that is the Payor that will be looked at when 
             assigning Tasks.
          • Individual Tasks from the Group will display in both the Exam and the Patient 
             Demographics.

• Table Setup
          • Task Group Table
                    • Main menu: Utility > Look-up Tables > General > Tasks > Groups.
                    • On-the-fly: Highlight a Surgery and click the 'Detail > Add' command; right 
                       click in the 'Task Group' field to open the table.
          • Payor Group Table
                    • Main menu: Utility > Look-up Tables > Financial > Payors > Groups.
                    • On-the-fly: Highlight a Surgery and click the 'Detail > Add' command; right 
                       click in the 'Payor Group' field to open the table.

• Connecting a Task Group and Payor Group to a Surgery
          • Highlight the Surgery, click the 'Detail > Add' command; this opens the 'Task 
             Group by Order Editing' window.
          • Owner – New records default to 'U' for User-Owned. 'C'=Compulink-Owned.
          • Hide – Default to 'N' to display the record; change to 'Y' to hide the record.
          • Task Group – Click the drop-down to select the Group that you want to assign. 
          • Payor Group – Click the drop-down to select the Group that you want to assign. 
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                    • Task Groups may be connected on their own, but if connecting a Payor 
                       Group, you must also select a Task Group.
          • Display Order – Order in which you would like the Task Group to display on the 
             Surgery (if anything other than the natural order).
          • Modified – Date the record was last modified.
          • Save the record.

 (5/23/2019) EHR > Test > Name > NEW Task Groups and Payor Groups

• The option to attach NEW 'Task Groups' and/or 'Payor Groups' via the Detail command 
   was added.
• See the following for details: EHR > Surgery > Name Table > NEW Task Groups and Payor
   Groups.

 (9/25/2019) EHR > Treatment > Name > Item(s) ADDED

• The following items were ADDED to the table:
          • Prolonged Services: 99354 (Request)
          • Prolonged Services each addl 30 min: 99355 (Request)

• The following items were ADDED to the table primarily for Telehealth (Post Code and 
   Insurance Code listed):
          • Telehealth Alc/Sub Assess Brief Intervent 15-30: G0396 G0396
          • Telehealth Alc/Sub Assess Intervent >30 min: G0397 G0397
          • Telehealth Annual Alc Misuse Screen 15: G0442 G0442
          • Telehealth Annual Depression Screen: G0444 G0444
          • Telehealth Asymptom Tobacco Cesstn 3-10 min: 405TM 99406
          • Telehealth Asymptom Tobacco Cesstn >10 min: 407TM 99407
          • Telehealth Brief FTF Behav Couns Alc Misuse 15: G0443 G0443
          • Telehealth Crisis Psychotherapy (ea addtl: 840TM 90840
          • Telehealth Crisis Psychotherapy 60 min: 839TM 90839
          • Telehealth Diagnostic Eval w/Med Services: 792TM 90792
          • Telehealth Diagnostic Evaluation: 791TM 90791
          • Telehealth Family Health/Beh Interv w/ Pt: 154TM 96154
          • Telehealth Family Psych w/ Pt Present: 847TM 90847
          • Telehealth Family Psych w/o Pt Present: 846TM 90846
          • Telehealth FTF Obesity Beh Counsel: G0447 G0447
          • Telehealth Grp Health/Beh Interv: 153TM 96153
          • Telehealth Health/Beh Asssess 15min: 150TM 96150
          • Telehealth Health/Beh ReAssess 15min: 151TM 96151
          • Telehealth High Inten Beh Couns Std 30m: G0445 G0445
          • Telehealth Ind Health/Beh Interv: 152TM 96152
          • Telehealth Interactive Complexity: 785TM 90785
          • Telehealth Orig Site Fac Fee: Q3014 Q3014
          • Telehealth Prolonged Serv each 30 after 60: 99355 99355 (Request)
          • Telehealth Prolonged Serv up to 60 min: 99354 99354 (Request)
          • Telehealth Psychoanalysis: 845TM 90845
          • Telehealth Psychotherapy 30 min: 832TM 90832
          • Telehealth Psychotherapy 45 min: 834TM 90834
          • Telehealth Psychotherapy 60 min: 837TM 90837
          • Telehealth Psychotherapy w/E&M 30 min: 833TM 90833
          • Telehealth Psychotherapy w/E&M 45 min: 836TM 90836
          • Telehealth Psychotherapy w/E&M 60 min: 838TM 90838
          • Telehealth Symptom Tobacco Cesstn 3-10 min: G0436 G0436
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          • Telehealth Symptom Tobacco Cesstn >10 min: G0437 G0437

 (5/23/2019) EHR > Treatment > Name > NEW Task Groups and Payor Groups

• The option to attach NEW 'Task Groups' and/or 'Payor Groups' via the Detail command 
   was added.
• See the following for details: EHR > Surgery > Name Table > NEW Task Groups and Payor
   Groups.

 (11/11/2019) Financial > Coding Rules > NEW Option(s) Added

• The following NEW options were added for User-Owned records:
• 3rd Modifier for Split Script - SQL Script that will review the data in the Exam and 
   determine if a 3rd Modifier is needed for the Split CPT Code, and what that Modifier 
   should be.

• Payor Group – Assign a group of Payors that this Coding Rule should run for when posting
   from Exam. This will prevent it from being run on ALL Payors. (Request)

 (10/1/2019) Financial > Payors > Compulink Update Added Back

• The option to manually run the Compulink Update for Payors and Claim Edits is now 
   available. (Request)
• Once the update runs, you must completely exit the Advantage software and re-start to 
   finish the process.

 (12/12/2019) Financial > Payors > NEW Table: Groups

• This is a NEW table that was added.
• Payor Groups are a group of Payors that require certain functionality; this could include 
   Tasks to be completed when a Surgery/Procedure is added to the patient exam.
          • When the Surgery/Procedure is added to the exam record, the patient's Insurance 
             records will be reviewed. If their Payor matches a Payor listed in the Payor Group 
             attached to the Surgery, the INDIVIDUAL Tasks associated with the GROUP Task 
             will automatically be added to the patient record.
• Adding the Payor Group
          • Click the 'Add' command.
                    • Owner – New records default to 'U' for User-Owned. 'C'=Compulink-Owned.
                    • Hide – Defaults to 'N' to display in the list.
                    • Name – Enter a 'Name' for the Group. Example: Work Comp.
                    • Display Order - Order in which you would like the Group to display in the 
                       list.
                    • Modified – Date the record was last modified.
          • Save the record.
• Attaching the INDIVIDUAL Payors to the Group.
          • Highlight the Group, click on 'Detail > Add' to open the 'Select Payor' window.
                    • Double click to select a Payor to add to the Group.
          • Continue this process until all individual Payors are listed at the bottom when you 
             highlight the Group name at the top.

 (8/19/2019) Financial > Services > Fees Greater than $9999.99

• You now have the capability to post Services with fees of the table limit of $9999.99.
• In the Default/Description screen, enter the description of your Service, followed by $n
• The 'n' represents the number that you want to multiply $1,000 dollars by for your fee... 
   $(n*1,000).
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          • Example: Your Surgical Procedure fee is $15,000.
          • Service Fee Schedule Description Column: Surgery $15
• When posting to the patient Ledger, the Amount/Charge would show as $15,000. 
• If you have an additional amount to be added on to the calculation, enter it in the Charge 
   & Allowed fields in the corresponding fee column. 
          • Description Column: Surgery $15
          • Commercial Fee Column: Charge=$500, Allowed=$500
          • When posting to the patient Ledger, the Amount/Charge would show as $15,500 or
             $15*1000+500.00.

 (10/1/2019) Financial > Services > New Telehealth Services Added

• The items listed below were ADDED to the table for NEW INSTALLS ONLY.
• If EXISTING CLIENTS would like to bill for these services, they will need to MANUALLY add
   them to their Services table, as Compulink may not override the User data.
• Descriptions do NOT need to match exactly, but the following items DO need to match: 
   Post Code (see each item below), Category=TM and POS=02 on ALL entries.
• New items added (Description, Post Code, Ins Code):
          • Interactive Complexity: 785TM 90785
          • Diagnostic Evaluation: 791TM 90791
          • Diagnostic Eval w/Med Services: 792TM 90792
          • Psychotherapy 30 min: 832TM 90832
          • Psychotherapy w/E&M 30 min: 833TM 90833
          • Psychotherapy 45 min: 834TM 90834
          • Psychotherapy w/E&M 45 min: 836TM 90836
          • Psychotherapy 60 min: 837TM 90837
          • Psychotherapy w/E&M 60 min: 838TM 90838
          • Crisis Psychotherapy 60 min: 839TM 90839
          • Crisis Psychotherapy (ea addtl: 840TM 90840
          • Psychoanalysis: 845TM 90845
          • Family Psych w/o Pt Present: 846TM 90846
          • Family Psych w/ Pt Present: 847TM 90847
          • Health/Beh Asssess 15min: 150TM 96150
          • Health/Beh ReAssess 15min: 151TM 96151
          • Ind Health/Beh Interv: 152TM 96152
          • Grp Health/Beh Interv: 153TM 96153
          • Family Health/Beh Interv w/ Pt: 154TM 96154
          • Asymptom Tobacco Cesstn 3-10 min: 405TM 99406
          • Asymptom Tobacco Cesstn >10 min: 407TM 99407
          • Symptom Tobacco Cesstn 3-10 min: G0436 G0436
          • Symptom Tobacco Cesstn >10 min: G0437 G0437
          • Alc/Sub Assess Brief Intervent 15-30: G0396 G0396
          • Alc/Sub Assess Intervent >30 min: G0397 G0397
          • Annual Alc Misuse Screen 15: G0442 G0442
          • Brief FTF Behav Couns Alc Misuse 15: G0443 G0443
          • Annual Depression Screen: G0444 G0444
          • High Inten Beh Couns Std 30m: G0445 G0445
          • FTF Obesity Beh Counsel: G0447 G0447
          • Prolonged Serv up to 60 min: 99354 99354 (Request)
          • Prolonged Serv each 30 after 60: 99355 99355 (Request)
          • Telehealth Orig Site Fac Fee: Q3014 Q3014

 X (8/1/2019) General > Facilities > Field/Label Change(s)
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• Direct E-Mail – NEW field added.
          • Direct E-Mail used to transport electronically secure messages. This is NOT the 
             same as a standard E-Mail.

• Fax – NEW field added.
          • Facility fax number.

• Use Direct E-Mail – NEW field added.
          • Default='N'. 
          • When selecting the Print > Letter, Template or Selected command, the Document 
             Creation window will default the 'Method' to Fax. 
          • If set to 'Y', the 'Method' will default to Direct Email.

 X (8/1/2019) General > Location > Details > Command Moved

• The 'Fax Setup' command was moved to the Main Menu, Utility > System Administrator >
   Fax Setup, to allow for increased security and NEW functionality.

 X (11/15/2019) General > Location > Details > Field(s) Added/Edited/Removed

• Cloud Fax – Field REMOVED
          • This field was removed, as it is now part of the new table found under the Main 
             Menu, Utility > System Administrator > Fax Setup.

• Display Order – Field ADDED (Request)
          • Use to control the position of items in drop-down lists. Enter a number between 1 
             and 999998. Default is 999999 to display in the order added to the table.

 (7/30/2019) General > Location > Groups > Field/Label Change(s)

• Logo Filename – NEW field added.
          • This is currently in development, and will be a future option to display a unique 
             logo for each Location Group on Crystal Reports and OpenOffice documents. 
             (Request)

 X (10/30/2020) General > Referral > Sources > Field/Label Change(s)

• Auto-Communicate Code – Field REMOVED.
          • This was replaced with the NEW fields 'Secure Communication Method' and 
             'Automatically Communicate'.

• Automatically Communicate – NEW field added.
          • If set to 'Y', once the Exam record is signed off, the established 'Secure 
             Communication Method' for the Referral Source will automatically be sent to the 
             Referral Source via PracticeWatch. (Request)
          • When adding the Referral Source to the patient, this field will default to the 'Auto' 
             field.

• CCD Format – Field REMOVED.
          • This was replaced with the NEW field 'Secure Communication Method'.

• Document History Tab – NEW field added.
          • All documents sent will be displayed on the NEW Patient Document History tab.
          • See the Patient Area Enhancements for New Tabs for full details.
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• Phone Ext. – NEW field added.
          • A phone number extension field was added to document for the Source. (Request) 

• Secure Communication Method – NEW field added.
          • Default or Preferred method of communicating information to this Referral Source.
          • Communication Methods:
                    • CCD - Continuity of Care Document (Patient Health Care Summary in the 
                       HL7 Clinical Document Architecture)
                    • CCD Extended
                    • Fax Document - The OpenOffice document that is listed in the 'Complete 
                       Doc' field in the Screen Builder for the layout used on the Exam.
          • When adding the Referral Source to the patient, this field will default to the 
             'Comm. Method' field. (Request)

 (12/1/2020) General > Referral > Sources > Patient Update

• If a change is made to the Referral Source, once it is saved, the following fields will 
  automatically be updated on all patients that have that Referral Source connected to their 
  account:
          • Business Name
          • Salutation, First Middle (initial) Last, Degree
          • Specialty
          • Web Site URL
          • Picture
          • Addr. Line #1, Addr. Line #2
          • Phone
          • Fax
          • E-Mail (non PHI Use)
          • Direct E-Mail
          • Secure Communication Method
          • Automatically Communicate
          • Medicare 
          • Medicare Advantage 
          • Co-Manage

 (11/14/2019) General > Tasks > Definition > NEW Table Added

• This is 1 of several NEW tables added to support the NEW Task Management Functionality.
• The Tasks Definition table stores action items/reminders to your office staff to perform 
   Tasks related to a patient.
• These action items may require follow-up phone calls, written correspondence or other 
   resolution.
• Individual Tasks can then be combined to create Task Groups, and be set up to 
   automatically add to a patient record based upon Insurance Payor, Order, Surgery, Test or
   treatment.
• This table also gives you access to the NEW 'Task Category' table.

• Adding a Task Definition
          • Click the 'Add' command.
          • Owner – New records default to 'U' for User-Owned. 'C'=Compulink-Owned.
          • Hide – Default to 'N' to display the record; change to 'Y' to hide the record.
          • Name – Enter a 'Name' for the Task. Example: Insurance Verification.
          • Category – Select a 'Category' or Type. (See Task Category Table below)
                    • Example: New Patient Tasks or Pre-Surgery Tasks.
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                    • If using Categories, it is best to create the Task Category table first, so they
                       will be available to choose from when adding the Task Definition.
          • Days to Complete – The number of days the staff has to complete the Task; '0' 
             means it should be completed the same day it is assigned.
          • Template – Create a text template for the staff to follow. 
                    • Example: A checklist of things to document when completing the Task.
                    • Optional field.
                    • May only be edited when initially ADDING the Task to the record, not when 
                       EDITING the Task and adding Notes later.
          • Staff Group – If you would like to assign the Task to a GROUP of staff members, 
             click the drop-down and select from the Staff Group table (Utility > Look-up Tables
             > General > Staff > Groups).
                    • When adding this Task to a patient, this field will default if established by 
                       the staff in the table.
          • Department Group – If you would like to assign the Task to a specific Department 
             Group, click the drop-down and select from the Department Group table (Utility > 
             Look-up Tables > General > Department > Groups).
                    • When adding this Task to a patient, this field will default if established by 
                       the staff in the table.
                    • You may not assign BOTH a 'Staff Group' AND a 'Department Group'. If both
                       are selected, upon saving, the following message will appear: Task cannot 
                       have both a Staff Group and a Department Group assigned!
          • Display Order - Order in which you would like the Task to display in the list.
          • Modified – Date the record was last modified.
          • Save the record.

• Task Category Table
          • The Task Category table stores classifications for the Task Definitions.
                    • Examples: New Patient Tasks and Pre-Surgery Tasks.
          • Categories can be useful for creating custom Worklists to find all patients with 
             Tasks matching a specific Category/Classification, rather than creating a Worklist 
             for each individual Task.
                    • Example: Category = New Patient Tasks
                    • Task Definitions 'Send Office Welcome Letter' and 'Insurance Verification' 
                       are both assigned the Category of 'New Patient Tasks'.
                    • A Worklist is created to pull all patients with Task Category=New Patient 
                       Tasks.
                    • Patients with either of the Task Definitions listed above will display on the 
                       list.
          • If you are going to assign Categories to Tasks, this table should be created first.
          • Right click in the 'Category' field to open the table.
                    • Adding the 'Task Category'
                              • Click the 'Add' command.
                              • Display Order – Order in which you would like the Category to 
                                 display in the list.
                              • Owner – 'C' for Compulink-Owned or 'U' for User-Owned.
                              • Hide – 'N' to display or 'Y' to Hide. 
                              • Value – Category Name/Value. 
                              • Modified – Date the record was last modified.
                              • Save the record.

 (11/14/2019) General > Tasks > Groups > NEW Table Added

• This is 1 of several NEW tables added to support the NEW Task Management Functionality.
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• The Tasks Groups table is where you can combine individual Tasks to create one Group.
• That Group can then be assigned to an Insurance Payor, Order, Surgery, Test or 
   Treatment.
• Example: When the Surgery/Procedure is added to the exam record, the INDIVIDUAL 
   Tasks associated with the GROUP Task, will automatically be added to the patient record 
   with a Status of 'Opened'.
          • If the INDIVIDUAL Task was not assigned a Staff Group or a Department Group in 
             the Task Definition table, the 'Responsible' name on the Task will default to the 
             person that was responsible for creating the Task (Example: the person that was 
             logged in when the Surgery was added to the record).
          • Order Sets assigned in the Exam will be reviewed, and if there is a Surgery 
             connected, the 'Task Group' for that Surgery will be added to the patient record.
          • Individual Tasks from the Group will display in both the Exam and the Patient 
             Demographics.

• Adding the Task Group
          • Click the 'Add' command.
                    • Owner – New records default to 'U' for User-Owned. 'C'=Compulink-Owned.
                    • Hide – Defaults to 'N' to display in the list.
                    • Name – Enter a 'Name' for the Group. Example: Surgery.
                    • Display Order - Order in which you would like the Group to display in the 
                       list.
                    • Modified – Date the record was last modified.

• Attaching the INDIVIDUAL Tasks to the Group.
          • Highlight the Group, click on 'Detail > Add' to open the 'Task Group Detail Editing' 
             window.
                    • Owner – New records default to 'U' for User-Owned. 'C'=Compulink-Owned.
                    • Hide – Defaults to 'N' to display in the list.
                    • Display Order - Order in which you would like the Task to display in the list.
                    • Task - Select the first of the INDIVIDUAL Tasks from the 'Task Definition' 
                       table. Example: Get Precert
                              • Right click to access the table.
                    • Wait on Done before Create – Used to hold the creation of the Task until the
                       selected Task is Resolved.
                              • Example: The Task 'Get Precert' must be completed prior to 
                                 'Schedule Surgery'.
                              • Select 'Get Precert' in the 'Task' field, and select 'Schedule Surgery' 
                                 in the 'Wait on Done before Create' field.
                              • When the Surgery is added to the patient exam, the Task 'Get 
                                 Precert' will automatically be added. Once the Task has been marked
                                 as Resolved, then the 'Schedule Surgery' Task will be added.
                    • Wait on Done for Entire Group – Used to hold the creation of the Task until 
                       the selected TASK GROUP is Resolved. ALL individual tasks in the Group 
                       MUST be Resolved prior to this Task being created.
                    • Modified – Date the record was last modified.
                    • Save the record.
          • Continue this process until all INDIVIDUAL Tasks have been added.

 (1/9/2020) General > Todo/Followup > Items > NEW Command(s) Added

• Migrate
          • This NEW command will Migrate User-Owned entries from this table to the NEW 
             'Tasks Definition' table.
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          • Click 'Migrate' and select either 'Yes' or 'Cancel' on the message: Select YES to 
             confirm your Request to Migrate User owned “TODO” oriented content over to 
             Tasks!
          • Click 'OK' on the message: Migration has completed!
          • The following information is Migrated:
                    • Owner = Owner
                    • Hide = Hide
                    • Display Order = Display Order
                    • Action = Name
                    • Delta = Days to Complete
                    • Modified = Modified

 (11/3/2020) Inventory > SKU Formula Plan Pricing

• This table stores formulas used to perform Plan-specific benefit calculations as Inventory 
   items are posted to the patient Ledger (using the SKU# from the Exam or directly on the 
   Ledger.
• Build these formulas after you have created your SKU Groups (SKU Groups table).
• From the Main Menu, go to 'Utility > Look-up Tables > Inventory > SKU Formula Plan 
   Pricing.
          • This table is not sorted. Enter items in the order you would like them displayed in 
             the table.
          • Add – Add a new record to the bottom of the table
          • Insert – Insert a new record ABOVE the highlighted entry
          • Complete the fields within the editing window:
                    • Plan – Financial Plan associated with this SKU Formula (must be selected 
                       from the drop-drown)
                    • SKU Pricing Group – Associated Pricing Group created in the 'SKU Groups' 
                       table (must be selected from the drop-down)
                    • Retail Formula – Formula to populate the Retail field in the charge 
                       transaction when the Inventory item is posted to the Ledger. 
                              • Example: XR
                              • This will post the Inventory item's 'Retail' amount in 'Amount' field.
                    • Ins. Paid Formula – Formula to populate the Ins. Balance field in the charge
                       transaction. 
                              • Example: XR*-20
                              • This will subtract $20 from the Inventory item's 'Retail', and place 
                                 that amount in the 'Ins. Bal.' field.
                    • Allowed Amount Formula – Formula to calculate the Insurance allowed 
                       amount.
                              • Example: XR*.80
                              • This will take the Inventory item's 'Retail' amount and multiply it 
                                 by .80; applying a 20% discount in the 'Adjust' field, and the 
                                 remaining 80% will be distributed to the Insurance and the Patient, 
                                 based upon the way the Insurance 'Pay %' is established on the 
                                 patient.
          • Click the check to Save.
• Pricing Plan Variables include the following from the Inventory Description screen:
          • XR – Retail 
          • XC – Cost 
          • XS – Manufacturer's Suggested Retail
          • XW – Wholesale

 (11/3/2020) Inventory > SKU Groups
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• This table stores the various Inventory Pricing Groups used in conjunction with 'SKU 
   Formula Plan Pricing'.
• It supports the 'Price Group' field found on each Inventory Description screen.
• The 'SKU Formula Plan Pricing' may be used to perform Plan-specific benefit calculations 
   as Inventory items are posted by Stock# to the patient Ledger.
• SKU Groups may be created based upon Inventory Type, Inventory Value or other 
   characteristics.
• From the Main Menu, go to 'Utility > Look-up Tables > Inventory > SKU Groups.
          • This table is not sorted. Enter items in the order you would like them displayed in 
             the table.
          • Add – Add a new record to the bottom of the table
          • Insert – Insert a new record ABOVE the highlighted entry
          • Complete the fields within the editing window:
                    • Name – Pricing Group description
          • Click the check to Save.
• After completing this table, you will go to the 'SKU Formula Plan Pricing' table to add your
   formulas for Plan-specific benefit calculations.
• The Price Group assigned to the Inventory item, in conjunction with the Financial Plan 
   that is active as the charge is posted, determine which SKU Formula is used to price the 
   item.
• Once the decision has been made to code Price Groups, and you have built out both 
   tables, go to the Inventory and assign each item its respective Price Group.

 (2/27/2020) Inventory > Adjustments > Command(s) ADDED/REMOVED

• Search – ADDED: Quickly perform an alphabetical search of your choice of fields in the 
   table.
          • Select Field to Search and click OK.
          • Accept the default (usually the table's key field such as 'Value'), or open the drop-
             down list to search the contents of a different field; currently for this table, 'Value' 
             is the ONLY option.
          • Enter your search characters and click OK.
• Insert – REMOVED: This is no longer needed with the addition of the 'Display Order' field.
• Filter – ADDED: Control which records are temporarily displayed in the table by selecting 
   one of the following:
          • Off – View ALL records (this is the default)
          • UnHidden – Display records with the NEW 'Hide' field blank or marked 'N'
          • Hidden – Display just the records with the NEW 'Hide' field marked 'Y'
          • Compulink Owned – Display just the records with the NEW 'Owner' field marked 'C'
          • User Owned – Display just the records with the NEW 'Owner' field marked 'U'
• Hide – ADDED: This command places you into record <Hide> mode. 
          • Double click on a table entry to toggle Hide from N to Y. 
          • This entry will no longer appear in the table drop-down. 
          • Click Hide again to stop.
• Subgroups – ADDED: In development
• Utility – ADDED: Used to mark the NEW 'Hide' field on ALL records with either 'Y' or 'N'
          • Hide All – Mark ALL entries as 'Hide=Y'.
          • UnHide All – Mark ALL entries as 'Hide='N'.
• Export – REMOVED: With the enhanced functionality of the table, the option to export to 
   a CSV file has been removed.
• Import – REMOVED: With the enhanced functionality of the table, the option to import a 
   CSV file has been removed.
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 (2/27/2020) Inventory > Adjustments > Field(s) ADDED/EDITED

• Display Order – Used to control the position of items in drop-down lists. Enter a number 
   between 1 and 999998. Default is 999999 to display in the order added to the table. 
• Owner – Each entry has an assigned Owner, 'U' for User or 'C' for Compulink. 
          • This allows Compulink to update our Rules without stepping on those you create. 
          • Owner 'C' records are not modifiable, but you can Hide them from Display.
• Hide – Set to 'Y' to Hide the item in the drop-drown list.
• Value – Renamed from 'Adjustment'
• Lookup Group Name – In development
• Modified – Date this table entry was last edited

 X (8/29/2019) Virtual > Attorney > Field/Label Change(s)

• Automatic Communication – NEW field added.
          • If set to 'Y', once the Exam record is signed off, the Attorney will automatically be 
             sent a Fax via PracticeWatch.
          • The Fax is the OpenOffice document that is listed in the 'Complete Doc' field in the 
             Screen Builder for the layout used on the Exam.

• Business Name – NEW field added.
          • Business/Practice Name where the Attorney works.
          • When adding a Contact record, the Business Name will display in the list to select 
             from; if empty, the Attorney Last Name, First Name will display.
          • Once selected, the Business Name will populate the 'Organization' field on the 
             Patient Contacts screen.

• Receive CCD – Field REMOVED.
          • This was replaced with the NEW field 'Automatic Communication'.

 X (10/17/2019) Virtual > Employers/Organizations > New Table Added

• A NEW 'Employers/Organizations' table was created, and can be accessed by right clicking
   in the 'Organization' field in the Patient Contact screen.
          • Click the Add command.
                    • Display Order - Use to control the position of items in drop-down lists. Enter
                       a number between 1 and 999998. Default is 999999 to display in the order 
                       added to the table.
                    • Business Name – Business Name associated with this 
                       employer/organization.
                    • Street – Business Street Address used in correspondence
                    • City – Business City used in correspondence
                    • State – Business State used in correspondence
                    • Zip Code – Business Zip Code used in correspondence
                    • Phone – Business Phone Number with (Area Code) plus number
                    • Ext. – Business Phone Number Extension
                    • Fax – Business Fax Number
                    • Contact Last – Last Name of Contact
                    • Contact First – First Name of Contact
                    • Contact Middle – Middle Name of Contact
                    • Contact Salutation – Contact's Salutation
                    • Contact Cell Phone – Contact’s Cellular Phone Number with (Area Code) 
                       plus number 
                    • E-Mail – Contact's E-Mail Address
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                    • Notes – Free typing comment field
          • Click the check to save.

MACRA/MIPS
 (9/30/2019) Clinical Quality Data Registry > FIGmd

• FIGmd provides clinical data registry, analytics and data reporting solutions to medical 
   practices, specialty societies, medical professional associations, hospitals, and health 
   systems.
• As the technical interface between EHRs and the registries, FIGmd partners with EHR 
   vendors to integrate and provide MIPS and value-based reporting to their customers. 
• Reporting is made easy with the Compulink FIGmd interface.
          • This simple solution allows your practice to report to a specialized registry or to 
             CMS without significant involvement from your team.
          • FIGmd does not require you to generate reports and electronically/securely send 
             the report information to a registry or CMS. 
          • This program interface provides Compulink practices direct access to specialty 
             registries that report on your behalf.
          • FIGmd automates the Quality Reporting process, and does all the work by pulling 
             the quality data directly from the Advantage EHR data fields and sending it to the 
             registry.
                    • FIGmd installs a ‘connector’ (called Elixir) which identifies reporting 
                       requirements for your specialty.
                    • Compulink ELIXIR© is our partnership with FIGmd. ELIXIR© is the gateway
                       to effective, Merit-based Incentive Payment System (MIPS) and CPC+ 
                       Advanced Alternative Payment Model (APM) reporting.
• For further details, see the Compulink Advantage Help File topic: CQDRs: FIGmd.

Patient Area
 X (11/13/2019) .Display Changes > Icons Condensed Under Ellipsis

• ALL CHS-Owned tabs
          • All icons were moved under a 3 vertical dot ellipsis icon to provide a cleaner look.
                    • Hover the mouse over the ellipsis to open a window with the available icons 
                       for that area, then single left click to select.
                    • Forward icons and Filter icons for grids were also moved under the ellipsis 
                       icon.
          • To disable this option, see the topic Utility Enhancements: System Administrator > 
             Login > IDs > Field(s) Added/Edited/Removed: Enable Grid Hover Menus

 X (10/21/2019) .Display Changes > Menu Commands

• The two rows of commands were combined into one row, and modifications were made.
• The following commands were REMOVED from the main menu: 
          • Chart, Group, Letters and Todo
• Jump – NEW icon added to access remaining commands to save on space.
          • Episode – Change in functionality.
                    • ADDING/EDITING/DELETING the Episode has been moved from Referral > 
                       History/Eligibility.
                    • The option to CONNECT the Episode to the Referral, has been updated in 
                       the Referral > History/Eligibility screen.
          • Task – This is a NEW command. See the 'Patient Area Enhancements' for details.
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• Chart – Moved to NEW 'Jump' command.
• Comments – Renamed from 'Notes'.
• Document – Renamed from 'Docs'.
• Exam – Renamed from 'EHR'.
• Group – Moved to NEW 'Jump' command.
• Insurance – Renamed from 'Insured'.
• Letters
          • Moved under the 'Print' command.
          • Select 'Print > Word Processing' to open the selected word processor (OpenOffice, 
             etc.)
• Recall – Moved to NEW 'Jump' command.
• Referral > New Patient
          • Moved under the 'Print' command.
          • It will immediately open in Crystal Report and allow for printing of the list.
• Referral
          • When clicking the 'Referral' command, you no longer have to select 'History', it will
             automatically open the window.
          • Episode command – Now only used to CONNECT the Episode to the Referral. See 
             the 'Patient Area' Enhancements for full details on the updated Episode 
             functionality.
• Todo – Moved to NEW 'Jump' command.

 (12/4/2019) .Display Changes > Patient Header Enhancement(s)

• Co-Manage
          • If the Referral Sources is flagged 'Co-Manage' = 'Y', then 'Co-Manage' will display 
             in the patient header, followed by the Referral Source.

 X (10/29/2019) Cloud Clients > Filtering Patients

• For clients using the Advantage Cloud, records with no Last Name will now be filtered out 
   of the patient database.

 X (9/23/2019) Command (Back & Next) > New Functionality

• New functionality has been added when clicking on either the 'Back' or 'Next' commands 
   on the Patient Demographic screen.
• Click 'Back' and the NEW Search window opens (see topic: NEW Search Window) to 
   display the top 50 patients (including the current patient) going BACK alphabetically.
• Click 'Next' and the NEW Search window opens to display the top 50 patients (including 
   the current patient) going FORWARD alphabetically.

 X (10/1/2019) Command (Document) > Now Using IMS (Image Management 
System)

• The Document command is now using the IMS (Image Management System).
• Clicking the command opens a new 'Documents' window that will list all of the patients 
   documents/images that have been scanned or imported in the demographics, or 
   transferred to the demographics from the InBox.
• Scanning a document/image
          • Click 'Scan'; if the software detects more than one option, a 'Select source' window
             will open to select the scanner, otherwise the scanner's software window will open.
          • Choose the proper settings and click 'Start' or 'Scan', whatever your scanner 
             option is.
          • An 'Edit Document' window opens with the following information:
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                    • Date – Defaults to the current date, but may be changed.
                    • Time – Current time stamp (may not be changed).
                    • Type – Type of document/image. Click the drop-drown to select from the 
                       'Scanned Document Types' table. Example: Insurance EOB.
                    • Name – Name of the document/image. Example: Medicare.
                    • Requires Review - Defaults to checked, but may be unchecked.
                              • If checked, the item will appear on the NEW worklist 'Documents 
                                 Needing Review'.
                              • Information displayed includes the Patient Account Number, Name 
                                 and Document Name.
                    • Reviewed – Date the item was Reviewed. 
                              • By entering a Date, the item will not appear on the worklist to be 
                                 Reviewed.
          • Save the record.
                    • The record is automatically saved as a PDF file.

• Editing a document/image
          • Highlight the record and click 'Edit'.
          • The 'Edit Document' window opens, allowing edit of the following fields: Date, 
             Type, Name, Requires Review and Reviewed.
          • Save the record.

• Deleting a document/image
          • Highlight the record and click 'Delete'.
          • Click 'Yes' on the message: Are you SURE you want to DELETE Item?

• Importing a document/image
          • You now have the option to import several different types of documents/images, 
             including the following: (Request)
                    • Word documents (.DOC/.DOCX)
                    • HTML documents (.HTM/.HTML)
                    • OpenOffice documents (.ODT)
                    • Microsoft XPS Documents (.XPS) or XLS documents
                    • Portable document Format (.PDF) 
          • Click 'Import'; the 'Importing Document/Image' window will open.
          • Select the file to import by highlighting it and clicking 'Open', or by double clicking 
             on the file.
          • The 'Edit Document' window opens, allowing edit of the following fields: Date, 
             Type, Name, Requires Review and Reviewed.
          • Save the record.

• Exporting a document/image
          • Click 'Export'; the 'Exporting Document/Image' window will open.
          • Select the location where you want to save the file, enter a 'File name' and click 
             'Open'.
          • Click 'OK' on the 'Export Completed!' confirmation message.

• Viewing a document/image
          • Highlight the record and click 'View', or double click on the record.
          • The item will open in your computer's established document or image viewing 
             program. (Request)

 (11/19/2020) Command (Edit) > Location > Login.LocationGroupUnique
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• When editing the patient's 'Loc' field, it will now only display the Locations that are 
   connected to the 'Location Group Restriction' attached to the person that is currently 
   logged into the software.

 X (9/24/2019) Command (Edit) > Merge > New Select Patient Window

• When searching for the patient to Merge, there is a NEW 'Select Patient' Window.
• Enter the Last, First name and hit enter; matching names (or the closest matches) will 
   display in the bottom window.
• Information displayed includes the following: 
          • Patient (Last, First)
          • Age
          • Plan
          • Last Visit
          • Provider
          • Location
          • Acct# (Request)
          • Responsible (Last, First)
          • Balance (total balance on Ledger; Patient and Insurance combined)

 X (12/18/2019) Command (Insurance) > Field/Label Change(s)

• CARRIER Name – Field EDITED.
          • When accessing the drop-drown to search for a Payor, the information will now 
             include the 'Payor ID'. (Request)
          • Right click in the field to access the 'Payor Names' table to make changes; the user
             must have Login Access Rights to modify tables.

• New button – Button REMOVED.
          • The 'New' button was removed from the 'Add/Edit Ins. Co. & Insured' screen.
          • To access the table directly from this screen, right click in the 'Name' field.

• Policy # - Field EDITED.
          • Medicare check – A number of characters check was added for Medicare. If an ID 
             with anything other than 10 OR 16 characters is entered, when the record is 
             saved, the following error message will appear: Illegal Medicare ID# Length!

 (11/6/2020) Command (Insurance) > Patient Date of Birth

• The patient's Date of Birth will now display on the header to the right of their name on 
   the 'Add/Edit Ins. Co. & Insured' window.

 (10/18/2019) Command (Insurance) > Pay % Warning

• When saving the Insurance record, if the combined Pay % for all records is greater than 
   100%, the following warning will appear: Insurance Pay % exceeds 100 for active Payors!

 (3/26/2019) Command (Insurance) > Print > Eligibility > Report(s) EDITED

• The 'Carrier Eligibility' report was updated to include the Benefit Period.
• This coverage period appears in sections regarding details of various benefit types ONLY if
   it is received from the Payor.

 X (12/6/2019) Command (Jump) > Episode > Functionality Relocated and 
Enhanced
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• Creating an Episode
          • The options for ADDING/EDITING/DELETING an Episode have been relocated from 
             the 'Referral > History/Eligibility' screen to the 'Jump > Episode' screen. (Request)
                    • A NEW 'Episode of Care' grid has also been added to the Patient 
                       Demographic screen. See the Patient Demographics section further down 
                       for full details.
          • Commands:
                    • Add – Add a NEW Episode.
                    • Edit – Edit an existing Episode.
                    • Delete – Delete an existing Episode.
                    • Staff > Add/Delete – Connect/Remove a Staff member from the Episode.
                              • This accesses the Login IDs table.
                              • If the patient has multiple active Episodes connected to staff 
                                 members, the one that defaults to the demographic screen, will be 
                                 the one connected to the user that is currently logged into the 
                                 system.
                                        • Episode 1 connected to staff member ABC.
                                        • Episode 2 connected to staff member XYZ.
                                        • Staff member XYZ logs into the software, so Episode 2 will 
                                           default to the top of the demographic screen.
                                        • If the patient has an Appointment scheduled wth an Episode 
                                           connected, that will default, regardless of the staff member 
                                           connected.
          • Click 'Add' to add a NEW Episode, enter the data below and 'Save' when done.
                    • Episode Start – Enter the start date of the Episode.
                    • Date of Injury – Enter the Date of Injury for this Episode.
                              • Defaults as the 'Injury Date' or Onset for the Complaint.
                              • Defaults as the 'Illness' date on the Claim when posting charges to 
                                 the Ledger.
                    • Description – Select a description to classify the Episode. Right click in the 
                       field to access the drop-drown table and make changes.
                    • Category – This is a NEW field that is IN DEVELOPMENT. Right click in the 
                       field to access the drop-drown table and make changes.
                    • Note – Notes pertaining to the individual Episode.
                    • Episode End – End date to be entered when the Episode is completed.
          • Information displayed: Start (date), Description, Injured (date), Category and End 
             (date).
          • Connecting Staff to the Episode. 
                    • Once the Episode is created, highlight it, click on 'Staff' and select 'Add'.
                    • A window will open to display the Login IDs table; double click to select.
                    • Click 'Staff > Add' if you would like to connect multiple staff members.
                    • If you need to REMOVE a staff member, highlight the name in the bottom 
                       window and click 'Staff > Delete'; then click 'OK' to confirm deletion.
                    • When the staff member is logged in, and access the patient record, the 
                       Episode that they are connected to will automatically default as the active 
                       Episode.

• Patient Demographics
          • NEW 'Episode of Care' grid
                    • Compulink will be updating the CHS-Owned screens with the new 
                       information. If your office is using a CUSTOMIZED patient tab, and you 
                       would like to use the new information, you will need to copy the grid, and 
                       all of the filter scripts for the other grids.
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                    • This is a filtered grid to only show the patient's ACTIVE Episodes.
                              • To display both active and inactive Episodes (ones with End dates), 
                                 highlight the ellipsis (3 dots) and select 'Filter > All Episodes'.
                              • Inactive records will display '[DC'd]' for discontinued.
                              • To go back to the filtered grid, highlight the ellipsis and select 'Filter 
                                 > Active Episodes'.
                    • It can also be used to Add/Edit/Delete an Episode, and connect it to an 
                       Insurance, Referral Source and/or Patient Contact.
                    • Information displayed includes:
                              • Effective (date)
                              • (Episode) Name
                              • (Episode) Category
                              • I = Insurance. 'Y' indicates that it has been connected to an 
                                 Insurance Payor.
                              • R = Referral. 'Y' indicates that it has been connected to a Referral 
                                 Source.
                              • C = Contact. 'Y' indicates that is has been connected to a Patient 
                                 Contact record.
                              • * = Note. '*' indicates that there is something in the 'Notes' field on 
                                 the Episode.
                                        • To view the 'Notes', hover the mouse over the '*' for a PopUp,
                                           or double click on the record to bring up the Edit window.
                    • Add an Episode
                              • Highlight the ellipsis and select 'Add'.
                              • When the 'Episode Add/Edit' window opens, follow the same steps as
                                 above (under Jump > Episode) to create the record.
                              • After each new Episode is added, the 'Select Active Episode' window 
                                 will open to choose the current ACTIVE Episode; this only occurs 
                                 when adding through the 'Episode of Care' grid.
                                        • Information displayed: Start (date), Name, Injured (date) and
                                           Category.
                    • Edit an existing Episode
                              • Double click on the record, or highlight it, then highlight the ellipsis 
                                 and select 'Edit'.
                    • Delete an Episode
                              • Highlight the ellipsis and select 'Delete'.
                              • Click 'Yes' on the confirmation window.
                    • Connect a Patient Contact record or multiple Contact records (Request)
                              • The Patient Contact record MUST be added to the patient PRIOR to 
                                 this.
                              • Highlight the Episode, then highlight the ellipsis and select 'Connect 
                                 Contact'.
                              • A 'Select Contacts for XXX' window will open, where XXX is replaced 
                                 with the name of the Episode that was highlighted.
                              • The window will display all of the Contact records entered for the 
                                 current patient; check the box next to all Contacts that you want to 
                                 connect to the Episode, and then click 'OK'.
                              • If there is only a single Contact, you may double click the record.
                              • The 'C' column in the grid will now display a 'Y' to indicate that a 
                                 Contact record has been connected.
                              • Follow the same steps to uncheck or unconnect the record.
                    • Connect an Insurance or multiple Insurances (Request)
                              • The Insurance MUST be added to the patient PRIOR to this.
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                              • Highlight the Episode, then highlight the ellipsis and select 'Connect 
                                 Insured'.
                              • A 'Select Insurance for XXX' window will open.
                              • The window will display all of the Insurances entered for the current 
                                 patient; check the box next to all Insurances that you want to 
                                 connect to the Episode, and then click 'OK'.
                              • If there is only a single Insurance, you may double click the record.
                              • The 'Episode Payor Connection' window opens to enter the ID 
                                 number that this Insurance should appear on the charges (Example:
                                 enter 1 for Primary); enter the number and click OK.
                                        • If more than one Insurance was selected, a window will open 
                                           identifying each one and prompting to enter the ID.
                              • The 'I' column in the grid will now display a 'Y' to indicate that an 
                                 Insurance has been connected.
                              • Follow the same steps to uncheck or unconnect the record.
                    • Connect a Referral or multiple Referrals (Request)
                              • The Referral Source MUST be added to the patient PRIOR to this.
                              • Highlight the Episode, then highlight the ellipsis and select 'Connect 
                                 Referral'.
                              • A 'Select Referral for XXX' window will open.
                              • The window will display all of the Referral Sources entered for the 
                                 current patient; check the box next to all Sources that you want to 
                                 connect to the Episode, and then click 'OK'.
                              • If there is only a single Source, you may double click the record.
                              • The 'R' column in the grid will now display a 'Y' to indicate that a 
                                 Referral Source has been connected.
                              • Follow the same steps to uncheck or unconnect the record.
          • Active Episode Display on Header
                    • When moving from one patient to another, the software will now look for 
                       any ACTIVE Episodes.
                    • Patient scheduled WITH an Appointment that day
                              • If the Appointment has an Episode connected, that Episode will 
                                 automatically display under the menu at the top of the demographic 
                                 screen.
                    • Patient WITHOUT an Appointment that day
                              • If the patient has ONE active Episode, that one will automatically 
                                 display.
                              • If the patient has MULTIPLE active Episodes, a 'Select Active Episode'
                                 window will open, displaying ALL active Episodes; double click to 
                                 select the one to be used at this time.
                              • Once selected, that Episode will then display under the menu.
                    • Changing the active/displayed Episode
                              • Click the name displayed under the menu to open the 'Select Active 
                                 Episode' window, and double click on a different Episode.
                              • You may also single left click on an Episode in the 'Episode of Care' 
                                 grid.
          • Utility Command > Episode Selection 
                    • This is a NEW command that was added. 
                    • If an Episode is not displaying under the menu, use this command to open 
                       the 'Select Active Episode' window.
          • Filtering Grids (Request)
                    • Once the active Episode is selected, the following grids will only display the 
                       records that are connected to that active Episode:
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                              • Insurance, Referral Sources, Patient Contacts and Appointment 
                                 History.
                    • If no records were connected, then ALL records for that section will display 
                       in the grid.
                              • No Contacts were connected, so ALL contact records will display.
                              • One Insurance was connected, so only that one Insurance will 
                                 display.
                    • Click 'Utility > Episode Selection', choose a different active Episode, and the
                       records in the grids will change, based on what is connected to the new 
                       Episode.
                    • You may also single left click on an item in the 'Episode of Care' grid, and 
                       the records will change, based on what is connected to that Episode. 

• Appointments
          • The Book/Edit window has a NEW 'Episode' field and 'Episode of Care' grid.
                    • See the section 'Appointment Enhancements: Command (Book/Edit) > NEW
                       Episode Functionality' for complete details.
                    • Compulink will be updating the CHS-Owned screens with the new 
                       information. If your office is using a CUSTOMIZED Appointment edit screen,
                       and you would like to use the new information, you will need to copy the 
                       grid, and all of the filter scripts for the other grids.
          • Customization
                    • In the Daily Detail screen, click Tools > Column > Customize.
                    • Select 'Appointment' on the far left.
                    • Under 'Available Fields', you now have the option to display 'Episode' in the 
                       Appointment Scheduler.
                    • Select the Configuration on the right that you would like to add it to, then 
                       double click on 'Episode' to add it to the 'Table-Field' list.
                    • Drag and Drop to change the order if needed, change the column width and
                       save the Configuration.

• Referral
          • The 'Episode' command now only has the options to 'Add' or 'Delete'.
          • If you used the 'Episode of Care' grid to connect a Referral to an Episode, the 
             Episode will already be displayed in the bottom window.
          • Connect an Episode to a Referral (the Referral Source must already be added).
                    • Highlight the Referral and click 'Episode > Add'.
                    • When the 'Select Active Episode' window opens, double click to select.
                    • Continue this process if more than one Episode should be connected to the 
                       individual Referral.
          • Remove an Episode from a Referral.
                    • Highlight the Referral, then highlight the Episode in the bottom window that
                       needs to be removed.
                    • Click 'Episode > Delete', then 'OK' to confirm deletion.

• Insurance
          • You now have the option to connect an Episode to an Insurance, and control which 
             Insurances appear on the charges when posting. (Request) 
          • If you used the 'Episode of Care' grid to connect an Insurance to an Episode, the 
             Episode will already be displayed in the bottom window.
          • When posting charges to the Ledger, if an Episode is connected to an Insurance (or
             multiple Insurances), ONLY that Insurance will appear on the charges.
          • If the Episode is NOT connected to an Insurance, then ALL active Insurances for 
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             the patient will appear on the charges.
          • Connecting an Episode to the Insurance
                    • Highlight the Insurance and click 'Episode > Add'.
                    • When the 'Select Active Episode' window opens, double click to select the 
                       Episode that you want to connect to the Insurance.
                    • The 'Enter Payor Order' window opens to enter the order number that this 
                       Insurance should appear on the charges (Example: enter 1 for Primary); 
                       enter the number and click OK.

• Exam
          • Active Episode
                    • Upon entering the Exam, the active Episode that was displaying on the 
                       patient demographics, will display at the top of the Exam screen.
                    • To change the active Episode, click on the name that is currently displayed 
                       at the top of the screen and choose from the 'Select Active Episode' 
                       window.
          • Adding an Exam
                    • When a new Exam record is added, the active Episode will default into the 
                       Episode field.
                    • If an Episode was NOT selected/displayed, once the Exam record is added, 
                       it will need to be selected from the drop-down field; the 'Select Active 
                       Episode' window will open to choose from. 
          • Active Episode vs. Exam Episode
                    • The CURRENT ACTIVE Episode will display at the TOP of the Exam screen.
                    • The Episode CONNECTED to the Exam (Exam Episode) will display in the 
                       Episode field on the actual Exam record.
          • PopUpComplaint tab
                    • If the Episode that is connected to the Exam contains an 'Injured Date', the 
                       'Injury Date' or Onset on the PopUpComplaint will default with that date.

• Ledger
          • Active Episode
                    • Upon entering the Ledger, the active Episode that was displaying on the 
                       patient demographics, will display at the top of the screen.
                    • To change the active Episode, click on the name that is currently displayed 
                       at the top of the screen and choose from the 'Select Active Episode' 
                       window.
          • Posting Charges
                    • If the active Episode is connected to an Insurance, when you post a charge,
                       that Insurance (or Insurances) will automatically default into the 'Carriers' 
                       section.
                    • If NO Insurances are connected to the Episode, ALL valid Insurances will 
                       default into the 'Carriers' section.

 X (1/9/2020) Command (Jump) > Task > New 'Task Management' Functionality 
Added

• A NEW Task Management functionality has been added that will allow for the following:
          • Assigning the responsibility to an individual staff member, a Staff Group, or a 
             Department Group.
          • Staff can be assigned to multiple Departments.
          • Categorization of Tasks, so they can easily be filtered for the needs of the staff.
          • Creation of Task Groups (multiple Tasks grouped together under one name) that 
             will automatically be added to the patient record based on the Order, Surgery, 
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             Test, or Treatment they are connected to.
                    • This allows for Task Groups to be attached to individual items in the table, 
                       and not based just on CPT Code like the Todo by CPT Code.
                    • Two Treatments may have the same CPT Code, but you only want to assign 
                       a Task Group to one of them.
          • Creating Payor Groups and connecting them to Orders, Surgeries, Tests and 
             Treatments for Task assignment.
                    • Certain Payors may require specific Tasks be completed prior to a Surgery 
                       being performed.
                    • Create a Task Group, Create a Payor Group and attach both of those to the 
                       Surgery.
                    • When the Surgery is added to the patient record, the individual Tasks will 
                       automatically be added as well.
• Consider transitioning your current Todos to this NEW Task Management, as the ToDo 
   functionality will eventually be phased out some time in 2020.
• Upon update, Compulink-Owned entries from the 'Todo/Followup> Items table, will be 
   copied to the NEW 'Task Definition' table.
          • If you would like User-Owned entries to be copied over, you must use the new 
             'Migrate' command found in the table.
          • This allows the User to continue to use the Todo functionality, and then Migrate 
             their entries when they are ready (prior to the end of 2020).
• A new Patient tab with a 'Patient Tasks' grid to replace the 'Patient Action Items' grid will 
             be delivered with the update.
          • This tab will have the same name as the current HiRes tab, with '- Tasks' at the 
             end; Example: Patient (HiRes–Tasks).
          • When the office is ready to stop using Todos and start using Tasks, the 
             Administrator will need to go into the Screen Builder and replace the 'Patient 
             (HiRes)' tab with the 'Patient (HiRes–Tasks)' tab on any layouts that are being 
             used.
          • See the Compulink Advantage Help Manual for instructions on how to access the 
             Screen Builder, load a layout and add/remove a tab.

• Table Setup
          • Task Definition table
                    • Main menu: Utility > Look-up Tables > General > Tasks > Definition.
                    • On-the-fly: From the patient record, click Jump > Task > Add; in the Task 
                       screen, right click in the 'Task' field to open the table.
                    • See the following topic for details on Table Setup: Look-up Table 
                       Enhancements: General > Tasks > Definition > NEW Table Added.
          • Task Category table
                    • Once in the 'Task Definition' table (see above), add a record and right click 
                       in the 'Category' field to open the table.
                    • See the following topic for details on Table Setup: Look-up Table 
                       Enhancements: General > Tasks > Definition > NEW Table Added.
          • Task Note Table
                    • Right click in the 'Notes' field in the Task > Add window to open the table.
                    • Click the 'Add' command.
                               • Display Order – Order in which you would like the Note to display in 
                                  the list.
                               • Owner – Defaults to 'U' for User-Owned.
                               • Hide – Defaults to 'N' to display in the list.
                               • Value – Enter the Note.
                               • Modified – Date the record was last modified.
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          • Task Status Table
                    • Right click in the 'Status' field in the Task > Add window to open the table.
                    • Click the 'Add' command.
                               • Display Order – Order in which you would like the Status to display 
                                  in the list.
                               • Owner – Defaults to 'U' for User-Owned.
                               • Hide – Defaults to 'N' to display in the list.
                               • Value – Enter a name for the Status. Example: In Progress.
                               • Modified – Date the record was last modified.
                    • Save the record.
                    • Your table MUST contain the following Values: Opened and Resolved.
                    • Follow the same steps to enter as many other Status Values as needed.

• Adding a Task
          • Click Jump > Task > Add.
          • Task – Click the drop-down to select the Task that you want to assign. 
                    • If the Task selected is established in the Task Definition table with a 'Staff 
                       Group', it will populate the 'Group' field.
                    • If it is established with a 'Department Group', it will populate the 'Dept. 
                       Group' field.
                    • This is a MANDATORY field. If left empty, when clicking Save, the following 
                       message will appear: Task Identifier Required!
          • Opened – Date the Task was OPENED. Defaults to the current date (may not edit).
          • Details – This field will only appear if the 'Task' that is selected is set up in the 
             table with a 'Template'. The default text will display in the field.
                    • May only be edited when initially ADDING the Task to the record, not when 
                       EDITING the Task and adding notes later.
                    • The only exception to this is when the Task is added automatically via the 
                       software; see 'Connecting Task Groups and Payor Groups to Table Items'.
          • When – Date/Time the Task is EDITED. Defaults to the current date/time (may not 
             edit). 
          • By – Name of person currently logged in and creating the Task.
          • Resolved – Date the Task is resolved. To be filled out once the Task is completed. 
          • Notes – Information regarding the task. Free text, or double click in the field to 
             open the 'Select Task Note(s) window to choose from. 
                    • This is a MANDATORY field. If left empty, when clicking Save, the following 
                       message will appear: Missing Activity Notes!
          • Status – Current Status of the Task. Defaults to 'Opened'.
                    • Click the drop-down to select the Status (Example: In Progress). 
                    • This is a MANDATORY field. If left empty, when clicking Save, the following 
                       message will appear: Missing Status!
          • Priority – If this field is checked, the Task will move to the top of the list in the 
             'Patient Tasks' grid on the demographics. 
          • Responsible – Staff member responsible for the Task. Defaults to the name of the 
             person currently logged in. Click the drop-down to select another staff member 
             (Login IDs table).
                    • If the Task selected is established in the Task Definition table with a 'Staff 
                       Group', the Responsible field will only display the staff members assigned 
                       to the specified Staff Group.
                    • If it is established with a 'Department Group', the Responsible field will only
                       display the staff members with a matching 'Employee Dept' in the Login IDs
                       table. 
                               • Mary works in the MRI dept: Login IDs table has 'Employee 
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                                  Dept'=MRI
                               • Departments > Identification table: MRI Department code=MRI
                               • Department Groups table: Group=Radiology, attached departments 
                                  are MRI and CT
                               • When a Department Group of 'Radiology' is assigned to the Task, 
                                  that is linked to Department of 'MRI', and Department of 'MRI' is 
                                  linked to employee Mary, therefore, Mary's name will appear in the 
                                  filtered list.
                    • If there are NO MATCHES found for either the 'Staff Group' or the 
                       'Department Group', when the drop-down is clicked, the following message 
                       will appear: Unable to Locate any items matching search criteria!
          • Follow Up – Date staff needs to follow up on the Task. Defaults to the following 
             day. Click the drop-down to open a calendar and select a different date.
          • Due – Date the Task is due to be completed. (Request)
                    • Defaults to the current Date.
                    • Once the 'Task' is selected, the Date will be calculated based upon the 'Days
                       to Complete' field in the Task Definition table.
                    • The 'Patient Tasks' grid on the demographic screen will sort based first by 
                       Priority, then by Due date.
          • Group – If you would like to assign the Task to a GROUP of staff members, click 
             the drop-down and select from the Staff Group table (Utility > Look-up Tables > 
             General > Staff > Groups). (Request)
                    • If the Task selected is established in the Task Definition table with a 'Staff 
                       Group', this field will populate automatically.
          • Dept. Group – If you would like to assign the Task to a specific Department Group, 
             click the drop-down and select from the Department Groups table. (Request)
                    • If the Task selected is established in the Task Definition table with a 
                       'Department Group', this field will populate automatically.
                    • You may not assign BOTH a 'Staff Group' AND a 'Department Group'. If both
                       are selected, upon saving, the following message will appear: Task can not 
                       have both a Staff Group and a Department Group assigned!
          • Save the Task.

• Editing a Task
          • Click Jump > Task > Edit.
          • Details – This field will only appear if the 'Task' that is selected is set up in the 
             table with a 'Template'. The default text will display in the field.
                    • May only be edited when initially ADDING the Task to the record, not when 
                       EDITING the Task and adding notes later.
          • When – Date/Time the Task is EDITED. 
          • By – Name of person currently logged in and editing the Task.
          • Resolved – Date the Task is resolved. To be filled out once the Task is completed. 
                    • Double click to auto-populate with current date.
                    • If the Resolved date needs to be removed, use one of the following options:
                       double click in the field or highlight the entire date and either hit the 
                       Backspace key or the Delete key on the keyboard.
                    • Double clicking in the field will also automatically populate the 'Status' field 
                       with the Status of 'Resolved'.
          • Notes – Information regarding the task. Free text, or double click in the field to 
             open the 'Select Task Note(s) window to choose from. 
                    • This is a MANDATORY field. If left empty, when clicking Save, the following 
                       message will appear: Missing Activity Notes!
                    • Notes may be entered even if the Task has a 'Resolved' date.
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          • Status – Current Status of the Task. Click the drop-down to select the Status 
             (Example: In Progress).
                    • This is a MANDATORY field. If left empty, when clicking Save, the following 
                       message will appear: Missing Status!
          • Responsible – Staff member responsible for the Task. Defaults to the name of the 
             person currently logged in. 
                    • Click the drop-down to select another staff member (Login IDs table).
                    • If the Task selected is established in the Task Definition table with a 'Staff 
                       Group', the Responsible field will only display the staff members assigned 
                       to the specified Staff Group.
                    • If it is established with a 'Department Group', the Responsible field will only
                       display the staff members with a matching 'Employee Dept' in the Login IDs
                       table. 
                    • At this time, the Task may be re-assigned to a DIFFERENT Staff Group, 
                       Dept. Group and/or Responsible party.
          • Follow Up – Date staff needs to follow up on the Task. Defaults to the following 
             day. Click the drop-down to open a calendar and select a different date.
          • Group – If you would like to assign the Task to a DIFFERENT group of staff 
             members, click the drop-down and select from the Staff Group table.
          • Dept. Group – If you would like to assign the Task to a DIFFERENT Department 
             Group, click the drop-down and select from the Department Groups table. 
                    • You may not assign BOTH a 'Staff Group' AND a 'Department Group'. If both
                       are selected, upon saving, the following message will appear: Task can not 
                       have both a Staff Group and a Department Group assigned!
          • Bottom window – Contains the following history of information about the Task:
                    • When – Date Added/Edited.
                    • Who – Staff logged in when Adding/Editing.
                    • Status – Status selected by staff member.
                    • Responsible – Responsible party selected by staff member.
                    • Follow Up – Date staff selected to Follow Up on the Task.
                    • Notes – Notes entered when Adding/Editing.
          • Save the Task.

• Patient Demographics
          • NEW 'Patient Tasks' grid
                    • This is a filtered grid to only show Current Tasks for the active patient.
                              • To display both Current and Resolved Tasks, highlight the ellipsis (3 
                                 dots) and select 'Filter > All Tasks.
                              • Resolved Tasks will display a date under the 'Resolved' column.
                              • To go back to the filtered grid, highlight the ellipsis and select 'Filter 
                                 > Current Tasks'.
                    • It can also be used to Add/Edit/Resolve/Delete a Task.
                    • Information displayed includes:
                              • Opened (date)
                              • P (Priority check)
                              • Due (date)
                              • (Task) Name
                              • Responsible (person)
                              • Resolved (date)
                    • Add a Task
                              • Highlight the ellipsis and select 'Add'.
                              • When the 'Task for:' window opens, follow the same steps as 
                                 above (under Jump > Task > Add) to create the record.
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                    • Edit an existing Task
                              • Double click on the record, or highlight it, then highlight the ellipsis 
                                 and select 'Edit'.
                    • Resolve a Task
                              • Highlight the Task, then highlight the ellipsis and select 'Resolve'.
                              • The software automatically enters the current date into the 
                                 'Resolved' field, and the Task will no longer display in the grid 
                                 (filtered for Current Tasks only).
                    • Delete a Task
                              • Highlight the Task, then highlight the ellipsis and select 'Delete'.
                              • Click 'Yes' on the confirmation window.
          • NEW 'Current User Tasks' grid
                    • This is a filtered grid to only show Current/Unresolved Tasks for the current 
                       Login ID.
                    • Information displayed includes:
                              • Due (date)
                              • Patient (Name)
                              • Task (Name)
                    • Double click on a patient to be taken to their demographic screen.

• Connecting Task Groups and Payor Groups to Table Items
          • This NEW functionality allows connecting of Task Groups to items in the table; 
             when those items are attached to the patient, the software will automatically add 
             the individual Tasks that make up the Group to the patient's record.
          • If certain Payors require specific Tasks to be completed, you may also connect a 
             Payor Group.
                    • Task Groups may be connected on their own, but if connecting a Payor 
                       Group, you must also select a Task Group.
          • The following EHR tables allow for connecting of Task Groups and Payor Groups:
                    • Orders > Definition
                    • Surgery > Name
                    • Test > Name
                    • Treatment > Name
          • Follow these steps to connect a Task Group and Payor Group:
                    • Highlight the Name of the item that you want to connect the Task to.
                    • Click on 'Detail > Add'; this opens the 'Task Group by Order Editing' 
                       window.
                    • Click the drop-down to select a 'Task Group'. Right click to access the table.
                    • Click the drop-down to select a 'Payor Group'. Right click to access the 
                       table.
                    • Enter a 'Display Order' if anything other than the natural order is preferred.
                    • Save the record.
          • The same steps are used in ALL tables.
          • See the following entry under the Look-up Table Enhancements section for details 
             on how to add records to the tables: EHR > Surgery > Name Table > NEW Task 
             Groups and Payor Groups.

• Worklist – Task Management All
          • A NEW Worklist 'Task Management All' was added.
          • See section 'Command (Worklist) > New Worklist(s) Added' for complete details.

 X (2/4/2020) Command (Jump) > Todo > Moved/Changed

• The 'Todo' command was moved under the NEW 'Jump' command.
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• Consider transitioning your current Todos to the NEW Task Management, as the ToDo 
   functionality will eventually be phased out some time in 2020.
• The 'Done' command was removed in preparation of phasing this functionality out. To 
   mark the Todo as Done, highlight and click 'Edit', or double click to open and click the 
   'Done' check.
• The Add/Edit screen has been changed to the same PopUpToDo screen that is used in the 
   patient exam.

 (3/25/2020) Command (Print) > .Option(s) ADDED

• Letter to Multiple Referral/Contact
          • This is a NEW option that allows the office to select multiple Referral Sources or 
             Patient Contacts to send a letter to at one time. (Request)
          • Click Print > Letter to Multiple Referral/Contact.
          • The 'Select Letter' window opens; click the drop-drown to choose a letter.
          • The 'Select Referral/Contact' window opens with the list of the records that have 
             been added to the patient record.
                    • Check the boxes next to the Referral Sources/Contacts to be sent a letter.
                    • Click anywhere in the blue to save, or click OK.
          • Click 'OK' on the confirmation message: Letters have been Queued up for 
             PracticeWatch to Send!
          • The next time PracticeWatch runs, the letter will be sent to the Referral 
             Source/Contact via Fax.

 X (7/30/2019) Command (Print) > .Option(s) REMOVED

• The following Print options were REMOVED, as they are now handled via the NEW 
   Document Creation window when selecting Print > Letter:
          • Send Letter to Patient Portal
          • Send Letter to Referral/Contact

 X (11/17/2020) Command (Print) > NEW Document Creation Window

• A NEW 'Document Creation' window will now display when selecting the Print command 
   from the following areas:
          • Patient Demographics
                    • Print > Letter
                    • Print > Template
          • Exam
                    • Print > Letter
                    • Print > Selected
• The window contains the following options to choose from:
          • Document – The Document that you want to print/send
                    • When selecting Print > Letter or Template, default is blank.
                    • When selecting Print > Selected in Exam, a slightly different window 
                       appears.
                              • Encounters – The left side lists all of the patient's Encounters. 
                                        • Information displayed includes the Date, connected Episode 
                                           and Layout name. 
                                        • You can check individual Encounters, or click the 'Select All' 
                                           button to check ALL Encounters.
                                        • This allows you to send a range of Exams connected to a 
                                           specific Episode of Care to a selected contact via print, fax or 
                                           Direct E-Mail. (Request)
                              • Documents – The right side lists all of the patient's previously saved 
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                                 PDF and TIF files from ExamImage. 
                                        • Information displayed includes the Date and file Name.
                                        • You can check individual items to include, or click the 'Select 
                                           All' Button to include ALL items; these will accompany the 
                                           default letters assigned to the layouts that are selected via 
                                           Encounters.
          • Type – Type of recipient
                    • Options for Type: Attorney, Contact, Facility, Medical Lab, Patient, Payor, 
                       Referral and Other.
                    • When selecting Print > Letter, Template or Range, default is 'Patient'.
                    • This will now allow the user to send any document they choose to the 
                       Patient Contact and Referral. (Request)
          • Who – Recipient
                    • When selecting Print > Letter, Template or Selected, default is the patient 
                       name.
                    • If Type='Patient', this will default to the patient name.
                    • If Type='Attorney', the drop-down will display any patient contacts with a 
                       'Relationship'=Attorney.
                    • If Type='Contact', the drop-down will display any patient contacts with a 
                       'Relationship'= anything OTHER THAN Attorney.
                    • If Type='Facility', the drop-down will display the Facilities table.
                    • If Type='Medical Lab', the drop-down will display the Medical Labs attached 
                       to the patient's ExamTest records.
                    • If Type='Payor', the drop-down will display the patient's Insurance Payors.
                    • If Type='Referral', the drop-down will display the Referral Sources attached 
                       to the patient record. 
          • Method – How you want the document delivered
                    • Options for Method: 
                              • Printer – Can be used for ALL Types. Be aware of any HIPAA 
                                 violations with printing patient medical information.
                              • Fax – Can be used for ALL Types.
                                        • Some Types will auto-fill the Fax# if available, if not, there is 
                                           the option of manually typing in the Fax#. (Request)
                              • Portal Upload – Used ONLY for Type='Patient'.
                                        • Once the Method is selected the software will verify that the 
                                           patient has a valid Portal Account.
                                        • If no account is found, it will look for a patient E-Mail address 
                                           to create an account.
                                        • If there is neither a valid Portal Account NOR an E-Mail 
                                           address, the following Error message will appear: Portal 
                                           Account has not been established for the acct and an e-mail 
                                           does not exist to automatically create one!
                                        • Click 'OK' on the message above, and the 'Method' will change
                                           to 'Printer'.
                                        • If a valid Portal Account is found/created, the patient will be 
                                           sent an automated text with the URL in it to the Portal for 
                                           easier log in. (Request)
                              • Direct Email – Used for Type='Attorney, Contact, Facility, Medical Lab
                                 or Referral'.
                              • File – Can be used for ALL Types. Be aware of any HIPAA violations 
                                 with saving patient medical information.
                    • When selecting Print > Letter, Template or Range, default is 'Printer'.
                    • If Type ='Attorney, Contact, Facility, Medical Lab or Payor', once the 'Who' 

1100 Business Center Circle | Thousand Oaks, CA  91320 | 805.716.8677 | eLearning@compulinkadvantage.com
www.compulinkadvantage.com

   64



Patient Area
                       field is selected, this will default to 'Fax'.
                    • If Type ='Referral', once the 'Who' field is selected, this will default to 
                       'Direct Email'.
          • Fax # - Fax # of the recipient
                    • If Method='Fax', a 'Fax #' field will automatically display.
                    • If Type='Attorney', once the Attorney is selected in the 'Who' field, the 'Fax 
                       #' will populate from the patient contact record.
                    • Outbound Fax#
                              • The Fax# that will be listed as the outbound Fax will be determined 
                                 by the patient’s Location Code, and the 'Department Group' of the 
                                 User that is logged in and sending the Fax.
                              • If there is no 'Department Group' assigned to the User that is logged
                                 in, it will simply find the first Fax# in the Fax Setup table where the 
                                 Location Code of the patient is part of the 'Service Location Group' 
                                 associated with the Fax #.
          • Direct – Direct Email of the recipient
                    • If Method='Direct Email', a 'Direct' field will automatically display.
                    • If Type='Referral', once the Referral is selected in the 'Who' field, the 
                       'Direct' Email will populate from the patient Referral record connected to 
                       the Referral Source table.
          • File – Name that you would like to assign the file that is created
                    • If Method='File', a 'File' field will automatically display.
                    • This field is blank, and you MUST enter a name for file creation.
                    • Enter a file name with NO extension (Example: ABNSmithJohn).
                              • The merged document will open to the screen, and automatically be 
                                 saved to the 'TemporaryDocuments' folder inside the Advantage 
                                 product directory.
                              • This folder is cleared out shortly after the lock on the document is 
                                 released and/or when the Advantage application is closed.
          • PracticeWatch Delivery – Check if you would like it sent via PracticeWatch
                    • If Method=anything OTHER THAN 'Printer' or 'File', this will automatically 
                       display, and default to checked.
                    • Uncheck to complete the Document Creation immediately.
• Once you have selected your options, click one of the following:
          • Cancel – This will cancel your selections and close the window.
          • OK – If 'PracticeWatch Delivery' was UNCHECKED, your document will be 
             automatically be sent. If it was CHECKED, the document will be queued to be sent 
             at a later time.
                    • If the 'Document' selected contains a Signature prompt, and PracticeWatch 
                      Delivery is selected, the following message will appear: Select YES to Skip 
                      Signatures within Document!

• Document History
          • All documents that are sent, are tracked in the NEW Document History database.
          • A NEW tab was created for the Patient demographic area called 'History'. It 
             contains both the 'Document History' and the 'Address History'.
                       • All documents Printed/Sent from the Patient and Exam screens, will 
                          display in this NEW tab.
          • Documents with the 'Sign' option that are Printed/Sent from the Patient 
             demographic screen, will also display in the 'Scanned Documents' grid with the 
             following information: Date=Current Date, Name=Document Name and 
             Image=Image of merged document. (Request)
                       • Edit the record to add a 'Type'.
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 (4/7/2020) Command (Print) > Audit Report > Report Extended

• The report was extended to include the following areas:
          • Acct Responsible (Bill Database) – Data Add and Edit Events. (Request)
          • Insured – Data Add, Edit and Delete Events.
                    • Deleted records will show the 'Record ID' number.
          • Patient Action Items (ToDo) – Data Add, Edit and Delete Events.
                    • Deleted records will show the 'Record ID' number.
          • Patient Contacts – Data Add, Edit and Delete Events.
                    • Deleted records will show the 'Record ID' number.
          • Patient Lock-Out – Data Add, Edit and Delete Events.
                    • Deleted records will show the 'Record ID' number.
          • Recalls – Data Add, Edit and Delete Events.
                    • Deleted records will show the 'Record ID' number.
          • Referrals – Data Add, Edit and Delete Events.
                    • Deleted records will show the 'Record ID' number.

 (10/21/2020) Command (Print) > Letter > Document(s) ADDED: FaxCoverSheet

• This was created to be used with the NEW fax functionality that looks at the NEW 
   Document History.
• It contains the following information when merged:
          • Letterhead and Logo
          • To
          • Fax to Number
          • Fax From/Added by
          • Date
          • Number of pages being sent
          • Confidentiality Disclaimer

 (2/6/2020) Command (Print) > Letter > Portal Upload Signed Documents

• You can now select a document with a signature line to upload to the portal. (Request)

 (6/27/2019) Command (Print) > Report > Report(s) EDITED

• PatientInfo
          • Cell Phone added for both the Patient and the Account Responsible. (Request)
          • The area for the E-mail address was increased to accommodate for longer 
             addresses.

 (9/16/2019) Command (Print) > Send E-Mail to Patient > Number of Characters 
Increased

• The number of characters that can be typed, has been increased to 160. (Request)

 X (1/14/2020) Command (Print) > Text Message > NEW Option to Select from 
Table

• The user now has the option of selecting a standardized text message from the NEW 'Text
   Messages' table (Utility > Look-up Tables > General > Text Messages).
• Click 'Print > Text Message', the 'Select Message' window opens to display the items in 
   the table to choose from.
• Highlight a message and hit the Enter key, or double click the message to select.
• The 'Texting Patient' window will open with the selected message in the field; type any 
   additional information needed and click 'OK' or 'Cancel'.
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 (9/11/2019) Command (Print) > Text Message > Number of Characters 

Increased

• The number of characters that can be typed, has been increased to 140. (Request)

 X (11/5/2020) Command (Referral) > User Friendly Edit Screen

• The 'Editing Referral History/Eligibility' screen has been upgraded to be more user 
   friendly.
• The 'Type' and 'Date' fields are now to the right of the 'Business' field.
• A NEW picture field was added under the 'Save' to display the picture of the Referral 
   Source if imported into the Referral Sources table.
• The 'Source' field was renamed to 'Business'.
          • Right click in the field to open the Referral Sources table and changes. (Request)
          • Professional Referral
                    • Type the Professional name, then click the drop-drown.
                    • The 'Select Referral' window will open to display a list of the closest 
                       matches.
                              • Information displayed includes the Business (Name), (Source) Name 
                                 and (Source) City, State & Zip.
                              • Highlight a source and hit the Enter key, or double click to select.
                    • The following information will default from the table if completed:
                              • Business – Business Name field
                                        • Business Name must be pulled from drop-down, otherwise,
                                           Following message will display upon saving of the record:
                                           Referral Required to be Pulled from Lookup or Patient Search!
                                          (Request)
                                        • Once this Name is selected, it will be grayed out, and the 
                                           drop-drown will be disabled.
                              • Co-Manage - Co-Manage
                              • Name – Salutation, First, Middle, Last and Degree
                                        • Fields in previous versions: Last, First, MI, Salutation and 
                                           Degree
                              • Addr – Addr. Line #1 and Addr. Line #2
                              • Phone - Phone
                              • Fax - Fax
                              • E-Mail – E-Mail (non PHI Use)
                              • Direct – Direct E-Mail (Request)
                              • Specialty - Specialty
                              • Comm. Method – Secure Communication Method
                              • Auto – Automatically Communicate
                                        • Field in previous version: Send CCD
                              • Letter – This is used to override the Comm Method of 'Fax 
                                 Document' only. If this Referral will need a letter other than the 
                                 standard one that will be sent via auto communication, click the 
                                 drop-drown and select an override letter.
                              • Web Site – Web Site URL
                              • Accept Medicare – Medicare
                              • Accept Medicare Advantage – Medicare Advantage
          • Patient Referral
                    • Type the Last Name, First Name, then click the drop-drown.
                    • The NEW 'Select Patient' search window will open with a list of patients that
                       match what was typed; double click to select.
                    • The 'Business' field will display Last,First (grayed out), 'Name' will display 
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                       First, Last and the 'Addr' will merge from the Referring patient record.
• Eligibility/Authorization
          • Buttons (Get Eligibility, Get Authorization and Reset Benefit) – These were 
             REMOVED, as they are only used for Vision Service Plans in the Eyecare and 
             Ophthalmology Advantage products.
          • Plan ID field – This was REMOVED, as it is only used for Vision Service Plans in the 
             Eyecare and Ophthalmology Advantage products.
          • Usage Type – Renamed from 'Usage'.
          • Max Usage – Renamed from 'Max'. Field size increased to 4 characters. (Request)
          • Expire – Renamed from 'Exp.'
          • Usage Incurred – Renamed from 'Incurred'.
• Fields REMOVED, as they are no longer needed:
          • Provider Code
          • ID
          • License
          • Letter 
          • Date Letter Sent
          • Appt Date/Time
          • Comm. Received/Reviewed
• ALERT – Because the 'Source' was replaced with the 'Business Name', you MAY need to 
   update the information that displays in the grid on the Patient Demographic screen, AND 
   the information that merges into any CUSTOM OpenOffice documents and Crystal 
   Reports.
          • Check your Referral > Sources table to see if the entries have a 'Business Name'.
          • If not, you may want to start entering them now for future use.
          • To display the 'Name' field in the grid and CUSTOM items, you will need to use the 
             Referral.Name field.

 X (11/20/2019) Command (Search) > New Search Window

• A NEW Search window that consolidates ALL search options into one screen was created.
• This new window is available in the following areas: Patient Demographics, Exam and 
   Ledger. 
• It can be accessed either by clicking the 'Search' command, or by holding down the 'Alt' 
   key on your keyboard and hitting the letter 'S' for Search. (Request)
          • The only exception is on the Ledger; because 'S' is used as the hotkey for 
             'Service', 'H' must be used as the hotkey for 'Search'.
• This window allows the user to enter multiple search filters, instead of just one filter at a 
   time.
          • Example: Last name AND phone number.
• Patient Search Options (Request)
          • Last, First – Search by Patient 'Last, First', 'Last' or ',First'.
                    • Enter the full Last Name, First Name (Smith, John)
                    • Enter the full Last Name (Smith)
                    • Enter a partial Last Name (Smi)
                    • Enter a comma, then the full First Name (,John)
          • Phone – Searches both the Patient 'Home' and 'Cell' fields. (Request)
          • Birth – Searches the Patient 'Birth' field.
          • Medical Rec# - Searches the 'EHR' number. (Request)
                    • This can be found to the right of the Name and Account # at the very top of
                       the screen on the Exam.
                    • Example: Exam – Heath, Adam [ACCT: 327] [EHR:820]
          • Email – Searches the Patient 'E-Mail' field.
          • User#1 – Searches User Field#1. 
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                    • The Compulink-Owned screen uses this field for the Patient 'SSN'.
                    • If searching by the SSN, enter ONLY numbers, no dashes or spaces.
          • User#2 – Searches User Field#2.
                    • The Compulink-Owned screen uses this field for the Patient 'Occupation'.
• Account Responsible Search Options
          • Acct# - Searches the Patient/Account Responsible Account#.
          • Last, First - Search by Account Responsible 'Last, First', 'Last' or ',First'.
• Enter your criteria and click 'Search'.
          • Search based upon Location Group
                    • The software will only search Patient/Account Responsible records based 
                       upon the users Login Location Group.
                    • If there is no Location Group assigned in the Login IDs table (Location 
                       Group Restriction field), ALL records will be searched.
                    • If a Location Group IS assigned, then only records connected to Locations 
                       that are assigned to that Group will be searched.
                    • This will prevent the user from seeing records that are NOT a part of their 
                       Location Group.
          • Search results
                    • Once you click 'Search', a 'Searching' message will display to let you know 
                       that the software is looking for the results.
                    • If NO match is found, the following warning will appear: Unable to locate 
                       any records for current search criteria! Please change criteria and try again!
                              • Click 'OK' on the warning message.
                              • The warning closes and the Search window remains open for you to 
                                 enter a different search criteria. (Request)
                    • If a single match is found, you will be taken directly to the Patient/Account 
                       Responsible record.
                    • If more than one match is found, all records with matching criteria will be 
                       listed in the bottom of the window; double click to select, or highlight the 
                       record and hit the Enter key on your keyboard.
                    • If NO CRITERIA is entered, and you click 'Search', the entire Patient 
                       database list will display in alphabetical order. The internal criteria defaults 
                       to the Last Name of 'A%', the % represents a wildcard.
                    • Information displayed includes the following:
                              • Patient (Last, First Name Middle Initial) (Request)
                              • Birth
                              • Age
                              • Plan
                              • Last Visit
                              • Provider (listed on the Demographic screen)
                              • Location
                              • Acct#
                              • Responsible (Last, First Name)
                              • Balance (total balance on Ledger; Patient and Insurance combined)
• Advanced Command
          • In previous versions, this was found under 'Search > SQL Options'. (Request)
          • The 'Data Mining' function can be used to create custom Search options.
          • Many of the Compulink-Owned SQL Options will no longer be needed, as the 
             search criteria is now available in the new Search window. You may go into the 
             Data Mining utility and mark these as 'Discontinued', so they no longer show on 
             the list.
• Companion Command 
          • If the active Patient record is part of a Companion account, the 'Companion' 
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             command will show as an option at the top of the window.
          • Click the command to automatically be taken to the Companion account for that 
             active Patient.
          • If there is no Companion account, the command will be hidden.

 X (12/23/2019) Command (Utility) > Appt History > .Command Relocated

• The 'Appt History' command was moved from the 'View' menu.
• The following enhancements were made to the display:
          • Location – Header expanded from 'LOC', and now merges the full location name, 
             and not just the ID.
          • Department – Header expanded from 'DEPT', and now merges the full department 
             name and not just the ID.
          • Who – Header expanded from 'ID', and now merges the full Appointment Provider 
             name, and not just the ID. If the Appointment was scheduled on a template 
             assigned to a Tracking Station, this field will be empty.
          • Status – Header expanded from 'S', and now merges the full Status, and not the 
             one character Status Code.
          • Comments – This will now merge the 'Notes' field and not the 'Remarks' field.
          • Station – This is a NEW field that will display the Station if the Appointment was 
             scheduled on a template assigned to a Tracking Station. If the Appointment was 
             scheduled on a template assigned to a staff member, this field will be empty.
          • Episode – This is a NEW field that will display the Active Episode attached to the 
             Appointment. If there is no Active Episode, the field will be empty.
          • By and Reminder – These fields were REMOVED from the display.

 X (12/23/2019) Command (Utility) > Appt History > .Display Changes

• Grid Changes
          • Date – Will now display a four digit year.
          • Location – Column header renamed from 'LOC', and will now display the full 
             Location name. This column will only appear if using multiple Locations.
          • Department – Column header renamed from 'DEPT', and will now display the full 
             Department name. This column will only appear if using multiple Departments.
          • Who – Column header renamed from 'ID', and will now display the full Provider 
             name.
          • Status – Column header renamed from 'S', and will now display the full Status.
          • Comments – Now displays the 'Comments' field instead of the 'Remarks' field.
                    • Click on a record and hover the mouse over the Comment to trigger the 
                       PopUp window that displays all data entered into the 'Comments' field.
          • Station – TBA
          • Episode – This is a new column that will display the Episode that is connected to 
             the Appointment. 
          • By – This column was REMOVED, as the data is now contained in the NEW Audit 
             Trail Report. See the topic: Command (Utility) > Appt History > Audit Trail > New 
             Report.
          • Reminder - TBA

• Icon Changes
          • Appt - The label was renamed to 'Scheduler'.
          • Audit Trail – The icon was changed to a flashlight.
          • Change Future – The icon was changed to a pencil.
          • Tracking Stops – The label was renamed to 'Tracking', and the icon was changed to
             a walking person.
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 (10/28/2020) Command (Utility) > Appt History > .Display Changes

• The Location and Department columns will only display if the practice is utilizing multiple 
   Location Codes and/or Department Codes.
• The Station column will only display if the practice is using SMART Workflow (Patient 
   Tracking).

 X (4/6/2020) Command (Utility) > Appt History > Audit Trail > New Report

• A NEW Crystal Report Audit Trail has replaced the Advantage Software version.
• Highlight an Appointment and click 'Audit Trail'; this will open a Report Viewer with the 
   'Appointment Auditing History'. (Request)
• If the Appointment is very old (prior to full auditing being available), the report will be 
   blank, and the following message will appear in red at the top: No data matches your 
   selections.
• The top of the report shows the Appointment in its CURRENT state:
          • Date – Current Date
          • Location – Current Location Code it is scheduled at
          • Dept – Current Department it is scheduled for
          • Provider – Current Provider it is scheduled with
          • Status – Current Status
          • Reason – Current Reason
• The next line shows information about WHEN the Appointment was made:
          • Activity Type - How the Appointment was originally made, like Add or Insert
          • Act. Date/Time – Actual Date/Time it was put into the Advantage software
          • (UTC) – Universal Time, Coordinated. Time zones around the world can be 
             expressed as positive or negative offsets from UTC.
          • By – Who made the original Appointment
          • Login Location – IP Address of the computer where it was made
          • From/Type – Type of connection where it was made, like Console for network 
             connection.
• The next line shows information about the ORIGINAL Appointment:
          • APPT DATE – The original Date of the Appointment
          • LOCATION – The original Location Code it was scheduled at
          • DEPT – The original Department it was scheduled for
          • ID – The original Provider it was scheduled with
          • Status – The original Status
          • REASON – The original Reason
• If changes were made to the Appointment, they will be listed in chronological order:
          • Activity Type will have 'Modify'.
          • Act. Date/Time of modification
          • (UTC) – Universal Time, Coordinated of the modification
          • By – Login ID of the person that made the modification
          • Login Location – IP Address of the computer where the modification was made
          • From/Type – Type of connection where it was made
          • MODIFIED section – This will display the fields that were modified
                    • FIELD – Name of the field
                    • BEFORE – Data in the field BEFORE the modification
                    • AFTER – Data in the field AFTER the modification

 X (12/30/2019) Data Entry > AdvantageERx Eligibility Check

• If available, enter the patient Middle Name when adding the patient record. This will 
   assist when checking for Eligibility in AdvantageERx.
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 X (4/29/2019) SMART Workflow > 1. Re-branding Functionality

• The 'Patient Tracking' functionality is being re-branded, and will now be referred to as 
   'SMART Workflow'.
• The 'Patient Workflow Tracking' window is now the 'SMART Workflow Dashboard'.
• The functionality at the bottom of the window will be referred to as the 'SMART Workflow 
   Toolbar'.

 (12/9/2019) SMART Workflow > 2. Environment Variable > Mobile Workstation

• The new Environment Variable 'MOBILEWORKFLOW=Y' has been created for offices that 
   use mobile devices as Workstations.
• If the device is set up with this variable, when the user selects a patient from the Waitlist 
   (see topic: SMART Workflow > Toolbar > Waitlist), the software will assign it a Station 
   that is equal to the Station Category that the patient is currently at in the Workflow.
• Example: Patient is at 'Check-In' when the user selects them from the Waitlist. The 
   Station that will display at the bottom left of the window will be 'Check-In'. If that user 
   takes that same mobile device, goes into the Exam, and that patient has been moved to 
   the Exam Station Category in the Workflow, when they select them from the Waitlist, the 
   Station in the bottom left will now show as Exam.
• If the User is NOT moving with the patient, but needs to change their Station Category, 
   they may click on the Station Category that is displaying on the SMART Workflow Toolbar.
          • This opens the 'Select New Station' window; double click or highlight and hit the 
             Enter key to select the new Station Category.
          • The SMART Workflow Toolbar will now display the NEW selection.

 X (10/4/2019) SMART Workflow > Dashboard Access

• Access to the SMART Workflow Dashboard is now limited to the following areas to reduce 
   clutter:
          • Patient Demographics
          • Exam
          • Ledger

 (11/19/2020) SMART Workflow > Dashboard > Ellipsis Icon & Skip Stop Option

• A NEW ellipsis icon will now display in the Station header when the patient is highlighted.
• Use this to move the patient to a Station Category OTHER THAN the next one in the 
   Workflow.
• Click the icon to open the 'Select a Workflow Category' window.
• Double click to select, or highlight a Workflow Category and hit the Enter key.
• If the selected Workflow Category is NOT the next one in the Workflow, the following 
   message will appear: Select YES to Permanently SKIP Stop: XX (XX represents the next 
   Category in the Workflow).
          • Click 'No' to leave the next Category in the Workflow available for the patient to be
             moved to.
          • Click 'Yes' to permanently SKIP that Workflow Category for this visit for this 
             patient.
                    • The Category in the Workflow AFTER the skipped one will now display as 
                       the next Workflow Category available for the patient.
          • Example: Workflow = Check-In, Pre-Test, ExamTech, ExamDr, Check-Out
                    • Patient currently in 'Pre-Test'. Select ellipsis and choose to move them to 
                       Category 'Billing' to make a correction.
                    • Receive prompt to permanently SKIP 'ExamTech' (it is the next Category in 
                       the Workflow).
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                    • Click 'No'. Patient moved to 'Billing' and 'ExamTech' shows as next Workflow
                       Category.
                    • Click 'Yes'. Patient moved to 'Billing' and 'ExamDr' shows as next Workflow 
                       Category.
• If the next Workflow Category is marked as a type 'Check-Out', the SKIP message will 
   NOT appear, as it is the last stop on the Workflow.

 (1/15/2020) SMART Workflow > Dashboard > Right Click Option(s) ADDED

• Cancel Arrival
          • If a patient was “Arrived” by mistake, there is now an option to 'Cancel Arrival'.
          • Left click on the patient in the SMART Workflow Dashboard to highlight them, right
             click and select 'Cancel Arrival'.
          • Select 'OK' or 'Cancel' on the message: Confirm the cancellation of Arrival of 
             patient XX (XX represents the Last, First name of the patient).
          • If 'OK' is selected, the patient will be moved back to the 'Appointments' window.

 X (1/28/2020) SMART Workflow > Dashboard > Command (Arrive) > Command 
REMOVED

• The 'Arrive' command was removed from the top of the Dashboard, as most clients are 
   Arriving the patient from the Appointment, Demographic or SMART Workflow Toolbar.
• The option to Arrive the patient is still available by right clicking on the patient in the 
   window.

 (11/6/2020) SMART Workflow > Dashboard > Command (Depart) > Clear 
Toolbar

• When the 'Depart' command is used in the Dashboard, it removes the patient from the 
   Dashboard, as well as from the SMART Workflow Toolbar at the bottom of the screen.

 X (2/13/2020) SMART Workflow > Dashboard > Command (Utility) > Command 
RENAMED

• The 'Tools' command was renamed to 'Utility' to be more consistent throughout the 
   software.

 (3/16/2020) SMART Workflow > Dashboard > Utility > Table Setup > Staff Pod 
Control

• This table works hand-in-hand with the 'Work Group Pods' table to control which 
   patients are viewed/controlled in the SMART Workflow Toolbar Waitlist.
• This is only used if the current Login ID is NOT a Provider or Scribe.
• The first step is to create Pods in the 'Work Group Pods' table; once those are created, 
   use this table to designate the staff members that will control those Pods.
• Here are some examples of how this table may be used:
          • Staff member ABC controls Work Group Pod 'Check-Out Staff' for Location '001' 
             every day.
          • Staff member XYZ controls Work Group Pod 'Check-In Staff' for Location '001' from
             7am-Noon, and for Location '002' from 1pm-4pm.
          • Staff member RTG will control Work Group Pod 'Check-In Staff' for Location 002' 
             on Wednesday from Noon-4pm, starting 1/1/20 and ending 1/8/20.
• To assign the control of the 'Work Group Pod', click the 'Add' command.
          • Start – Date the Staff member will start having control.
          • End – Date the Staff member will stop having control.
          • Who – Staff member (select from the Login ID table).

1100 Business Center Circle | Thousand Oaks, CA  91320 | 805.716.8677 | eLearning@compulinkadvantage.com
www.compulinkadvantage.com

   73



Patient Area
          • Work Group Pod – Select from the 'Work Group Pods' table.
          • Daily Start – Start time in the day when the Staff member will start having control.
          • Daily End – End time in the day when the Staff member will stop having control.
          • Day(s) – The day of the week the Staff member will have control. 
                    • This is a MANDATORY field.
                    • If it only applies to a specific day during the Start/End Date range, select 
                       the individual day.
                    • If it applies to multiple days, there will need to be one entry for each day.
                    • If it applies to every day of the week, there only needs to be one entry; 
                       select 'All days of week' from the drop-drown'.
          • Save the record.

 X (2/13/2020) SMART Workflow > Dashboard > Utility > Table Setup > Work Group
Pods

• This table was renamed from 'Staff Workflow Assignment'.
• It works hand-in-hand with the 'Staff Pod Control' table to control which patients are 
   viewed/controlled in the SMART Workflow Toolbar Waitlist.
• This is only used if the current Login ID is NOT a Provider or Scribe.
• If a staff member only checks out patients, they may be set up at Station with a 'Patient 
   Tracking Stop' of 'Check-Out', and only view/control patients in the Waitlist that have 
   been moved to that Station Category of 'Check-Out'.
• If a staff member works 'Check-In', you may want them to be able to view/control 
   patients for Station Categories of 'Check-In', 'Exam' and 'Check-Out'; this will allow them 
   to move that patient throughout the entire Workflow.
• To create a 'Work Group Pod', click 'Add'.
          • Location – The Location/Office that you are creating the Pod for.
          • Name – Assign a Name for the Pod like 'Check-In Staff'
          • Save the record.
• Attach the individual Workflow Stations to the Pod
          • Highlight the Pod and click on 'Detail > Add'.
          • When the 'Select Workflow Station' window opens, double click on a Station.
          • Follow this process until you have attached all of the Workflow Stations that you 
             need to create the Pod.
          • Example: Pod Name=Check-In Staff, Workflow Stations attached=Check-In, 
             Exam1, Exam2 and Check-Out.

 (6/12/2020) SMART Workflow > Dashboard > Utility > Table Setup > Workflow 
Groups > Table Renamed & Functionality Available

• The 'Category Groups for Staff' table was renamed to 'Workflow Groups'.

 (2/13/2020) SMART Workflow > Dashboard > Utility > Table Setup > Workflow 
Station Category > Field(s) ADDED

• Color - NEW field added.
          • Used to color code the Workflow Station Category.
          • When a patient is moved to a Station in the Dashboard that is connected to the 
             Station Category, the header at the top of the panel will reflect the specified color.
          • If there is no patient at the Station, the header reflects the color specified in the 
             'Workflow Stations' table.

 (2/14/2020) SMART Workflow > Dashboard > Utility > Table Setup > Workflow 
Stations > Field(s) ADDED
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• Location Group
          • This NEW field replaces the 'Office Location' field. (Request)
          • Instead of attaching a SINGLE Location, you can now attach a Location Group.

• Max Waiting Area Seating
          • The maximum number of patients allowed to be waiting at this station.
          • Used in conjunction with 'Waiting Area' Stations, or Workflow Station Categories 
             that are marked 'Waiting Area'='Y'.
          • Default value is zero.
          • If the value is greater than zero, then the number of patients currently at that 
             Station will be verified to insure that it has not reached its max prior to moving 
             the patient.
          • Once the maximum number of patients are at the Workflow Station, if the user 
             tries to move another one there, the following message will appear: There is no 
             open Tracking Station that meets the category XX (XX represents the Station 
             Category).

• Workflow Stop
          • This field is used to identify Stations that are NOT going to be used as part of the 
             SMART Workflow setup, but you do want the option to MANUALLY move the 
             patient to the stop if needed.
          • Example: The patient is seen by the Provider, and then needs to schedule their 
             surgery prior to moving to the 'Check-Out' stop of the Workflow.
                    • Go to the table 'Workflow Station Categories', and create a Category to 
                       attach to the stop that you are going to create (Example: Scheduling).
                    • Come back to the 'Workflow Stations' table and create a stop where they 
                       will schedule their surgery (Example: Sx Scheduling).
                    • Mark the Station as 'Workflow Stop' = N.
                    • Once the record is saved, click 'Detail > Add' and select the Workflow 
                       Station Category that you created (Example: Scheduling).
          • The patient has seen the Provider, and their name is displaying on the SMART 
             Workflow Toolbar at the bottom of the screen.
          • Click the ellipsis (3 dots) to open the 'Select a Workflow Category' window and 
             choose your non-workflow Category (Example: Scheduling).
          • A confirmation window will open with the following message: Select YES to 
             Permanently SKIP Stop: XXX (XXX represents the next stop in the Workflow).
                    • Selecting 'Yes' will move the patient to the selected non-workflow Category, 
                       and when done, when the staff moves them again, they will SKIP the XXX 
                       Stop and move to the following one in the Workflow.
                    • Selecting 'No' will move the patient to the selected non-workflow Category, 
                       and when done, when the staff moves them again, they will move to the 
                       XXX Stop (the standard next Stop in the Workflow).

 X (10/4/2019) SMART Workflow > Dashboard > Utility > Table Setup > Workflow 
Stations > Field(s) REMOVED

• Office Location - Field REMOVED.
          • This field was REMOVED from the table and replaced with 'Location Group'.

 X (10/8/2020) SMART Workflow > Toolbar > Moving a Patient

• NEW ellipsis icon
          • A NEW ellipsis (3 dots) icon was added to the toolbar, and will display between the 
             Station Category that the patient is currently at, and the Station Category that is 
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             next in the Workflow.
          • To move the patient to the Station Category that is listed next in the Workflow, 
             simply click on the white arrow, or the Station Category.
          • To move the patient to a Station Category OTHER THAN the one displayed, click 
             the ellipsis icon to open the 'Select Workflow Category' window, and double click 
             to choose a different option.

• Check-Out Stations
          • If there are multiple Stations set up as 'Check-Out' Stations, when a patient is 
             moved to 'Check-Out', the user will no longer be prompted to select the individual 
             Station; the patient will automatically be moved to the first available 'Check-Out'.
          • If the patient is at a 'Check-Out' Station, and the next stop in the Workflow is 
             empty, 'Depart' will display as the next Station Category. 
                    • Clicking the arrow or the word 'Depart' will Depart the patient.
                    • Once the patient has been Departed, the 'Wait Count' will be updated.
• Hold icon
          • The 'Hold' icon will not display if the patient is at a Station that is flagged as a 
             'Waiting Area' or 'Check-Out', as these Stations allow for multiple patients.

• PopUp Messages Removed
          • With the addition of the option to move a patient from the Toolbar, the following 
             PopUp messages have been removed after saving the Exam record: (Request)
                    • Ready to move Patient to next Station? Use OK to Move or YES to Move and
                       Hold!
                    • Ready to move Patient to next Station? Select OK to Move!

 (1/14/2020) SMART Workflow > Toolbar > Waitlist

• If patients are waiting at the Workflow Station that the user logs into, the word 'Wait' will 
   display highlighted in yellow on the SMART Workflow Toolbar.
• For Workflow Stations that are designated as 'Waiting Area' or 'Check-Out', the Wait 
   Count (number of patients waiting) for that Station, will display to the right of the word 
   'Wait'.
          • When does the 'Wait Count' get updated?
                    • As soon as the patient is moved to another Workflow Station.
                    • In another area of the software and returning to the Patient Demographics. 
                    • Once a patient has been 'Departed' from the office
                    • When the 'Search' command is selected.
• Click 'Wait' to open the 'Patients Waiting' list and view patients.
          • If the user logs into a computer that is set up as a Workflow Station, the Waitlist 
             will automatically pop up.
          • This happens only when logging back in from an area OTHER THAN the main 
             screen of the software.
• Patients displayed
          • If the user is logged in as a Provider or Scribe, this window will display ALL 
             patients scheduled for that Provider (or the Provider that the Scribe is logged in 
             for). (Request)
          • If the user is NOT a Provider or Scribe, the software will look to the 'Staff Pod 
             Control' table to decide on what to display.
                    • Staff Workflow Assignment table – Create the 'Work Group Pod' name, and 
                       assign the individual Workflow Stations to it.
                    • Staff Pod Control table – Pick the user and assign the 'Work Group Pod' that
                       they are allowed to view/control in the SMART Workflow. Assign Start/End 
                       dates, Daily Start/End times and number of Days.
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                    • The Waitlist will display all patients that are at Stations that are assigned to 
                       the 'Work Group Pod' that is connected to the user that is logged in.
                    • Example: 'Work Group Pod'='Exam'. Individual Stations attached=Exam1, 
                       Exam2 and Exam3. In the 'Staff Pod Control' table, user=ABC, and they are
                       attached to 'Work Group Pod' of 'Exam'. When user 'ABC' logs in, they will 
                       see all patients on the Waitlist that are in Exam1, Exam2 and Exam3.
          • If the user is neither a Provider or Scribe, nor are they assigned a 'Work Group 
             Pod', then only the patients that are currently at the Station they are logged into 
             will display in the window.
• Information displayed includes:
          • Appt – Appointment Time
          • Reason – Appointment Reason
          • Provider – Provider Last, First Name
          • Notes – Appointment Comments field
          • Arrived – Time patient was Arrived into the office (Arrive command)
          • Wait – How long the patient has been waiting at the current Station
          • Name – Patient Last, First Name
          • Where – Station Category that the patient is currently at
          • For – Station Name the patient is currently at
          • Next – Next Station Category for the patient in the SMART Workflow
          • Open Room – Name of an Open Station that the patient can be moved to
• Double click on the Station under 'Open Room' to move the patient to that Station.
          • This can be done from ANY Station that is a Tracking Stop.
          • Move the patient from your Station to the next Station.
          • Pull the patient from the current Station to your Station. (Request)
          • Move the patient from the current Station to the next Station (neither one is 
             yours).

 X (11/16/2020) Tabs > Tab(s) ADDED

• History
          • A NEW tab was created called 'History', and contains both the NEW 'Document 
             History' and the 'Address History' found on the 'PtAddressHx' tab.
          • Document History panel
                    • All documents sent, are tracked in the NEW Document History database.
                    • Ellipsis options:
                              • Cancel – Used to Cancel an item that has been queued to be sent via
                                 PracticeWatch. (Request)
                                        • Highlight the line, highlight the Ellipsis and select 'Cancel'.
                                        • Click 'OK' on the the message: Document has been 
                                           Successfully Canceled!.
                              • REQUEUE – Used to resend an item with a 'Status' other than 'Sent'.
                                        • May have been missing a Fax Number, and it has been added.
                                        • May only be used on items previously sent via Fax, Direct or 
                                           Patient Portal upload. (Request)
                                        • Highlight the line, highlight the Ellipsis and select 'REQUEUE'.
                                        • If the document was Signed and saved, it will be pulled from 
                                           the IMS folder and resent; if it was not signed, the function 
                                           reprints the document using the Document History 
                                           Instruction field.
                   • Information displayed in the grid includes the following: (Request)
                              • Sent - Date document was sent
                              • Name – Document Name
                              • Type – Type of communication (Printer, Fax, Patient Portal, etc.)
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                              • EHR – Displays 'Y' if sent from Exam, blank if not.
                              • Destination – Who/Where the document was sent.
                              • Status – Status of the document communication (Sent, Failed, etc.)
                              • Confirmation – Date and time Confirmation of a successful 
                                 communication (only displays for Fax and Direct E-Mail 
                                 communications)
                    • Failed Communications Worklist
                              • Click the 'Failed Communications' label to bring up the Worklist.
                              • This will show a list of all documents that failed to be sent. (Request)
                              • Information displayed includes the following:
                                        • Acct (number)
                                        • Name (Patient Last, First)
                                        • Document (Name)
                                        • To (Recipient)
                                        • Sent (Date and Time attempt was made)
                                        • Error (Reason for Failed Communication)
                              • Double click on a patient to move to their Demographic record.

          • Address History panel
                    • Addresses that the patient previously resided at.
                    • Ellipsis options:
                              • Add – Add a new Address
                                        • Ellipsis option 'Copy From Patient' will copy the 'Street', 
                                           'City', 'State' and 'Zip' from the Patient Demographic screen.
                                        • From/To – Dates that the patient lived at this address
                                        • Street – Previous Street address
                                        • City/State/Zip – Previous City, State and Zip Code
                                        • Country – Previous Country
                                        • Occupation – Previous Occupation
                                        • Industry – Previous Industry
                                        • Company – Previous Company
                              • Edit – Edit an existing Address by highlighting the line, highlighting 
                                 the ellipsis and clicking on Edit.
                              • Delete – Delete and existing Address by highlight the line, highlight 
                                 the ellipsis and clicking on Delete. Select 'Yes' to Confirm the 
                                 Deletion.
                    • Information displayed in the grid includes the following: From and to, 
                       Address, City, State, Zip and Country.

 X (11/11/2020) Tabs > Tab(s) EDITED

• The following are for ALL tabs in ALL Advantage products.
          • All icons were moved under a 3 vertical dot ellipsis icon to provide a cleaner look.
          • Hover the mouse over the ellipsis to open a window with the available icons for 
             that area, then single left click to select.

• Patient
          • Patient Information panel – Updates were made to the 'Age' field.
                    • If the patient is less than 3 years old, the age will display in months.
                    • If the 'Birth' field is left empty, the word 'Missing' will display next to 'Age:'.
          • Scanned Documents panel – Enhanced format.
                    • Information displayed includes Date, Type and Name.
                    • Double click on an item to load it in a viewer.
                    • Enhanced options under the ellipsis include Scan, View, Import, Export and 

1100 Business Center Circle | Thousand Oaks, CA  91320 | 805.716.8677 | eLearning@compulinkadvantage.com
www.compulinkadvantage.com

   78



Patient Area
                       Delete; for details, see the topic: Patient Area > Command (Document) > 
                       Enhanced Format/Window
          • Today's Appointments panel 
                    • The 'Arrive' icon for SMART Workflow was changed from feet to a person 
                       walking.
                    • A NEW 'Refresh' icon was added. When clicked, it will Refresh the grid with 
                       any changes that have been made on other workstations.

• PopUpContacts - Patient Contacts Screen
          • Always Send CCD check box – This check box was REMOVED.
          • Auto Communicate field – This is a NEW field in the 'Contact Information' section.
                    • If checked, the Patient Contact will automatically be sent a communication 
                       via PracticeWatch, after the electronic health record is signed off. (Request)
                    • The type of communication that is sent is specified in the NEW 'Comm 
                       Method' field.
                    • Will default if selecting an Attorney or Referral, and has been established in 
                       the table.
          • Comm Method field – This is a NEW field in the 'Contact Information' section.
                    • Establishes the type of communication that is automatically sent to the 
                       Patient Contact.
                    • If 'Relationship'=Attorney, and an Attorney is selected from the drop-drown 
                       at the 'Last' field, this will default to 'Fax Document'.
                    • If a Referral is selected from the drop-drown at the 'Last' field, this will 
                       default to what has been established in the table.
                    • If the Patient Contact is NOT an Attorney, and they have a Direct Email and 
                       a Fax, then they will have the option of sending either a CCD via Direct 
                       Email, or a Fax Document via Fax.
                              • If a Referral Source is added as a Patient Contact, you may want to 
                                 send a CCD via Direct Email.
                              • If a Nursing Home is added as a Patient Contact, you may want to 
                                 send a Letter via a Fax Document.
          • Last field – Field updated to filter drop-down by characters entered. (Request)
                    • If field is left empty, and drop-down is selected, the entire Referral table is
                       displayed.
                    • Example: if the letters ‘Ca’ are entered and the drop-down is selected, only
                       referral entries beginning with ‘Ca’ will be displayed.
          • Letter Override field – This is a NEW field in the 'Contact Information' section.
                    • It is used to override the Comm Method of 'Fax Document' only.
                    • If this Contact will need a letter other than the standard one that will be 
                       sent via auto communication, click the drop-drown and select an override 
                       letter.
          • Organization field – The NEW 'Employer' table was connected to this field.
                    • For details on the table, see the topic under Look-up Table Enhancements: 
                       Employer > New Table Added.

• PopUpDemographics
          • City and Financial Plans fields – Right clicking in the fields will now open the Look-
             up table, provided that the User that is logged in has access rights to tables.

Reports
 (3/31/2020) ALL Report Options > EDITED: ALL

• View the entire Parameter field if the data is too long
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          • Use one of the following options:
                    • Hover your mouse over the Parameter.
                    • Go to the line on the header dividing the Parameter and Value. Left click on 
                       the line, hold your left mouse button down and drag the line to the right to 
                       expand the Parameter field.

• Begin command grayed out after click
          • After clicking on 'Begin', the command will be grayed out to prevent users from 
             clicking on it again after the process has already started. (Request)

• Maximize expands window
          • After the report runs and the window opens, use the Maximize square in the top 
             right to make the window full screen and remove the left/right scroll bar at the 
             bottom. (Request)

 (3/30/2020) Administrative > Report(s) EDITED

• Instant Message Review
          • The NEW Parameter/Option 'IM Status: (*)All, (D)Deleted, (N)on Deleted' was 
             added. (Request)
                    • Option to filter the report for Instant Message Status of 'D' for Deleted, 'N' 
                       for Non-Deleted or '*' for All.

 X (7/10/2020) Appointment > Analysis > ADDED: Utilization

• This report reviews Appointment time-slot usage (either booked appointment or blocked 
   time) in schedules that were set-up via Appointment > Utility > Table Setup > Template 
   Schedule. (Request)
• The report uses the templates as they are set up AT THE TIME THE REPORT IS RUN.
         • This is important to keep in mind if changes have been made to the templates.
         • If the report is run ON 03/15/2020, and it is run for a Start Date of 01/01/2020 
             and an End Date of 01/31/2020, and there have been changes made to the time 
             slots on the template since then, it will report on how the template appears on 
             03/15/2020.
• Options/Parameters for running the report include the following:
          • Location (Appt Schedule) – Location assigned to the template in the Template 
             Schedule
          • ID (Scheduled Provider) – ID assigned to the template in the Template Schedule
          • Department (Appt Schedule Dept) – Department assigned to the template in the 
             Template Schedule
          • Start Date (Schedule) – Start Date assigned to the template in the Template 
             Schedule
          • End Date (Schedule) – End Date assigned to the template in the Template 
             Schedule
          • Summary Only? – Default is 'True'. Set to 'False' to show slot count and usage 
             count per time slot by Date, Location, Department, Provider and Template Name.
• Select your Options and click Begin.
• Summary Only=True output displays the following
          • Graph of Appointment Utilization By Week.
          • Appointment Utilization by Year, Month, Location and Provider for each Weekday 
             with Template Name; this includes Used, Slots (open) and Utilization %.
• Summary Only=False output displays the following
          • Graph of Appointment Utilization By Week.
          • Appointment Utilization by Year, Month, Location and Provider for each Weekday 
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             with Template Name; this includes Used, Slots (built) and Utilization %.
          • Appointment Utilization Detail; this includes the following information from the 
             Template Schedule:
                    • DATE – Start Date assigned to the template
                    • LOC – Location Code assigned to the template
                    • DEPT – Department assigned to the template
                    • ID – Provider ID assigned to the template
                    • TEMPLATE – Template Name
                    • APPT TIME – Appointment Time on the template
                    • FILLED – Number of filled slots at that time
                    • SLOTS – Number of slots built at that time (Example: some offices create 
                       two 8am time slots)

 (6/25/2019) Appointment > Daily > Report(s) EDITED

• No Future Appt
          • The patient's Cell Phone will now print on the report. (Request)

 (6/25/2019) Electronic Health Record > ADDED: 2019 PI Patient List

• This NEW report is similar to the 2018 report, and only shows Measures with data that 
   have a denominator that is greater than zero. (Request)

 (6/25/2019) Electronic Health Record > ADDED: 2019 PI Simple List

• This NEW report is similar to the 2018 report, and shows ALL Measures, even if the 
   denominator is empty or equal to zero. (Request)

 (9/21/2020) Electronic Health Record > ADDED: Supervisor Sign-Off Log

• This report is a tool that helps the practice evaluate proper supervision of mid-level 
   Providers and Providers in training.
          • This is legally required by some states, and for some medical specialties.
          • Refer to your state's regulations for the minimum counts and percentages 
             required.
• Options/Parameters for running the report include the following:
          • Location Group (Exam Loc) – Service Location Group. Run the report for an 
             individual Service Location, All Locations or a Location Group of your design. 
             Default is * for All Locations.
          • ID (Provider) – Defaults to * for all mid-level Providers, with the option to filter for 
             one.
                    • If run with *, the output will be grouped by Provider and then Exam Date.
                    • When an ID is selected, it must match the ID of an associated staff 
                       signature on the exam record.
          • STARTDATE – Include Exams starting with this date. Defaults to today's date.
          • ENDDATE – Include Exams ending with this date. Defaults to today's date.
          • Supervisor ID – Defaults to * for All Supervisors, with the option to filter for one.
                    • When a Supervisor ID is selected, the Supervisor ID in the Provider's Login 
                       ID record, must match this value.
                    • For purposes of the report, the Supervisor is the current Supervisor as 
                       noted in the Login table for that Provider’s record at the time the report is 
                       run.
          • Supervisor Sign-Off Required – Defaults to 'True' to include only Exam records for 
             Providers with a Supervisor ID and 'Require Supervisor EHR Sign Off=Y' in their 
             Login ID record.
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          • HIDE Patient Detail? – Defaults to 'True' to produce a Summary of counts and 
             percentages without patient detail.
                    • If 'False', output includes the detail described below that is associated with 
                       records signed by the Provider.
                    • PHI Detail such as patient name or diagnosis isn't included.
          • DEA Scheduled Med Only? – Defaults to 'False' for all.
                    • 'True' will filter for Exam records where a Scheduled Medication (1-5) was 
                       prescribed.
          • Show Random Sample (10%) – Defaults to 'False' for all data rows. 
                    • When 'True', the output is limited to a 10% random data sample; this 
                       option produces the most meaningful data when Supervisor Sign-offs 
                       occur on a regular basis over the date period of the report.
                    • Choose False to select all records for the best overview.
• Report Organization
          • The report is organized by Provider, Supervisor, Exam date, Patient Account# and 
             EHR#.
• Report Detail includes the following:
          • Patient Name
          • Acc

 (8/17/2020) Financial > Acct Management > ADDED: Claims Eligible for Ins. 
Billing (Scrubbed)

• This report lists claims that have been scrubbed, but have NOT been billed out as of the 
   'Process Limit' Date/Time listed on the report. (Request)
• SUGGESTION: Use the following Worklists rather than the report for real-time data:
          • Claims – To Be Billed
          • Claims – To Be Billed - By EMC Destination
• Options/Parameters for running the report include the following:
          • Loc. Group – Location Group selected when the claims were scrubbed. Default is * 
             for All Locations.
          • ID – Service/Ledger Provider ID. Default is * for All, but you may run it for an 
             individual Provider ID.
          • Plan (on Insurance Record) – Financial Plan on the Insurance Payor attached to the
             scrubbed claim. Default is * for All, but you may run it for an individual Plan (Ex: 
             Medicare).
          • Form – Paper Form type on the Insurance Payor attached to the scrubbed claim.
             Default is * for All, but you may run it for an individual Form (Ex: CMS1500).
          • Claim Min $ - The minimum dollar amount on charges within the pending claim. 
          • Group by Payor Name? - Defaults to 'False', meaning the report runs by Location, 
             Patient then Claim Sets sorted by Payor. If set to 'True', the report runs by 
             Location, then Payor, then Patient and Claim Sets.
          • EMC Dest Code (Blank=Paper) – Like the 'EMC' field in Claim Scrubbing, this is the 
             'EMC Dest. Code' on the patient Insurance screen. Default is * for All, but you 
             may run it for an individual Code (Ex: NEICANSI).
                    • Free Type in the field
                    • Wildcards are OK to use 
                    • Leave blank for paper claims
• Select your Options and click Begin.
• Detailed information includes the following:
          • LOC – Service Location Code
          • ID – Service Provider ID
          • ACCT# - Patient Account Number
          • PATIENT NAME – Patient Last, First Name
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          • CLAIM SET – Claim Set# on Ledger charge screen attached to scrubbed claim
          • LEVEL – Coverage, whether Primary, Secondary or Tertiary
          • PAYOR – Carrier Name from the Insurance record attached to scrubbed claim
          • AMOUNT – Ledger charge amount for the unbilled, scrubbed charges (total for the 
             Claim Set)

 (11/3/2020) Financial > Analysis > ADDED: Charge Collection by Patient

• This report is a companion to the 'Charge Collection Analysis', only at the account and 
   patient level.
• The two report formats present the data differently:
          • Charge Collection by Patient – Organized by Patient Account#, then 
             Patient EHR#, then Insurance Code or Description.
          • Charge Collection Analysis – Charges are grouped by Insurance Code or AUX ID, 
             then Insurance Code.
• Both reports are designed for practices using the Line Item Posting (LIP) environment.
• This report includes charges for Services, Materials and Radiology having a Service Date 
   in the report period; with all Payments and Adjustments of ANY DATE applied to those 
   charges.
• If there are charges for more than one patient in the account, patient Subtotals are 
   displayed in the Default view of the report.
• Parameter/Option:
          • LOC (Service Location) – Ledger Service Location ID
                    • Default is * to include all Locations.
          • ID (Service Provider) – Provider ID associated with the Service Charge Posted
                    • Default is * to include all Providers.
          • START DATE (Service) – Ledger Transactions with a Date of Service from this date 
             forward are considered by the report.
                    • Default is today's date.
                    • Double click the Date and use the drop-drown arrow to display a Calendar.
          • END DATE (Service) – Ledger Transactions with a Date of Service through this date
             are considered by the report. 
                    • Default is today's date.
                    • Double click the Date and use the drop-drown arrow to display a Calendar.
          • CPT START CODE – Assign the Lowest CPT Code to include in the report
                    • Default is 0 for All.
          • END CPT – Assign the Highest CPT Code to include in the report
                    • Default is V9999 for ALL.
          • Details – Set to 'True' or 'False' to include account detail.
                    • Default of 'False' will display a Summary only.
                    • If set to 'True', the report includes individual accounts with charges posted 
                       within each CPT group; and a Summary.
          • Expanded Detail – Set to 'True' or 'False' to produce expanded account detail
                    • Default of 'False' will display a Summary only.
                    • If set to 'True', the individual payment and adjustment detail includes 
                       Payment Source (Responsible or Carrier 1/2/3) and Days to Payment for 
                       each Charge.
          • Include CLOSED Accounts? – Set to 'True' or 'False' to include accounts that are 
             marked Closed on the patient Ledger
                    • Default of 'True' will include accounts marked Closed.
                    • If set to 'False', accounts marked Closed are not included.
          • Include Accts on Collections? – Set to 'True' or 'False' to include accounts that are 
             flagged Collection on the patient Ledger
                    • Default of 'True' will include accounts flagged for Collection.
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                    • If set to 'False', accounts flagged for Collection are not included. 
          • ONLY Accts on Collection? – Set to 'True' or 'False' to report on only accounts that 
             are flagged Collection on the patient Ledger.
                    • Default of 'False' will include ALL accounts.
                    • If set to 'True', ONLY accounts flagged for Collection are included.
          • Account Summary ONLY? – Set to 'True' or 'False' to produce a totals line by 
             patient account only
                    • Default of 'False' will produce data based on the selection made for the 
                       Parameters of 'Details' or 'Expanded Detail'.
                    • If set to 'True', a single line of Totals by Account# is produced. 
          • Acct Number (0 for All) – Option to filter the report for an individual patient 
             account number (Request)
                    • Default is 0 (zero) for All accounts.
• Summary Only
          • Single line of Totals in Account# order.
                    • ACCT# - Patient Account Number.
                    • DESCRIPTION – 'Account Totals:'.
                    • Units – Total Number of Units posted to this account, within the Service 
                       Date range.
                    • CHARGE – Total Charge Amounts posted to this account, within the Service 
                       Date range.
                    • CONT ADJ – Total Contractual Adjustments (Adjustments posted as part of 
                       the Charge transaction on the Ledger) associated with Charges posted to 
                       this account, within the Service Date range.
                    • OTH ADJ – Total Non-Contractual Adjustments (Adjustments posted as 
                       separate transactions on the Ledger) applied to Charges posted to this 
                       account, within the Service Date range. Adjustments posted against these 
                       Charges up to the report generation date will be reflected in the Analysis.
                    • NET CHG – Total Charges minus Total Adjustments and Refunds for this 
                       account.
                    • INS PAY – Total Insurance Payments applied to Charges posted to this 
                       account, within the Service Date range. Payments posted against these 
                       Charges up to the report generation date will be reflected in the Analysis.
                    • RESP PAY – Total Responsible Payments applied to Charges posted to this 
                       account, within the Service Date range. Payments posted against these 
                       Charges up to the report generation date will be reflected in the Analysis.
                    • TOT PAY – Total Payments applied to Charges posted to this account, within 
                       the Service Date range.
                    • BALANCE – Balance remaining on Charges posted to this account, within 
                       the Service Date range.
          • Report Totals for the following:
                    • Units
                    • CHARGE
                    • CONT ADJ and OTH ADJ 
                    • NET CHG
                    • INS PAY, RESP PAY AND TOT PAY
                    • BALANCE
          • Percent of Net Charge Paid for the following: INS PAY, RESP PAY AND TOT PAY.

• Default Report
          • Account header
                    • Account – Patient Account Number
                    • Acct Name – Account Responsible First Name, MI Last Name
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                    • Acct Balance – The 'Total Balance' field in the Account Responsible section 
                       of the Patient Demographic screen
                    • On Collection? - Will display a 'Y' or 'N' to identify accounts flagged for 
                       Collection.
                    • Closed? - Will display a 'Y' or 'N' to identify accounts marked Closed.
          • Patient header
                    • EHR#– Patient Electronic Health Record Number
                    • Patient – Patient First Name, MI Last Name
                    • DOB – Patient's Date of Birth
                    • Last Svc – Date last Service was posted to the patient Ledger
                    • Plan – Demographic Plan currently assigned to the Patient
          • CPT information and Totals
                    • CPT – Code posted to the Ledger 
                    • Total Units – Number of Units posted during the Service Date range with 
                       this CPT.
                    • CHARGE – Total Charge Amounts posted with this CPT within the Service 
                       Date range.
                    • CONT ADJ – Total Contractual Adjustments (Adjustments posted as part of 
                       the Charge transaction on the Ledger) associated with Charges posted with 
                       this CPT within the Service Date range.
                    • OTH ADJ – Total Non-Contractual Adjustments (Adjustments posted as 
                       separate transactions on the Ledger) applied to Charges posted with this 
                       CPT within the Service Date range. Adjustments posted against these 
                       Charges up to the report generation date will be reflected in the Analysis.
                    • NET CHG – Total Charges minus Total Adjustments and Refunds for this CPT.
                    • INS PAY – Total Insurance Payments applied to Charges posted with this 
                       CPT within the Service Date range. Payments posted against these Charges
                       up to the report generation date will be reflected in the Analysis.
                    • RESP PAY – Total Responsible Payments applied to Charges posted with this 
                       CPT within the Service Date range. Payments posted against these Charges
                       up to the report generation date will be reflected in the Analysis.
                    • TOT PAY – Total Payments applied to Charges posted with this CPT within 
                       the Service Date range.
                    • BALANCE – Balance remaining on Charges posted with this CPT within the 
                       Service Date range.
         • Account Totals Line information – Units, CHARGE, CONT ADJ, OTH ADJ, NET CHG, 
            INS PAY, RESP PAY, TOT PAY and BALANCE.

• Details = True
          • Includes all of the information from the Default Report.
          • CPT Code expanded to show detail:
                    • Description – Ledger Description 
                    • DOS – Date of Service associated with Charge posted to this account.
                    • MOD – Modifiers assigned to Charge posted to this account, if applicable. 
                    • ID – Ledger Provider ID assigned to Charge posted to this account.
                    • Individual Charge Line information – CHARGE, CONT ADJ, OTH ADJ, NET 
                       CHG, INS PAY, RESP PAY, TOT PAY and BALANCE.
                    • Subtotals per CPT Line information – Units, CHARGE, CONT ADJ, OTH ADJ, 
                       NET CHG, INS PAY, RESP PAY, TOT PAY and BALANCE.
                    • Account Totals Line information – Units, CHARGE, CONT ADJ, OTH ADJ, NET
                       CHG, INS PAY, RESP PAY, TOT PAY and BALANCE.
          • Report Totals Line information – Units, CHARGE, CONT ADJ, OTH ADJ, NET CHG, 
             INS PAY, RESP PAY, TOT PAY and BALANCE.
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          • Percent of Net Charge Paid Line information – INS PAY, RESP PAY AND TOT PAY.

• Expanded Detail = True
          • Includes all of the information from the Default Report and the Details=True.
          • CPT Code expanded to show Payment and Adjustment detail:
                    • Description – Payment and Adjustment Detail 
                    • Date – Date Payment or Adjustment was posted to the ledger.
                    • By – Payment Source (R for Responsible or Carrier 1/2/3). 
                    • Days to Payment – Number of Days between the Date of Service and the 
                       Payment Date.
                    • Individual Payment/Adjustment Line information – OTH ADJ, INS PAY, RESP 
                       PAY and TOT PAY.
          • Report Totals Line information – Units, CHARGE, CONT ADJ, OTH ADJ, NET CHG, 
             INS PAY, RESP PAY, TOT PAY and BALANCE.
          • Percent of Net Charge Paid Line information – INS PAY, RESP PAY AND TOT PAY.

 (10/23/2020) Financial > Analysis > ADDED: Revenue Opportunity

• Compulink offers many services that can reduce costs and improve efficiencies. (Request)
• This report is a tool to quantify potential savings with a number of these services.
• Based on your practice's utilization of the software, the report estimates revenue, as well 
   as your costs for adding services to your Advantage software.
• If you're interested in implementing one or more of these services, please contact 
   Customer Care for additional information and any associated costs.
• Parameter/Option:
          • Start Date – Include Advantage activity from this Date. Default is today's date.
          • End Date – Include Advantage activity through this Date. Default is today's date.
          • Using Interface VSP/Eyefinity? – Set to 'True' or 'False' to indicate whether you are
             currently using the Eyefinity PMI.
                    • Default of 'False' indicates that you are NOT using the interface, and would 
                       like to include details on the report.
                    • Set to 'True' to indicate that you ARE already using the interface.
          • On Compulink Cloud service? – Set to 'True' or 'False' to indicate whether you are 
             an Advantage Cloud Client.
                    • Default of 'False' indicates that you are NOT an Advantage Cloud Client, and
                       you would like to include details on the report.
                    • Set to 'True' to indicate that you ARE an Advantage Cloud client.
          • Compulink License Count – 0 (this is captured automatically - no need to input)
• Revenue Opportunity Available from Functionality/Services Not Currently Used
          • In this report view, each Service or Feature is listed with estimated Revenue 
             Opportunities per Year, as well as a Total Annual Revenue Opportunity for all.
          • Click on a title to view more information; if the report is exported to PDF, the links 
             will be active in the generated PDF document.
• Staff Cost Assumptions
          • Estimated costs are presented using the following values for wage or salary, plus 
             all benefits or other cost of role, per hour. 
          • The job roles presented in the report will reflect your medical specialty. 
          • Your true costs will vary.
                    • Back office technical staff: $30/hour
                    • Billing office staff: $30/hour
                    • Front office staff: $18/hour
                    • Optical/dispensing staff: $25/hour
                    • Non-M.D. Professional staff: $200/hour
                    • M.D. Physician staff: $500/hour
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                    • Professional Psychotherapist staff: $300/hour
• Revenue Opportunity Details
          • This displays a detailed review of your use of the Services/Features, and projected 
             Revenue Opportunities.
          • The opportunities presented in your report are filtered by your Advantage product, 
             and by the report parameters you set.
          • Annual numbers generate automatically, no matter what period you select and 
             small savings add up.
                    • In the report 'annual' means 365 days and 'annualized' means what you’d 
                       expect in 365 days, based on the period in the report.
                    • If you run the report for six months, an annualized total would be close to 
                       double the six-month subtotal.
                    • Example:
                              • For a report period of 45 days, 365/45 = 8.11
                              • The period subtotal, projected out to a year, would be estimated as 
                                 that period subtotal TIMES 8.11
          • For full details on each section, see the Advantage Online Help File.

 (7/30/2019) Financial > Analysis > Report(s) EDITED

• Charge Collection Analysis
          • The NEW Parameter/Option 'Sort by Aux ID' was added. (Request)
                    • Option to sort/group the report by Auxiliary ID, with subtotals for each.
                    • Default is 'False' to NOT sort by Aux ID.
          • The NEW Parameter/Option 'AUXID' was added. (Request)
                    • Option to filter the report for Ledger transactions with a specific Auxiliary 
                       ID. 
                    • Default is '*' to run for ALL Auxiliary IDs.
                    • A combination of 'ID'= *, with a specific 'AUXID', will report this individual's 
                       production statistics across all Providers.

 (5/30/2019) Inventory > Stale > Misc. > Report(s) EDITED

• The individual items in the detail section will now alternate between white and gray 
   highlight to distinguish between records.

 X (10/8/2019) Marketing > ADDED: Patient Demographics Appt Status

• This NEW report captures patients with the selected Appointment Status in the reported 
   period; it displays tables and charts of patient count by Age and Gender, by Race, by 
   Financial Plan and by Zip Code. (Request)
• Options/Parameters for running the report include the following:
          • Location (Appt Loc) – Location Code where Appointment is scheduled. Default is * 
              for ALL.
          • ID (Appt Provider) – ID of the Provider that the Appointment is scheduled with. 
             Default is * for ALL.
          • PLAN (Patient Demogr. Plan) – Plan on the Patient Demographic screen. Default is 
             * for ALL.
          • Appt Start Date – Starting Date of Appointments to be included. Default is the 
             current date.
          • Appt End Date – Ending Date of Appointments to be included. Default is the 
             current date.
          • ZIP Codes From – Starting Zip Codes to be included. Default is 00000.
          • End ZIP Code – Ending Zip Codes to be included. Default is 99999.
          • Enter StartAGE – Starting Age of patients to be included. Default is 0.
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                    • The default will include patients with a blank Birth Date field.
          • AGE To – Ending Age of patients to be included. Default is 120.
          • Gender – M, F or * for ALL – Gender of patients to be included. Default is * for 
             ALL.
          • Race (Wildcards OK) – Default is * for ALL.
                    • You may enter Alaska Indian, or Alaska*
                    • Alaska* will find all patients with a race of 'Alaska Indian', Alaska Native' 
                       and 'Alaskan Athabascan'.
          • Appt Status (up to 3, * for All) – Status of the Appointment. Default is K for Kept.
                    • You may enter up to 3 upper case letters with no comma (Example: SKA)
                    • Use * for ALL.
                    • The selected Status types MUST exist under Tools > Table Setup > Status.
          • Show Detail? - Defaults to 'False' or No. If 'True', the report opens with 
             demographic detail per patient, in account# order.
• Select your Options and click Begin.
• Patient Detail in Account# Order includes the following information:
          • Acct# - Patient Account#
          • EHR# - Patient unique#
          • Plan – Patient Demographic Financial Plan
          • Gender – Patient Gender
          • DOB – Patient Date of Birth
          • ZIP – Patient Zip Code
          • Age – Patient Age
          • Race – Patient Race
          • Age Group – Patient Age Range
• The report also includes the following (each with a Graph and Chart):
          • Patients By Gender and Age Group
          • Patients by Race
          • Patients by Financial Plan
          • Patients by ZIP Code – Top 15

 (6/19/2019) Recall > Report(s) EDITED

• Recall/Reactivation List
          • The Parameter/Option 'Include Address?' has been updated.
                    • If set to 'True', a second line will print with the patient address (as usual).
                    • The patient name was removed from the second line, as it was redundant.
                    • If the patient has an E-mail address, it will now print at the beginning of the
                       second line. (Request)
                    • If the Option is set to 'False', the ENTIRE second line will be suppressed.

• Non-Updated Recall
          • The NEW Parameter/Option 'Patient Status: (*)All, (A)ctive, (I)nactive' was added.
                    • Looks at the 'Active' check box on the demographic screen. (Request)
                    • Default is '*' to run for ALL Active and Inactive patients.
                    • Enter 'A' to only run for patients with the 'Active' field checked.
                    • Enter 'I' to only run for patients with the 'Active' field unchecked.

 (7/16/2019) Referral > General > Report(s) EDITED

• Referrals General
          • The NEW Parameter/Option 'Include (A,S,W,M,I,G) was added. (Request)
                    • These letters represent Referral Types that are related to correspondence 
                       regarding the patient.
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                    • Previous versions of the report always included these Types; this new 
                       parameter now gives the option to EXCLUDE them by leaving the default of 
                       'False'.
                    • See the Compulink Advantage Online Help Manual for definitions of the 
                       Referral Type letters.

 (5/28/2019) System Admin. > ADDED: ERx Administrative Message Log

• This report captures Prescriber and Location record changes that are communicated 
   between AdvantageERx and Surescripts.
• When records are saved in the Location Details or Surescript Provider table (accessed 
   with the ERx pill icon in the Provider table), a message is sent to Surescripts.
• Options/Parameters for running the report include the following:
          • Start Date (sent date) - Starting Date of messages to be included. Default is 
             today's date.
          • End Date - Ending Date of messages to be included. Default is today's date.
• Select your Options and click Begin.
• The data is grouped by Message Type:
          • Provider Messages such as Location/Provider Information Updates.
          • No Provider Identified.
• Details include the following:
          • SENT – Message Date
          • EVENT – Message Type
          • Provider SID – Clinician's Surescripts Provider ID
          • Provider – Clinician's Name
          • Result – Message was Accepted or Rejected
• See the Compulink Advantage Online Help Manual for detailed information.

 (4/8/2020) System Admin. > ADDED: Error Event Snapshot

• This report assists a user's I.T. staff and Compulink's QC staff in drilling down to a 
   particular hour or event type/hour when software unusual events may occur; especially 
   those that display a message to the user. (Request)
• For full details, go to the following section at the END of this document: I.T. Specialist 
   Information

 (8/21/2019) System Admin. > Report(s) EDITED

• User Defined Audit Report
          • The audit event Date field will now also include the audit event Time. (Request)

Utility
 (1/6/2020) Diagnostics > Diag.Log

• The Diag.Log file is written to each time a Diagnostics is run.
• As of 12/16/19, upon each version update, the Diag.Log file will be REMOVED, so a new 
   one can be created for that version.

 X (1/6/2020) Diagnostics > Level Options Changed

• Click the drop-drown at 'Level' and the options have changed to the following:
          • Complete 
          • Ledger Related ONLY – Includes the following tables:
                    • Bill
                    • Ledger
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                    • Billhist
                    • Payhist
          • Dictionary Rebuild – Re-Building Creating Client Specific Field Dictionary
          • Index Specific Table – User chooses the table(s) to index
                    • Click Begin and the 'Selected Indexing' window will open with the following 
                       prompt: Enter characters for table search filtering.
                    • Type the name of the table you want to re-index and click OK or hit Enter; 
                       Example LEDGER.
                    • The 'Select Table to Re-Index' will open with table names that match what 
                       you typed; double click to select, or highlight and hit Enter.
                    • Click OK on the message: Indexing Completed!
                    • The same 'Selected Indexing' window will open to enter characters for table
                       search; if you need to re-index another table, type another name and 
                       follow the same steps.
                    • If you don't need to re-index another table, click 'Cancel'.
                    • The rest of the Diagnostics will finish.

 X (1/3/2020) Miscellaneous Utilities > .Section Renamed

• Miscellaneous Database Utilities was renamed to 'Miscellaneous Utilities'.

 (11/6/2020) Miscellaneous Utilities > Image Management Express Migration > 
NEW Utility ADDED

• Once your practice initiates the migration of images to the Image Management System, 
   every 1-2 seconds, PracticeWatch will take an image from either the EXAMIMAG or 
   IMAGEDAT file and migrate it over to the NEW IMS format.
• This runs slow enough that it should not impact your daily functionality.
• For clients with multiple images and large files, this could take weeks to months.
• The 'Image Management Express Migration' Utility allows you to enter a number of 
   minutes to let the migration run non-stop at full speed, and without pausing.
• This is intended to be run during NON-BUSINESS HOURS.
• See the Compulink Advantage Online Help File for full details on the IMS.

 X (1/3/2020) Miscellaneous Utilities > Other Utilities > Option Renamed

• Other Misc Utilities was renamed to 'Other Utilities'.

 (5/28/2019) PracticeWatch Setup > Functions: NEW Assertion (optional) Field

• The NEW field 'Assertion (optional)' was added for FUTURE DEVELOPMENT.

 X (11/12/2019) System Administrator > Fax Setup (NEW Option)

• This is a NEW table for Fax Setup; previously located in the Location > Details table.
• When updating to version 12.2, the software will use the entries from your Location 
   Details and Location Groups tables to populate this table.
• The following fields will be automatically populated upon update:
          • Physical Site for Updox Registration – The Name of your Location from the table.
          • Number – The Cloud Fax number from the table.
          • Service Location Group – The Location Group from the Location Groups table.
• The fields listed below will need to be set up by the user IF they would like to use them.
          • Cover Page Document – Enter the name of an OpenOffice document that you 
             would like to use as a Cover Page. 
                    • Do NOT enter the file name extension of .odt or .cbsodt.
                    • This file MUST be located in your Advantage product folder.
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                    • This is NOT a mandatory field.
          • Service Location Group – This field is associated with the Cover Page Document.
                    • If you would like a Service Location Group to use the specified Cover Page 
                       Document, click the drop-down and select from the list; if not, select 'All 
                       Locations'.
                    • This field IS MANDATORY, so if not selecting a specific Service Location 
                       Group, make sure that you DO select 'All Locations'.
          • Service Department Group – This field is associated with the Cover Page 
             Document.
                    • If you would like a Service Depart Group (example: Billing) to use the 
                       specified Cover Page Document, click the drop-down and select from the 
                       list.
                    • This gives the option of setting up multiple entries for the same 'Service 
                       Location Group', but a different 'Service Department Group'.
                              • Service Location Group 'Main Office' and Service Department Group 
                                 'Billing Department' may use Cover Page Document 
                                 'MainOfficeBilling'.
                              • Service Location Group 'Main Office' and Service Department Group 
                                 'Medical Department' may use Cover Page Document 
                                 'MainOfficeMedical'.
                    • This is NOT a mandatory field.
• Adding a NEW record 
          • Click the Add command.
                    • Physical Site for Updox Registration – Select the Location where most of the
                       faxing will come from.
                    • Number – Leave blank, as this will be automatically populated later.
                    • Cover Page Document – See information above.
                    • Service Location Group – See information above.
                    • Service Department Group – See information above.
                    • Click 'Save'.
          • Highlight the NEW record and click the 'Fax # Registration' command (previously 
             'Fax Setup' in the Location table). 
          • You will be presented with the prompt 'Press YES to continue in setting up new Fax
             # using Updox!'.
          • Answering YES will update the 'Number' field on the highlighted Location.

 X (8/2/2019) System Administrator > Fax Setup > Use Existing Fax for E-Fax

• You now have the option of using your existing office fax number for the Cloud fax 
   number to send e-faxes.
• Create an E-Fax number using the Utility > System Administrator > Fax Setup table, Fax 
   Setup option. 
• Contact Compulink Support (if established client) or your Implementation Coordinator (if 
   new client), and provide the fax number that you would like substituted.
• Compulink will contact Updox and provide your preferred fax number.
• Compulink will then contact you and advise you that you can edit the Fax Setup ‘Number’ 
   field and replace the previously assigned number with yours.
• Only a user with the System Administrator Profile Right assigned to FULL can edit this 
   field.

 X (1/28/2020) System Administrator > Login > IDs > Field(s) ADDED

• Department Group
          • Staff can be assigned to a specific Department, and then assigned Tasks based on 
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             that Department.
          • For full details, see the topic 'Patient Area Enhancements: Command (Jump > 
             Task) > NEW 'Task Management' Functionality Added.'

• EHR Restricted to own patients
          • When set to 'Y' or TRUE, when searching for patients, the User that is logged in 
             will ONLY have access to patients that have the 'Provider' field on the Patient 
             Demographic screen set to their ID.
          • When searching for patients, they will only see patients that are assigned to their 
             ID.

• Enable Grid Hover Menus
          • When set to 'Y' or TRUE, the menus on the Patient Demographics and Exam will 
             display the NEW ellipsis icon. Hover the mouse over the ellipsis to open a window 
             with the available icons for that area, then single left click to select.
          • When set to 'N' or FALSE, the menus will display the actual icons to click on, as in 
             versions prior to 12.2.
          • This setting can also be changed on-the-fly from the Patient screen.
                    • Click the 'Printer & Output Tools' icon in the bottom right corner and select 
                       'Grid Hover Menu'.
                    • Click 'OK' on the confirmation: Select OK to Confirm Turning OFF Grid Hover
                       Menu option!
                    • Exit the patient screen and go back in to see the change to the menus.
                    • Follow the same steps to reverse the option.
                    • This change DOES effect the 'Y/N' setting in the table.

• Hint Pause in Seconds (0=default)
          • The number of seconds the mouse can hover over an item before the hint window 
             pops up.

 X (2/10/2020) System Administrator > Login > IDs > Field(s)/Label(s) EDITED

• Location Group Restriction
          • Label renamed from 'Appt/FAX Location Group Restriction'.
          • It controls which Locations the user has permissions to in the Demographic Patient
             Search, Exam, Inventory, Ledger and Electronic Faxing areas. (Request)
                    • If the field is blank, the user will have access to View/Search all patients.
                    • If a Location Group is specified, the user will only have access to 
                       View/Search patients assigned to Location Codes within that Location 
                       Group.

 X (5/1/2019) System Administrator > Login > IDs > Supervisor ID and 
AdvantageERx

• The functionality of the 'Supervisor ID' field has been updated in regards to the 
   AdvantageERx functionality.
• If the user is a PRESCRIBER, the 'Supervisor ID' assigned, MUST belong to a user who is 
   a clinician with a valid DEA# in their Provider table record.
• If the user is a STAFF MEMBER (Scribe/Nurse) that is prescribing UNDER a clinician, their 
   'Supervisor ID' may belong to a non-provider, but the rule above applies to the clinician 
   they are e-prescribing under.

 (6/18/2019) System Administrator > Login > IDs > Table Update

• After making changes to the table and exiting, the update process will now run much 
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   quicker. (Request)

 X (12/19/2019) System Administrator > Login > Profiles > Insert Removed/NEW 
Alpha Sort

• The 'Insert' command was REMOVED.
• The table will now automatically sort alphabetically.

 (11/5/2020) System Administrator > Login > Profiles > NEW Right(s) ADDED

• Appointment Schedule Blocks – Controls the user's ability to set Blocks in the Scheduler. 
   (Request)
          • Defaults to the level of access assigned to the user's 'Appointment Scheduling' 
             Profile Right during the update.
          • Options are 'Full' and 'None'.
• Appointment Wait List – Controls access level to the Wait List used to track those patients
   waiting for an opening. (Request)
          • Options are the standard 6 choices from 'None' to 'Full'.

 (11/13/2019) System Administrator > Login > Profiles > Rights Search Added

• In the Profiles table, click on 'Rights'; a NEW 'Search' command was added. (Request)
• When clicked, it will open the 'Right Search' window with the following prompt: Enter Text
   to search forward with!:
• Type a word in the field (Example: LEDGER) and click 'OK', or hit Enter on the keyboard.
• The software will highlight the next entry in the table that contains the word LEDGER.

 X (3/16/2020) System Administrator > System Setup > System Administrator Tab 
> Field/Label Change(s)

• Allow Single Sign On – NEW field added.
          • Check this option to have the Advantage software authenticate the user based on 
             their Windows Active Directory configuration.
                    • What this means is that the user's Windows login credentials are securely 
                       passed to the Advantage software during login.
                    • Upon saving the System Administrator Setup window with this field 
                       checked, you will receive the following message “Select Yes to Confirm you 
                       have read the recommendations of use within Help documentation for 
                       Single Sign On and Assume ALL HIPAA Liability for Usage!” Select Yes or 
                       No.
                    • This confirmation is logged as an audit event in your Security Admin Log 
                       (Reports > System Admin). 
          • Default is unchecked. This requires each user to log into the Compulink software 
             with their Advantage User Name and Password.
          • Single Sign-On set up requirements:
                    • Active Directory is configured by your IT professional as part of your 
                       practice's Windows server operating system.
                    • A group named “CBSADV Group” is created.
                    • The Single Sign-On user is a member of CBSADV group. 
                    • The Active Directory user must have an attribute called "info" set to his/her 
                       Compulink login User Name.

• IMS Override Root Path – NEW field added.
          • Once the Migration Start date arrives and/or the Advantage Software is updated to
             Version 12.2 or greater, an 'ims' folder is created inside the Advantage product 
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             folder.
          • This is where the patient-specific image folders are stored.
          • If your IT Professional feels that you should store those files in a different location,
             enter the path to that location into this field.
          • When images are imported/scanned into the Advantage software, they will be 
             stored in the location listed here, and NOT in the Advantage product folder.
          • Example: X:\CompulinkImageStorage\ims

• IMS File Encryption – NEW field added.
          • This field is used in conjunction with the 'IMS Override Root Path'.
          • If your IT Professional selects to store the image files OUTSIDE of the Advantage 
             product folder, they may choose to either encrypt the files (check), or not 
             (unchecked).
          • If unchecked, they MUST provide their own protection for the files, or face a HIPAA
             violation.
          • This field defaults to checked for encryption, and Compulink strongly suggests that
             it remains checked.

• I.M.S. Legacy Migration Start – Label EDITED.
          • The field label was renamed from 'I.M.S. Start'.
          • In versions prior to 12.2, this date signified BOTH the date that the office would 
             like to start using the Image Management System (I.M.S.) to store NEW image 
             files, as well as initiate the migration of existing image files out of the large image 
             data file tables into patient-specific image folders.
          • In version 12.2, the Advantage software will now automatically be using the I.M.S 
             for storage of all NEW image files.
          • Due to this change, the Start Date entered here will now ONLY initiate the 
             migration of existing image files related to a patient' medical record out of the 
             image data file and into the image folders.

• System Maintenance Period (mil time)- Start/End – Label EDITED.
          • The label was renamed from 'Backup Start Time (mil)' and 'Backup End Time 
             (mil)'.

 (11/13/2019) System Administrator > System Setup > TableAudit

• Changes made to ANY field in the System Setup are now recorded to the TableAudit.
• This means that the software is tracking who is logged in when items are changed like the
   new 'IMS Override Root Path' and 'IMS File Encryption'.

 X (11/15/2019) System Administrator > Table Maintenance > Utility Renamed

• The 'File Maintenance' Utility was renamed to 'Table Maintenance'.

 (11/22/2019) System Administrator > Table Packing > NEW Utility

• The NEW Utility 'Table Packing' was added.
• This requires the same Login Right as 'Table Maintenance' (Right=Table 
   Maintenance/Utilities).
• ADT tables
          • ADT tables reuse the space occupied by deleted records when new records are 
             added, you must take explicit steps to recover the space occupied by deleted 
             records with these files. 
          • This process is referred to as packing.
• Packing tables
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          • Although packing is a process most often associated with DBF files, you can also 
             pack an ADT table. 
          • As with DBF tables, packing an ADT table removes all records that have been 
             deleted.
          • Since an ADT table can reuse deleted records automatically, packing an ADT table 
             is usually only necessary if you have deleted a large number of records and want 
             to recover available space in the underlying ADT file.
• When you may want to pack tables
          • One very specific scenario in which you may want to pack an ADS table 
             occasionally occurs if you are using memo files. 
          • A memo file will have orphaned memo pages if a memo field's contents for a 
             record (any binary, image, or memo data) are added and are then deleted, and 
             that record's memo field now has no data in it.
          • Packing an ADT table with frequent changes of this type to a memo file will recover
             disk space.
• Running the Utility
          • Prior to running the Utility, Compulink STRONGLY RECOMMENDS that you perform 
             a FULL backup of your Advantage software.
                    • If the process is interrupted and fails, you MUST restore from the backup.
          • Once you select the Utility, a window opens with the following prompt: Enter 
             characters for table search filtering.
          • To pack the Ledger, type LEDGER and click 'OK'.
          • The 'Select Table to Pack' window opens with all of the tables that match the 
             characters that you typed; double click on the table that you want to pack.
          • A 'Packing Table' message will flash on the screen while working.
          • When done, the 'Packing Completed!' window will appear; click 'OK'.
          • The window with the prompt to search for another table will come up again; at this
             time you can search for another table, or click 'Cancel' to close out of the Utility.

 (3/21/2020) System Administrator > Utility SQL Scripts > NEW Script(s) ADDED

• EDI: Clean Up Penny Amounts
          • This routine looks for amounts of a penny and marks them as paid. (Request)
          • It was created for Non-Medicare payors that may have had PQR charges posted to 
             the Ledger.

• EDI: Remove Sec. Payor when Primary Paid and PQRS
          • This routine will remove the Secondary payor when it is PQRS, and the Primary 
             has been paid.

• Migration: Patient ToDos to Patient Tasks
          • This routine takes all PATIENT ToDos and creates a Patient Task record; this 
             includes historical data.
          • It accompanies the NEW 'Migrate' command in the following table: Utility 
             > Look-up Tables > General > Todo/Followup > Items.
                    • The 'Migrate' command will copy the To Do Actions from the 'Items' table to
                       the 'Tasks > Definition' table.
          • It is NOT mandatory to migrate Patient ToDos to Patient Tasks.
                    • Your office may choose to finish all existing ToDos, and start fresh with 
                       Tasks.
          • It is very important that your staff understand how the new Task Management 
             functionality works prior to running this routine.
          • WARNING: This can take HOURS to run on large data sets.
          • The following items will be converted (Task = ToDo):
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                    • Task = Action
                    • Opened = When Added date
                    • When = Date and time routine was run
                    • By = Name of staff logged in when routine was run
                    • Resolved = Finished date if the ToDo was completed, blank if not
                    • Responsible = Name of staff logged in when routine was run
                    • Follow Up = Defaults to the date after the routine was run
                    • Due = Due date
                    • Dept. Group = Left blank if no Department was assigned on the ToDo
                              • If the Department on the ToDo matches a Department Group in the 
                                 table, it will be assigned to the Task.
                              • If there is NOT a match in the table, the Department assigned on the
                                 ToDo will be ADDED to the Department > Groups table, and 
                                 assigned to the Task.
                    • When = When Added date
                    • Status = Defaults to 'Resolved' for ToDos with a Finished date, and Opened 
                       for ToDos that have not been completed yet.
                    • Responsible = Converts ID to full Name
                    • Follow Up = Due date
                    • Note = This will always display the 1st item below, and possibly the 2nd:
                              • From ToDo: Action name that was converted
                              • Note: Note that was on the ToDo
          • Only Active Tasks (ToDos converted WITHOUT a 'Finished' date) will display in the 
             'Patient Tasks' grid on the Demographics.
                    • Resolved Tasks (ToDos converted WITH a 'Finished' date) may be accessed 
                       via Jump > Task > Edit.
          • Additional information:
                    • Tasks do not use 'Frequency', so ToDos will be converted based upon 
                       'Finished' date only.
                    • ToDos allow free-typing in the 'Action' field, but Tasks do not. Because of 
                       this, there is a possibility that there are several variations of the same 
                       Action, or one-of-a-kind Actions.
                              • The routine will only migrate the 100 most popular recent Actions.
                              • All others will be added with a generic Action name, and the original 
                                 ToDo details will be in the Notes.
                    • It is very important to review the results once the routine has been run.
          • Once the ToDos have been converted, and the results have been reviewed, the 
             next step is to hide all existing ToDos so the staff does not continue to work them.
                    • See the information for the NEW routine: Migration: Remove All Todo Data.

• Migration: Remove All Todo Data
          • This routine accompanies the Migration: Patient ToDos to Patient Tasks routine.
          • Once the ToDos have been converted and reviewed, the old ToDo data may be 
             cleared out with this NEW routine.
          • The following actions will be performed when run:
                    • Patient ToDos removed
                    • Todo/Followup > Items – Records marked hidden
                    • Todo/Followup > Groups and Group Detail – Records marked hidden
                    • Todo/Followup > By CPT Code – Records marked hidden

 (2/26/2020) System Administrator > Workstation Static Licenses > Workstation 
Setup > Driver Path Setup

• Once in the 'Workstation Static Licenses' window, highlight a Workstation and click Edit, 
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   or double click to open the 'Workstation Setup' window.
• The fields where your IT Professional enters the path to the drivers for the devices, now 
   have a drop-drown arrow to the right.
• When a device is installed on a Workstation, the path needs to be typed into the field on 
   that Workstation.
• If that device is going to be shared and used across multiple Workstations, the Advantage
   software will now display that path in the drop-drown on the other Workstations; making 
   setup easier and faster. (Request)

Worklist
 (4/2/2019) .General Enhancement(s) > Quantity of Items Added

• The Quantity of Items that qualify for the Worklist will now display in [brackets] in the 
   caption next to the Worklist name.
• This will display for Worklists in ALL areas of the software, not just the Patient Area.

 (9/26/2019) EHR Note > Worklist(s) EDITED

• Episode of Care Discharge For All Active Patients
          • Updated for new Episode functionality

• Episode of Care Summary For All Active Patients
          • Updated for new Episode functionality

• Episode of Care Exam Record Added In Last 60 Days
          • Temporarily removed for additional programming for the new Episode functionality.

• Requires Supervisor Signoff
          • The 'Layoutname' will now display, so if the patient is on the list more than one 
             time for the same day, you can see which one needs to be reviewed.

 (12/9/2019) Global > Worklist(s) ADDED

• Group Enrollment Details
          • This is a Global Worklist, and can be accessed anywhere Worklists are available.
          • It shows details of Group Enrollment.
          • Information displayed includes the following:
                    • Acct (#)
                    • Client
                    • Group
                    • Provider
                    • Day (Day Group Meets)

• Patients with appointments search by day
          • Worklist shows a list of Appointments for ALL ID's for any given day. 
          • Once the Worklist is selected, the User is prompted to enter the date they want to 
             run the query for.
          • Information displayed includes the following:
                    • Date
                    • Provider
                    • Name (Client)
                    • Reason (Appointment)
                    • Status (Appointment)
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 (3/31/2020) Global > Worklist(s) ADDED

• Failed Communications Worklist
          • This can also be accessed by clicking the 'Failed Communications' label on the NEW
             'History' tab.
          • This will show a list of all documents that failed to be sent. (Request)
          • Information displayed includes the following:
                    • Acct (number)
                    • Name (Patient Last, First)
                    • Document (Name)
                    • To (Recipient)
                    • Sent (Date and Time attempt was made)
                    • Error (Reason for Failed Communication)
          • Double click on a patient to move to their Demographic record.

 X (11/5/2019) Patient > Worklist(s) ADDED

• Documents Needing Review
          • This Worklist displays items scanned/imported, where the check box 'Requires 
             Review' was checked. 
          • It also displays items transferred from the InBox to the Demographics or Exam 
             with 'Requires Review' checked.
          • Information displayed includes the following: Account Number, Name and 
             Document.

• Task Management All
          • This Worklist displays ALL unresolved Tasks for all Department Groups, Staff 
             Groups and individual Responsible staff members.
          • Information displayed includes:
                    • Due (Date)
                    • Priority
                    • Patient (Name)
                    • Dept (Responsible Department Group)
                    • Resp (Responsible Staff)
                    • Group (Responsible Staff Group)
                    • Task (Name)
                    • Insurance (Patient Primary Insurance)
          • Double click on a patient to be taken to their demographic screen.

 (11/26/2019) Patient > Worklist(s) ADDED

• Patients with Appointments search by day and ID
          • This SQL query runs a list of Appointments for all ID's, for any given day. 
             (Request)
          • The user is prompted to enter the Date and Provider when the Worklist is selected.

• Patients with Appointments search by day and ID and Status
          • This SQL query runs a list of Appointments for all ID's, for any given day. 
             (Request)
          • The user is prompted to enter the Date, Provider and Appointment Status when 
             the Worklist is selected.

 (11/26/2019) Patient > Worklist(s) EDITED

• Patients with Appointments search by day
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          • Column header 'ID' was changed to 'Provider'.

I.T. Specialist Information
 (10/28/2020) Printer & Output Tools > Workstation Configuration

• After establishing paths for the 'Patient Face Twain Device' and/or the 'Ins. Card Twain 
   Device' on one workstation, those same paths will be available to select from the drop-
   downs on the next workstation on the network. (Request)

 (4/8/2020) Report > System Admin. > ADDED: Error Event Snapshot

• This report assists a user's I.T. staff and Compulink's QC staff in drilling down to a 
   particular hour or event type/hour when software unusual events may occur; especially 
   those that display a message to the user. (Request)
• Once the report is run, there is an option to drill down and display data in individual tabs.
• Options/Parameters for running the report include the following:
          • Start Date (Error Date) – Starting Date of errors to be included. Default is today's 
             date.
          • End Date – Ending Date of errors to be included. Default is today's date.
          • Start Hour (Range) – Starting Hour in the day of errors to be included. Default it 0.
          • End Hour (Range) – Ending Hour in the day of errors to be included. Default is 24.
          • Staff Login ID – Login ID of person logged in when errors occurred. Select a 
             specific ID from the Login ID table, or leave the default of '*' for ALL.
          • Show Detail? – Leave default 'True' to include the information from the software 
             component and/or operation involved. 'False' will show a simpler list of error 
             event information.
          • Group by Error Source? – Leave default 'True' to group the output by Error Source 
             such as CBSComponents and ExamScrn. 'False' will group the output by Event 
             Hour Date/Time.
• Select your Options and click Begin.
• Output for 'Show Detail?=False' and 'Group by Error Source?=False':
          • Output grouped by Event Hour Date/Time.
          • Detailed information:
                    • Event Hour – Date and time (military) the error occurred
                    • Program – Name of the program that the error occurred in
                    • Error ID – Error Identifier
                    • Session ID – Software session connection ID
                    • Source – Error Source
                    • Login ID – ID of the person logged in when the error occurred
                    • Log In Time UNC – Date, time and UTC (Coordinated Universal Time) of 
                       when the person logged into the software. 
                    • Location – IP Address of the workstation where the error occurred
                    • Interface – Workstation's connection to the server
          • Drill-down option:
                    • Double click on an 'Event Hour Date/Time' header to open a new tab to 
                       display ONLY that specific Hour Date/Time's information.
• Output for 'Show Detail?=False' and 'Group by Error Source?=True':
          • Output grouped by Error Source, then Event Hour Date/Time with Error Source.
          • Detailed information:
                    • Same as above.
          • Drill-down options:
                    • Double click on an 'Error Source' header to open a new tab to display ONLY 
                       that specific source's information.
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                    • Double click on an 'Event Hour Date/Time' header to open a new tab to 
                       display ONLY that specific Hour Date/Time's information.
• Output for 'Show Detail?=True' and 'Group by Error Source?=False':
          • Output grouped by Event Hour Date/Time.
          • Detailed information:
                    • Same as above, but also includes the detailed error message that was 
                       displayed to the user at the time of the event.
          • Drill-down option:
                    • Double click on an 'Event Hour Date/Time' header to open a new tab to 
                       display ONLY that specific Hour Date/Time information.
• Output for 'Show Detail?=True' and 'Group by Error Source?=True' – DEFAULT SETTINGS:
          • Output grouped by Error Source, then Event Hour Date/Time with Error Source.
          • Detailed information:
                    • Same as above, but also includes the detailed error message that was 
                       displayed to the user at the time of the event.
          • Drill-down options:
                    • Double click on an 'Error Source' header to open a new tab to display ONLY 
                       that specific source's information.
                    • Double click on an 'Event Hour Date/Time' header to open a new tab to 
                       display ONLY that specific Hour Date/Time's information.
• Printing or Exporting the report
          • The software will Print/Export the tab that is active/highlighted on.
          • If the 'Preview' tab (the first tab) is active/highlighted, the entire report is 
             available for Print/Export.
          • If one of the drill-down tabs is active/highlighted, then ONLY that tab will be 
             available for Print/Export.
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